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Welcome to Helix Native
Plug-in

Thank you for purchasing the Line 6® Helix® Native software, one of the most powerful
and flexible native, multi-processing audio plug-ins ever created. Not just for guitarists,
the Helix Native plug-in is also ideal for producers and engineers, sound designers,
film/TV/game composers, electronic musicians, and anyone else seeking to craft new

and exciting sounds and special effects. This guide covers the features & functionality
of Helix Native plug-in v1.92.

The Helix Native plug-in truly is the same set of astounding amps, cabs & effects as
included within the ground-breaking Line 6 Helix® hardware multi-effects units, and
shares the same simple user interface and workflow as the Line 6 HX Edit editor
application for Helix family devices.* Due to this design, all presets you create in Helix
Native plug-in are compatible and transferable to Helix hardware units via the HX Edit
application, so you can take your presets from studio to the stage—and back again! We
hope it helps drive your search for tonal bliss and spawns years of creativity.
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The Helix Native plug-in

3 *NOTE: Presets can be shared between the Helix Native plug-in and all Helix and
I HX devices—please see “Preset Compatibility with Helix and HX Devices” on

page 13.

Requirements and Installation

Ready to jump in? The latest Helix Native installer for Mac & Windows® computers can
be downloaded anytime from line6.com/software. Once installed, a free 15-day trial is
available, allowing you to fully try the software on your system. After 15 days, you are
required to purchase and authorize the Helix Native plug-in to continue using it on your
system. Please check the requirements below to make sure your computer and DAW
software meet the minimum requirements.

System Requirements

To follow are the requirements to install and use the Helix Native software on your DAW
computer system. Note that Helix Native is a 64-bit plug-in and, therefore, requires that
your host DAW application supports 64-bit plug-ins.

Mac Computers:
Mac OS X 10.10 and 10.11, and macOS 10.12 and later
64-bit AAX Native, Audio Units (AU), VST®(VST2 or VST3) host DAW software
Supported sample rates: 44.1kHz, 48kHz, 88.2kHz, and 96kHz

Windows Computers:
Windows 7 SP1, Windows 8.1, and Windows 10 (64-bit versions only)
+  64-bit AAX Native, VST (VST2 or VST3) host DAW software
Supported sample rates: 44.1kHz, 48kHz, 88.2kHz, and 96kHz

Minimum Hardware Requirements
Dual-Core 2.0GHz processor or faster
4GB of RAM
100MB of free disk space

+ Internet connection required for license authorization, use of trial version, and
for the initial license synchronization of Marketplace premium assets. (The
use of premium presets and Impulse Responses purchased from Marketplace
requires Helix Native version 1.70, or later)
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Installing the Helix Native Plug-in

The first step is to sign in to your Line 6 User Account. If you don't already have
one, just go ahead and create one now at line6.com/account—all the cool kids
have one, and it's free!l Then follow the steps below.

NOTE: An Internet connection is required for the computer on which you want to
install and run the Helix Native trial version, as well as for license authorization &
deauthorization. License authorization on your computer is required for the use of
Helix Native plug-in and for the import & export of purchased Marketplace premium
assets. See page 5.

-
T

NOTE: The use of premium presets and IRs from the Line 6 Marketplace requires
Helix Native version 1.70 (or later). Once Helix Native 1.70 has been installed, it is
necessary to uninstall Helix Native before installing any earlier Helix Native version
(see “Removing Helix Native Plug-in” on page 6).
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1. Once signed in, you can head directly to the Line 6 Online Store and purchase
your Helix Native license (see “Purchasing the Software License” on page 5),
or proceed to the next step to install the Helix Native software on your computer
and optionally choose the 15-day free trial.

2. Proceed to the line6.com/software page and download the Helix Native installer

for your Mac or Windows system.

FREE SOFTWARE DOWNLOADS

R T T -

The Line 6 website's software downloads page

IMPORTANT! Before installing Helix Native plug-in, or any Line 6 application,
device drivers, or firmware, it is highly advised to first read the product’s
Release Notes (typically available on the Line 6 Software Downloads page,
within the product’s download description). It is also advised to check the
Knowledge Base and FAQs regarding updating to new versions, or especially
for rolling back to older versions, since special install instructions may apply.

A

Once the download completes, exit your host DAW and all other applications,
then run the installer and read and follow its steps to complete the installation
(yes, we do recommend reading those screens before just clicking to the next!).
If desired, you can customize the installation to install only the format(s) you
require (AAX, AU, VST3 or VST2) for your particular host DAW application.*

Custom Install on "Macintosh HD" Select components to install:

Action size
416 MB
18.7 MB
13.7 MB
151 MB

7.8 MB

Package Name
¥ © Helix Native Plugins
AU
O wvst2
VST3
AAX

.-
Helix Native - AAX

Install
Skip

Install
Install

26t

Desaription

oe

Mac - Custom install options Windows - Custom install options

(click the Customize button to access options)

*NOTE: If your host DAW application supports VST3, it is recommended that
you do not also install the older VST2 format (VST2 is not selected by default).
The VST2 format is offered for users that have host DAW applications that do
not yet support VST3 plug-ins.

-
¥

On Windows installation, if you do choose to install VST2, you'll be prompted
to enter a custom install location. Please take note of the VST2 install location
you choose since your host DAW may require that you manually define this
VST2 directory within its Preferences to allow its VST2 scan to find it.

4. Once the installation is complete, simply launch your host DAW application and
it will typically scan and find the Line 6 Helix Native plug-in and list it within its
audio plug-in insert menus.

5. Insert the Helix Native plug-in on a track within your DAW project (see
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“Quick Start” on page 8 for help, if needed). You'll initially see the license
authorization screen.

If You Have Already Purchased a Helix Native License - You'll be prompted
to authorize the computer for this license—please skip ahead to “Authorizing
your Computer” on page 5.

If You Have Not Yet Purchased a Helix Native License - You can either
choose to purchase now (see next section), or start a 15-day free trial. Once the
trial expires, it is necessary to purchase and then authorize the computer with
which you will be using Helix Native, or the plug-in will no longer be functional.

FHE L | >< NATIVE

You are eligible to try Helix Native

Buy Helix Native

Start Free Trial

Helix Native plug-in's purchase & trial mode options
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E NOTE: Once you've started the free trial version, you'll see your remaining trial
" time displayed at the bottom right of the plug-in window.

15 days remaining in trial

Trial status indicator
You can purchase a Helix Native license online at any time during or after your trial
period by simply clicking on this trial status indicator, or going directly to the Line
6 Online Store at https://shop.line6.com/.

Purchasing the Software License

The Helix Native license is available for purchase from the Line 6 Store.* Just add Helix
Native to your shopping cart, checkout, and, through the power of the Interwebs, the
license will be immediately deposited into your Line 6 User Account. Alternatively, you
can first download and install the Helix Native software and then choose to purchase or
run it as a free trial first (see “Installing the Helix Native Plug-in” on page 4). Once
you've purchased the Helix Native license, you then use the plug-in's Authorization
screen to authorize your computer to run Helix Native, as covered in the following
section.

B, *NOTE: Helix Native may also be available from your favorite music gear retailer. If
I purchased from one of these vendors, your purchased Helix Native license will be
automatically deposited into your Line 6 account as part of the process.

S Ll o<
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® NOTE: If you are the registered owner of a Line 6 Helix or HX device, or POD
I Farm software, you may qualify for a substantial discount on the purchase of Helix
Native! Please see the purchase options on the Line 6 Store.

Authorizing your Computer

Before you can use Helix Native, your computer on which you will be running the
plug-in must be authorized for your purchased Helix Native license. Authorization is
accomplished within the plug-in's built-in Authorization screen, via an Internet connection
directly from your DAW computer. Once you've installed the Helix Native software,
launch your host DAW application, insert an instance of the Helix Native plug-in on a
track and launch the plug-in window. (Please see “Quick Start” on page 8 for help
on how to insert Helix Native plug-in within a host DAW.)

1. Sign in - Once launched, the Helix Native Authorization screen is displayed,

prompting you to sign in using your Line 6 User Account username and password.
(Note that your username is typically the name you created when creating the
account and not your email address!)

E NOTE: Once a Helix Native license is purchased and your computer is successfully
| authorized, you will no longer be prompted to sign in on each use. Being actively
signed in is then only necessary to deauthorize and authorize your computer, and

for the initial synchronization of licenses for newly purchased Marketplace assets.

Your computer must be in the “authorized” state to be able to import and export
and utilize any premium assets purchased from the online Marketplace for use
within Helix Native. If you plan on purchasing Marketplace premium assets, it is
easiest just to remain signed in and authorized within Helix Native —this allows all
your assets fully functional, and their licenses to remain synced. Please also see
“Marketplace & Account Options” on page 58.

A = S (D24

Please sign-in to your Line 6 account

You must sign in to autho computer to run Helix

The initial Helix Native Authorization - Sign In Screen

If You Have an Existing Line 6 Account but Forgot Your Login - Click the
Forgot password/username? option and follow the steps to reset your login
credentials.

If You Don't Yet Have a Line 6 Account - Click the Create a Line 6 Account
link to create one. Or you can do that right now by going here—it's free!

2. Enter your username and password and click Sign In to proceed.

If You Have Already Purchased a Helix Native License with this Line 6
Account - Upon signing in, select the Authorize Computer option and you
should see confirmation that your computer is now successfully authorized.”
You can now start using Helix Native!
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- If You Have Not Yet Purchased a Helix Native License - You'll be informed
that no license was found on your Line 6 account, and you'll have the option to

HE L | > NATIVE

You are eligible to try Helix Native

Buy Helix Native

Start Free Trial

Helix Native plug-in's purchase & trial mode options

E *NOTE: Be sure to Sign In using the same Line 6 Account you used when making
I the Helix Native license purchase!

- To Purchase a Helix Native License - Click the Buy Helix Native button and
follow the steps on the secure Line 6 Online Store. Once complete, a Helix
Native license will be deposited into your Line 6 account. Your purchased
license will be found and Helix Native plug-in will authorize on your computer.

- To Use Helix Native in Trial Mode - Click the Start Free Trial button and
you'll be able to use the Helix Native plug-in without restriction on this
computer for 15 days (an active Internet connection is required for the Trial
Mode). You may be prompted to sign in for each session when using Helix
Native in trial mode. After the trial period expires, Helix Native will no longer be
functional unless you choose to purchase the Helix Native license.

E NOTE: Once you've started the free trial version, you'll see your trial time
I remaining at the bottom of the plug-in window. Click directly on this indicator
if you wish to purchase your Helix Native license.

15 days remaining in trial

Deauthorizing - Moving to Another Computer

Once you have purchased the plug-in license and authorized your computer (or if using
the free trial version), if you wish to run Helix Native plug-on a different computer, it may
be necessary that you first deauthorize your current computer.*

To deauthorize, click on the My Account menu at the lower left of the plug-in window to
Sign In to your Line 6 account, then choose Deauthorize Computer from this menu.

(Also see page 60).

0 Deauthorize Computer I
i3

& Sign Out

8 Steve

Selecting Deauthorize Computer from the My Account menu

Once you’ve deatuhorized the computer, you can authorize it again at any time by
performing the Sign In to your account from the My Account menu. In this scenario,
since you had previously authorized this computer, it will be automatically authorized
upon a successful sign in.

3 *NOTE: Line 6 generously permits you to have your purchased or trial mode Helix
I Native license authorized on a maximum of 4 of your own computers concurrently.
To move the license to a different computer, it is necessary to deauthorize on
at least one of these systems to free up an authorization to be used on another

computer. For further assistance, please contact Line 6 Support.

Removing Helix Native Plug-in

Should you ever desire to remove Helix Native from your computer system, first quit
your host DAW application, then follow the instructions below.

3 NOTE: Before removing Helix Native, it is highly recommended to export your
I presets (see “Importing and Exporting Helix Preset Files”) and IRs (see “Importing
and Exporting Impulse Responses”) to make sure you have backups of them.

Mac
To uninstall each plug-in format, move the following files to the Trash:

AU plug-in: /Library/Audio/Plug-Ins/Components/Helix Native.component
VST2 plug-in: /Library/Audio/Plug-Ins/VST/Line 6/Helix Native.vst
VST3 plug-in: /Library/Audio/Plug-Ins/VST/Line 6/Helix Native.vst3

AAX plug-in: /Library/Application Support/Avid/Audio/Plug-Ins/Line 6/Helix
Native.aaxplugin (or, you can optionally drag the Helix Native.aaxplugin file
into the /Plug-Ins (Unused) folder)

Windows
To uninstall all plug-in formats:

Choose Start > Control Panel (or, on Windows 10, choose Settings)

Click Programs and Features (or, on Windows 10, choose System > Apps &
Features)

Select Line 6 Helix Native Uninstaller from the list of installed applications
Click Uninstall and follow the on-screen instructions to remove Helix Native
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Workflow

This guide contains details of the Helix Native plug-in's features and functionality.
All behaviors are the same on Mac and Windows (and for all plug-in formats—AAX,
AU, VST3 & VST2) unless otherwise noted. For the most part, the many host DAW
applications on the market work very similarly in respect to how you insert and utilize
effects plug-ins. However, each host may have some unique features and settings you'll
want to take advantage of, so be sure to read through your host DAW application's user
documentation as well.

About Plug-ins

There are many types of “plug-ins” in the world of software. Plug-ins are relatively
small applications that can only run when loaded inside a compatible “host” software
application, extending the capabilities of the host. In the world of DAW (Digital Audio
Workstation) applications, audio plug-ins provide signal processing for your audio
tracks and/or live audio input.

A helpful analogy for audio plug-ins is to think of them as effects pedals. Effects pedals
change the tone of your instrument before the signal reaches your amplifier. As with
pedals, rack effects units, or any other conventional piece of outboard gear, plug-
ins provide familiar knobs, sliders & buttons for tweaking their parameters. Plug-ins
process your track signal similarly, but since they run in real-time in your DAW host
software, they are non-destructive, allowing you to continue tweaking their settings all
the way up until you do your final DAW project mix-down!

What'’s in it for Me?

Helix Native is much more than a one-trick audio processing plug-in. It allows you to
combine a multitude of amps, speaker cabs and effects in practically any signal routing
fashion you can imagine. Its integrated preset librarian and IR manager also allow you
to easily customize, back up and manage your built-in library of tones. All is managed
within its simple, but powerful, user interface. Also note that Helix Native is not just
for guitar! The many included amp, preamp, delay, modulation, reverb, compressor,
distortion and other effects can be utilized on any types of recordings, for traditional or
other-worldly results.

If you own a Line 6 Helix or HX device, then you effectively already know how to use
Helix Native plug-in! Helix Native utilizes a similar user interface as the current Line 6
HX Edit* editor application, therefore, tone creation and preset management tasks are
essentially the same. In fact, you can import Helix/HX hardware-created presets and
use them within Helix Native—and vice-versa!

B *NOTE: HX Edit is the newest editor application for Helix family devices that are
I running firmware v2.20 or later, and it replaces the previous Helix application,
which is the recommended editor application to be used for Helix devices running
firmware earlier than v2.20. For best performance, and to take advantage of all the
newest features & functionality, it is recommended that you always use the latest
available version of both the HX Edit application and Helix/HX device firmware.
Please also see “Preset Compatibility with Helix and HX Devices” on page 13.

For those new to the Helix products family, although Helix Native plug-in may appear
complex at first glance, it is designed in such a way that once you learn a few basic
concepts, you'll be able to construct both simple and complex tones at nearly the
speed of thought, with very little deep diving required. It's a great idea to try the included
Factory & Template presets as a starting point, which you can customize as desired to
start building your own Helix tone collection.

E NOTE: For even more details about individual Helix family models and capabilities,
I please also read through the Helix hardware and software Owner's Manuals—

available from line6.com/support/manuals.

Marketplace

Be sure to visit the Marketplace online shop, where you'll find 3rd-party add-on assets
that even further enhance the functionality of your Helix Native plug-in (and Helix or
HX device, if you own one). Available now are professionally crafted presets and IRs
that can be instantly purchased and added to your Helix Native libraries. An Internet
connection is required for the computer where you'll be using Helix Native to initially
sync and authorize the licenses for the use of Marketplace premium assets. Please see
“Marketplace & Account Options” on page 58.

>1<
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Quick Start

OK, we know you're eager to jump right in and give Helix Native a try on your tracks!
To follow are steps for adding an instance of Helix Native plug-in within a host DAW
application's audio track to get you up and running.

You will find Helix Native within your host DAW application's plug-in insert menus along
with all other audio effects plug-ins. The initial steps in any host DAW application are
as follows.

1. Create a Session or Project at a supported sample rate (44.1kHz, 48kHz, 88.2kHz
or 96kHz)

2. Create at least one audio track. Depending on your host DAW application, it
may offer options for “mono” or “stereo” type audio tracks, or just one common
audio track type that can record or import mono or stereo audio, depending
upon the hardware input type you choose for the track. Either way, Helix Native
plug-in can be added into the effects insert of your audio track.

3. Either record some unprocessed “dry” electric guitar into the audio track, or
import an existing recorded audio file into the track so you have something for
playback.

4. Now you can proceed to insert an instance of Helix Native on this track by
selecting it from the host DAW track's effects insert menu. To follow we've
provided examples on several popular host DAW applications.

Steinberg Cubase

The Cubase® application is offered for both for Mac & PC. It supports the VST3 plug-in
format.

1. Select your audio track within the Cubase project. Within the track's Inspector
at the left of the track (or within the Cubase Mixer window's channel strip for this
track), click on one of the slot's menus in the Inserts section.

) 558 A ) 13. 3. 3. 93 12. 2. 2. 93 R E 0.0.0. 0

it e =[]
Input/Output Channels

| 7

» Equalizers

¥ Inserts
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2. In the Effects menu, choose Helix Native. Note that Cubase offers both mono
and stereo track types. You can simply choose the Helix Native plug-in and it will
conform to your Cubase track's input & output routing configuration.

E NOTE: Within later versions of Cubase, when creating an audio track, the
I Project > Add Track > Audio window’s Configuration menu allows you to
choose Mono or Stereo. This Configuration setting determines whether a
mono or stereo version of the plug-in is used when adding the plug-in to the
audio track’s Insert slots.

3. You will then see the Helix Native plug-in appear in the Effects Insert window. Be
sure to turn your monitoring system to a low level, then double-click a factory
preset from the plug-in's Presets tab and hit Play to hear the results.

Cockos Reaper
Reaper is a full-featured host DAW available for both Mac and PC.

1. Select your audio track within your Reaper project. Within the track header at
the left (or within the Reaper Mixer window's channel strip for this track), click
on the FX track effects insert menu button.

@ e Add FX to: Track 1 "01-Guitar"

¥ All Plugins FX Default Preset

-
veTs AU: POD Farm 2 (Line 6)
eTal AU: POD Farm Bass Amps (Line 6)
AU: POD Farm Delays (Line &)
iti AU: POD Farm Distortions (Line 6)
AU: POD Farm Dynamics (Line 6)
e . AU: POD Farm Filters (Line 6}
ReWire =
(P e AU: POD Farm Guitar Amps (Line 6)
AU: POD Farm Mods (Line 6)
et iiyused AU: POD Farm Preamps :ltme 8)
¥ Categories AU: POD Farm Reverbs (Line 6)
AU: POD Farm Tuner (Line 6)
AU: POD Farm Wahs (Line 6)

ﬂ Clear filter

Cackos

Inserting Helix Native plug-in on a Reaper audio track

2. Inthe FX window, click the Add button to open the list of plug-ins, then choose
the plug-in format type. On Mac, Reaper supports both the AU (Audio Units) and
VST3 plug-in formats, so you can choose either. On PC, choose VST3. Select
Line 6: Helix Native and click OK.

3. You will then see the Helix Native plug-in appear in the FX window. Be sure to
turn your audio monitoring system to a low level, then double click a Factory
preset from the plug-in's Presets tab and hit Play to hear the results.

3 NOTE: Some Mac host DAW applications allow you to use instances of plug-ins
" of different format types (for example, in Reaper you can insert both VST and
AU type instances of Helix Native within the same project simultaneously). For
some actions, such as changes within the Helix Native Preset or IR Libraries and
Preference options, changed settings will not take effect immediately across
currently open Helix Native plug-in instances of different format types until you
close and re-open the plug-in windows.



Apple Logic Pro

Logic Pro is an extremely popular host DAW for Mac. It supports the Apple Audio Units
(AU) plug-in format.

1.

Select your audio track within the Logic Pro project. Within the track's Inspector
channel strip (or within the Logic Pro Mixer window's channel strip for this track),
click on the Audio FX track effects insert menu.

P Track: GUITAR 1

GUITAR 1
M SER I

O Input3

Stereo Out

Edit Functions

N
E Po id

Inserting Helix Native plug-in on a Logic Pro X audio track

In the FX window, choose the Audio Units (AU) plug-in format type and select

Line 6 > Helix Native. Note that Logic Pro offers both mono and stereo track

types, therefore, you'll have different sub-options depending on your track's

type:

- If inserting on a mono track - You'll have the option to choose either Mono
(the plug-in's output is summed to mono) or Mono->Stereo (the plug-in's
output is stereo).

+ Ifinserting on a stereo track - It is recommended to select the Stereo option
here, which provides stereo in/out processing. The Dual Mono option inserts
two mono instances of the plug-in (each accessed via the L and R buttons at
the top of the plug-in window). Each mono instance processes the left and
right audio channels of the stereo track discretely, but this can quickly utilize
a great deal of CPU power, so we don't recommend using it.

You will then see Helix Native appear within the plug-in window. Be sure to turn
your monitoring system to a low level, then double click a Factory preset from
the plug-in's Presets tab and hit Play to hear the results.

Avid Pro Tools

The Avid® Pro Tools® host DAW application for is available for Mac & Windows. It
supports the Avid AAX plug-in format.

1.

A\

Select your audio track within your Pro Tools project. Within the track header at
the left of the track (or within the Pro Tools Mixer window's channel strip for this
track), click on one of the slot's menus in the Inserts section.

Bars|Beats
Min:Secs
Tempo
- L ¥ INSERTSA-E
|_GuITART =[N
I3

* s ™M

+  noinsert

plug-in Avid

Line 6 Echo Farm {mona)

Echo Farm (mono/sterec)
Helix Native (mono)

Helix Native (mono/stereo)

ijo
Avid Marketplace...

Inserting Helix Native plug-in on a Pro Tools mono audio track

In the plug-in menu, choose Helix Native. Note that Pro Tools offers both mono
and stereo track types, therefore, you'll have different sub-options depending
on your track's type:

- If inserting on a mono track (as shown above) - You'll have the option to

choose either mono (the plug-in's output is summed to mono) or mono/
stereo (the plug-in's output is stereo, assuming the track is routed to a stereo
output).
If inserting on a stereo track - Only a stereo option is offered here, which
provides stereo in/out processing. (Note that Pro Tools does offer a dual
mono option for some plug-ins, but this is not supported by Helix Native
plug-in.)

You will then see the Helix Native plug-in appear in the Effects Insert window. Be

sure to turn your monitoring system to a low level, then double-click a Factory

preset from the plug-in's Presets tab and hit Play to hear the results.

TIP: Most host DAWSs also allow you to insert plug-ins on Send, Bus or Aux track
types. Host DAWs differ slightly in their naming and features of these track types,
but their main purpose is to allow you to insert a single instance of your plug-in and
then route the output of any number of audio tracks into it to process them using
the same effect. This is the preferred way of processing multiple tracks since,
obviously, one instance of your plug-in utilizes less CPU power as compared to
inserting individual instances on each audio track! Please refer to your host DAW's
documentation for details.

Once you insert an instance of Helix Native and load a preset, the preset's contents

are

displayed within the Signal Flow Window, with model menus, parameters and

automation control options available within the tabs of the Inspector Window.
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This allows you to load & customize any of the provided Factory presets, create your
own presets, configure automation controller assignments, manage presets & Impulse
Responses, as well as back up all your tones to your computer. Even better, all your
saved creations can be transferred between Helix Native plug-in and the HX Edit
application, allowing them to also be used on a Helix hardware device as well (see
“Preset Compatibility with Helix and HX Devices” on page 13 for details).

Live Input Monitoring Through Helix Native Plug-in

Another great benefit of audio effects plug-ins is the ability to monitor your input signal
through the plug-in inserted on the track. This allows you to dial in the desired tone,
such as a customized set of amp, cab & effects within the instance of Helix Native, and
then hear your guitar (or other track input signal) processed by it in real-time. Once you
hit record, only your “dry” D.I. guitar signal is actually recorded into the track, which
provides the huge benefit of being able to completely change the plug-in settings at any
time, right up until you do a final mix-down of the DAW project!

Live Input Monitoring is a function of your host DAW application, and is typically
accomplished by the following steps. Each host DAW is slightly different, so be sure to
consult your DAW application's documentation for details.

1. Configure your audio track's input options to receive input from whatever
physical input your guitar (or desired instrument) is plugged into.

2. Insert Helix Native on the track, as described in the previous section.
Set the track's Record Arm button to “on” so that the track receives audio input.

4. Activate the track's “Input Monitoring” feature. This is typically a button found
near the Record Arm button. This feature allows the live track input to be fed
through the DAW track and all plug-ins inserted on the track.

Record Arm

Input Monitor

o
o =)

An audio track in Cubase configured with Record Arm & Input Monitoring active

NOTE: When utilizing your DAW track's “Input Monitoring” feature, you'll want to
be sure to disable any “Direct Monitoring” signal on your audio interface (many
interfaces offer an optional function that routes your input signal directly to its
outputs, without going through the DAW software). This way you'll hear only
the input signal fed through the Helix Native plug-in. See your audio interface's
documentation for details.

(=

5. Now when you strum your guitar, you should hear your signal through the track
with the Helix Native processing applied. You can hit the Record button and try
a pass at recording your performance. Upon playback you can then experiment
with tweaking the Helix Native settings even further!

About Latency

Since this input signal is being fed round-trip—into your audio interface, through the
DAW software and back out your audio interface's outputs —it is subject to some amount
of “latency.” Latency is the time between when you pluck a note on your guitar and hear
the resulting audio output through your monitoring system. Latency is a function of your
audio interface, host DAW software and the recording capabilities of your computer
system. You can generally get the lowest latency by reducing your buffer size options
for your audio interface driver within in your host DAW software's Preferences. Please
see your DAW software’s documentation for details.

Optimizing the Input Level

The level of the input signal entering the Helix Native plug-in can affect the overall gain
and saturation of your tones, therefore, it is essential to “gain stage” accordingly. It is
important to note that most Helix Native Amp & Effect models are designed to receive
“Instrument” level input signals, much like plugging an electric guitar directly into the
same type of amp or effects pedal we modeled them after. To follow are several tips for
achieving the optimal signal level.

3 NOTE: Please also see “Master Input & Output Level Controls” on page 34.
]

For the most accurate results when recording “dry” electric guitar (or bass), we
recommend that you use an audio interface with a “Hi-Z” or “Instrument” input.

For monitoring your input signal level (or the playback level of any clips within
your track), reference the Master Input Level meter within the plug-in.

Master Input

Optimal Input Level Slider

Range Indicator

Multi-color
Input Meter

The Master Input Level controls

The Optimal Input Range Indicator provides a guideline for where you should
keep your input level, between -36 dB to -12 dB.

The Multi-color Input Meter also provides guidance. Basically, strive for
keeping your input level in the green and yellow, and avoid the blue (signal is
too low) and red (signal is too high).
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- If your audio interface offers input level adjustment, it is typically best to adjust Navigation within the plug-in's user interface is divided into three main windows:

it there to keep the recording level entering the plug-in within this optimal range.
If needed, you can adjust the plug-in Master Input Level Slider to fine-tune the
level. The Master Input and Output Level sliders are global per plug-in instance
and, therefore, their values are not saved per preset.

- Guitars with active pickups may have a hotter output than traditional passive
pickups. If your guitar utilizes active or especially high output pickups, set your
audio interface or preamp's input “pad” to on, if available.

+  Clipping, as indicated when the red Clip Indicator lights up, should always be
avoided on both the plug-in's input and output meters.

Clip Indicator

The Input meter showing a clipped input level

GUI Overview

The Helix Native plug-in has a very simple, easy-to-use interface which functions as
both a Librarian for your Helix Preset and Impulse Response files and as an Editor to
create and customize your tones.

Presets Impulses Show/Hide Signal Flow  Undo/ Redo A/B
Tab Tab Librarian Window Buttons Buttons

Tr n LS Doubde Hrm

Nvidvdann

T T T
Status Bar Edit Inspector  Automation/Controller
Controls Tab Window Assign Tab
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The Librarian Window - For managing presets and impulse response (IR) files—
see “Presets Panel” on page 20 and “Impulses Panel” on page 24.

The Signal Flow Window - Where you can add and move amps & effects blocks,
and customize your complete signal path routing—see “The Signal Flow Window”

on page 34.
The Inspector Window - Where you can choose from the huge selection of models,

edit their parameters, and create and manage parameter automation control—see
the Inspector Window chapters on page 40 and page 43.

Customizing the Helix Native Plug-in Window

Resize the Plug-in Window - The plug-in's window is resizable to allow you adjust
the window size that best suits your screen and workflow. Simply click and drag
using the “grab handle” at the bottom right of the plug-in window to reduce or
increase the window size independently for any instance of the Helix Native.

AUTOMATION/CONTROLLER ASSIGN

[ US Double Nrm

MIDI In:

Drag the “grab handle” on the bottom right of the plug-in window for resizing

Show or Hide the Librarian Panel - It is also possible to show or hide the Presets/
Impulses Librarian panel independently for each instance of the plug-in, by clicking
on the toggle button at the top left of the Signal Flow window.

'IMPULSES  ( =>) T US Double Nrm

The Librarian Panel's Show/Hide Button



Undo / Redo

Helix Native supports Undo and Redo for most edit actions performed within the plug-
in window, accessible via the Undo and Redo buttons at the top of the main plug-in
window. The Undo / Redo history is tracked per instance of the plug-in. See “Undo and
Redo” on page 28.

=y ™~ A

The Undo and Redo buttons

1/ SNAPSHOT 1

A /B Compare

This set of buttons allows you to temporarily store all the Helix Native plug-in instance’s
parameter settings, then tweak any number of parameters and easily compare the
sound of your edited settings vs your original stored settings. See “Using the A/B

Compare” on page 29.

The A/B Compare controls

Status Bar Controls

This bottom row of the main plug-in window includes several options.

Plug-in Preferences, Help & Account Options

At the bottom left of the plug-in window, click on the menu buttons to access the plug-
in Preferences, Help & About Box, (see page 54) and My Account options (see page
59).

N6A New Preset

- {E:I My Account

Preferences Help/About Account Options

MIDI In Indicator

At the lower right of the main window, you’ll see a handy MIDI In indicator light. When
Helix Native receives MIDI input, you’ll see this light up green—which can be a big help
to let you know you have correctly routed your MIDI controller data into the plug-in for
accessing its MIDI Control and bypass assignments (see page 49).
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Preset Compatibility with
Helix and HX Devices

Since the engine of Helix Native is essentially the same as the one utilized in all Line
6 Helix and HX products, we’ve made things even more flexible within Helix Native
by offering Hardware Compatibility modes (HC modes), to emulate Helix and HX
devices, as well as Preset Translation. As covered in the following sections, these
features provide the ability to share presets between Helix Native and all Helix and HX
devices, allowing you to greatly expand your library of Helix Native tones.

Z TIP: The HC mode can also be turned Off, which means you can construct a preset

= in Helix Native using as many blocks as will fit on its signal paths, regardless of
block type (Amps, Cabs, IRs, and Effects) and DSP usage, effectively “unleashing”
Helix Native from any per-instance DSP limits!

Loading vs. Importing Presets into Helix Native

Key to the Helix Native HC mode and preset translation functionality is for you to
understand the difference between what we refer to as loading a preset vs. importing a
preset, since options and behaviors differ for these actions. Please also refer to “Presets
Panel” on page 20.

Loading a Preset

In Helix Native, you load a preset to utilize it as your current tone, which is what you
see within the plug-in’s Signal Flow. You can load a preset in Helix Native in any of the
following ways:

+ Using the Open From File command from the Preset Menu button at the top
of Signal Flow panel.

+ Drag a preset from any computer folder, or from the HX Edit app’s Preset Library
list, and drop it directly into the Helix Native Signal Flow panel.

+  Double-click on any preset in the Presets Library at the left to load it from the
current library into the Signal Flow. (Note that any preset already within the
Helix Native Presets Library was already translated upon import, so no further
translation process is necessary.)

When you load a preset, Helix Native automatically detects the device (or HC mode)
from which it was created and, if the preset differs, Helix Native offers you the option
of either switching the plug-in’s HC mode to match the preset’s originating device, or to
attempt to translate the preset to match the plug-in’s current HC mode (see “Changing
HC Mode on Preset Load” on page 16 for details).

Importing a Preset

In Helix Native, you import a preset to add the preset to the plug-in’s Presets Library.
You can import a preset into Helix Native using any of the following methods:

Select a slot within the plug-in’s Presets list and click the Import button just
above the list.

Drag a preset from any computer folder, or from the HX Edit app’s Preset Library
list, and drop it directly into a slot within the Helix Native preset list.

Copy a preset from the HX Edit app’s Preset Library list, and Paste it directly
into a slot within the Helix Native preset list.

Use the Setlist Import button at the top of the Presets Panel, or Import
Bundle (Helix and Off HC modes only for bundle file support) button in the
plug-in’s Preferences window to import a setlist or bundle from your computer.
All presets therein are attempted to be imported (following the same rules as
described in “Preset Translation” on page 15). This import action changes
the Helix Native HC mode to match that of the imported setlist/bundle file,
and any presets within the setlist or bundle that are not translatable are not
imported.

When importing a preset, Helix Native will automatically attempt to convert it to match the
current Helix Native HC mode. If it cannot be translated, you’ll get a dialog alerting you
why. In this situation, the import is aborted and the current HC mode is left unchanged.

Helix Native

Helix Native was unable to import presets in this set
(. due to following errors:

-B703 - Preset translation not supported,
incompatible model.

Alert dialog when attempting to import a preset that cannot be translated

Once imported, the preset is retained within this HC mode’s individual Presets Library.

Hardware Compatibility Modes

The current HC mode within Helix Native is indicated, and can be manually changed, by
the Current Hardware Compatibility Mode menu, found in the Preferences window -
Hardware Compatibility tab (see page 55). Helix Native will also prompt you to adopt
the matching HC mode when loading a preset, as covered in the following sections.

Helix Native Preferences

Presets/IRs Hardware Compatibility

Current Hardware Compatibility Mode: Helix [Default]
Off

When loading presets that don't match ® Helix [Default]
current hardware mode:  HX Effects

HX Stomp

Remove unsuppoited blocks when

The Current Hardware Compatibility Mode menu
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¥ NOTE: The HC mode can also be changed automatically by loading a preset that
‘T’ was created with a different HC mode (or device type) than is currently in use in
Helix Native. Please see “Changing HC Mode on Preset Load” on page 16.

When you select one of the HC modes from the menu, the Ul and functionality of the
current Helix Native plug-in instance change to match those of the selected device (as
well as matching the Ul of the HX Edit application when connected to the selected device
type). This includes the Signal Flow, maximum block per path capacity, Model menu
and model type options, and includes its own independent Preset Library and set of
Factory Presets. The menu options and respective Helix Native Hardware Compatibility
modes are as follows. Also see the “HC Mode Feature Comparison Table” on page
15 for differences between these modes.

Helix Mode - Presets exported from any Helix device (Helix Floor, Helix LT, or Helix
Rack) can be loaded or imported into Helix Native in this mode (or back into HX
Edit with a Helix Floor/LT/Rack device connected), with no translation required. (If
you’re familiar with any earlier version of Helix Native, this Helix mode is essentially
the same.)

HX Effects Mode - Presets exported from an HX Effects device can be loaded or
imported into Helix Native in this mode (or back into HX Edit with an HX Effects
device connected), with no translation required.

HX Stomp Mode - Presets exported from an HX Stomp device can be loaded or
imported into Helix Native in this mode (or back into HX Edit with an HX Stomp
device connected), with no translation required.

Off - Once a preset is saved in, or exported from, Helix Native in this HC mode
setting, the preset can be loaded or imported into Helix Native in this mode setting
with no translation required. When set to Off, the Ul and options are essentially the
same as the Helix HC mode, but with several restrictions removed (see the “HC
Mode Feature Comparison Table”).

Just remember when working in this Off mode—with greater power comes
greater responsibility! Without the restrictions imposed as in other HC modes, it
is possible to create a preset in a single plug-in instance that can place significant
CPU demands on your computer system. Also, creating a preset that exceeds the
limits of other HC modes also means the preset will not be able to be translated
and utilized in HX Edit with any Helix or HX device, and only loaded in Helix Native
when it is set to the HC mode Off state.

Set As Default Button

Changing the HC mode in one instance of the plug-in does not affect the HC mode in
use by any other existing Helix Native plug-in instance. Future, new instances of Helix
Native will utilize the designated Default HC mode. Click the Set As Default button to
configure the currently selected HC mode as the Default, globally for all future plug-in
instances. Initially, the Helix mode is set as the Default.

Presets/IRs Hardware Compatibility

Current Hardware Compatibility Mode: HX Stomp Set As Default

I

The HC mode - Set As Default button

Changing to a Different HC Mode

Once you select a different mode from the HC Mode menu, Helix Native will first
automatically alert you that are about to make a HC mode change. Choose OK to
proceed, or, if this tone is one you want to save in its original HC mode format, choose
No, and then Save or Export the tone as a preset before changing to the new HC mode.

If you click OK to proceed, Helix Native will attempt to translate your currently-loaded
tone into the HC mode format you selected. If translation is possible, your (translated)
tone remains the current tone within the plug-in’s Signal Flow (see the following sections
for more about preset translation). Note that the now translated, current tone is in an
un-saved state, so you’ll want to use the preset menu’s Save To Library command if
you want to retain it within the Presets Library for this HC mode.

If your currently-loaded tone is not able to be translated to your new selected HC mode,
you’ll see an alert, asking if you want to proceed with the HC mode, discarding the
preset.

Helix Native

Translation of current preset failed.

. qe
( Proceed with change and discard the current preset?

Preset translation alert—changing from Helix to HX Stomp HC mode

Choosing Yes will discard your current tone (meaning, the un-saved tone will be lost)
and change to the select HC mode, loading an “empty” Signal Flow for your current
tone. Choosing No will abort, leaving your current tone and HC mode unchanged.

Note that whenever you save or export a tone from Helix Native, it is saved as a preset
in the current HC mode/hardware format. A Helix Native preset may be able to be
translated and imported or loaded into Helix Native while in a different HX mode.
Likewise, the preset may be able to be translated and imported or loaded into HX
Edit with a different device type connected. The ability for the preset to be translated
depends upon destination mode/device’s block count, DSP, and path limits—see the
following “Preset Translation” section for details.

¥ NOTE: Some DAW host applications (such as Cubase and Pro Tools) include their

‘r own plug-in preset functionality, independent of the Helix Native Preset Library.
Since changing the HC mode within the Helix Native results in the plug-in instance
utilizing the specific Preset Library of that mode, you could get unexpected results
if attempting to use your DAW host application’s own plug-in preset features.
Therefore, we recommend you use the Helix Native built-in Preset Library to save,
load and manage all its presets.
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HC Mode Feature Comparison Table

The following table shows the primary differences between the four selectable Hardware
Compatibility modes in Helix Native. You can consult this table to determine if a preset
created in one HC mode (or device type) will be able to be translated to other HC
modes. Also see the Preset Translation Compatibility table in the next section for

more info.

HC MODE / DEVICE FEATURE COMPARISON

Presets cannot be translated if created with a device or mode that includes features
or capabilities that exceed those of the current HC mode (see the preceding Feature
Comparison table). The following table further illustrates the translation conditions, and
the following sections in this chapter go into further details on compatibility of individual
preset features.

f NOTE: Likewise, if importing multiple presets, a setlist, or a bundle, where one

S” or more presets are not able to be translated to the current HC mode, the non-
translatable presets display an error window and are not imported, while the eligible
presets are successfully translated and imported.

Preset Translation Compatibility Table

The following table provides an overview of the preset translation capabilities from each
source device (or each source Helix Native HC mode).

PRESET TRANSLATION COMPATIBILITY

HC Mode or Device Type:
Feature
Off Helix HX Stomp HX Effects
Full set of v2.90 Full set of v2.90 Full set of v2.90 Full set of v2.90
Included Helix models Helix models Helix models, Helix models,
Models* except 6 Switch except Amps &
Looper Cabs
Blocks Per Path 16 16 6 9
Capacity
None 2 Amps, 2 Cabs, 2 Amps, 2 Cabs, 2 Amps, 2 Cabs,
Max. Block Type 2 IRs (1,024 21Rs (1,024 2IRs (1,024
Per Path sample) or 1 IR sample) or 1 IR sample) or 1 IR
(2,048 sample) (2,048 sample) (2,048 sample)
None Same as Helix Same as Same as
Max. DSP Limit HX Stomp HX Effects
hardware hardware
Snapshots 8 8 3 4
Per Preset
P 8 Setlists for up | 8 Setlists forup to | 1 Setlist for up to 1 Setlist for up to
(iﬁézszzblebr:tanér to 1,024 Presets. 1,024 Presets. 128 Presets 128 Presets
o P Bundle support Bundle support
HC mode) included included
Impulses Library| Holdsupto 128 | Holds up to 128 Holds up to 128 Holds up to 128
(shared between User IRs User IRs User IRs User IRs
HC modes)

*Also see “Model Lists” on page 61 for the categories and lists of included models.

Preset Translation

As covered in the preceding sections of this chapter, when loading or importing a
preset, Helix Native will automatically attempt to “translate” the preset to match the plug-
in instance’s current Helix Native HC mode. If it cannot be translated, you'll get an error

window letting you know the preset is not compatible with the current HC mode.

g\

TIP: This preset translation functionality is also available within the HX Edit
application. Whenever loading or importing a preset into HX Edit—whether

exported from Helix Native in any HC mode, or from any Helix or HX type device—
HX Edit will always automatically attempt to translate the preset for the currently
connected device. Please see the HX Edit Pilot’s Guide for details.

Can Be Translated To:
Created With:
Off Helix HX Stomp HX Effects
If does not exceed| If does not exceed | If does not exceed
Helix Native Helix block count | HX Stomp Block HX Effects Block
HC mode = Off \/ and DSP limits and Path count and Path count
and DSP limits and DSP limits
Helix If does not exceed | If does not exceed
Rack, Floor, L HX Stomp Block HX Effects Block
(Rac oor, LT) and Path count and Path count
or v v and DSP limits and DSP limits
Helix Native
HC mode = Helix
HX Stomp If does not exceed
or v v v nggett:;t}s Bloctk
i . and Path coun
Helix Native and DSP limits
HC mode = HX Stomp
HX Effects
or
Helix Native \/ \/ \/ ‘/
HC mode = HX Effects

Controller Support

Note that Helix, HX Stomp, and HX Effects modes/devices each have their own set
of supported types and numbers of controllers (number of Snapshots, EXP Pedal
controllers, Command Center options, etc.) When translating a preset to a Helix Native
HC mode that has lesser support of these controller features, the non-supported
controllers are discarded from the translated preset.
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Changing HC Mode on Preset Load

When you load any .hix preset file, such as by dragging a preset file from another
computer window and dropping it directly into the plug-in’s Signal Flow, Helix Native
automatically detects the device type or HC mode with which the preset was created
and prompts you with the option to change HC mode, or to attempt to translate the
preset to load it within the current HC mode.

‘@00

Helix Native

The Helix Native preset you are loading does not match the current Hardware
Compatibility (HC) mode.

Select an option and click OK (or click Cancel to canc

CANCEL

nged in the Preferences.)

Change HC mode prompt window
The options in the prompt window are as follows.

Change the current HC mode - Helix Native changes its HC mode to match that
of the preset you are loading, and then loads it as the current tone.

Translate the preset - Helix Native attempts to translate the preset to that of the
current HC mode and, if able to translate it, loads the preset. If the preset cannot
be translated to the current HC mode, the preset is not loaded and no change is
applied to the plug-in’s HC mode state.

Don’t ask me again - Selecting this option will stop the Change HC Mode
prompt window from appearing, and automatically apply the above option that is
selected for all future preset load actions. (You can change this behavior within the
Preferences > Hardware Compatibility tab window at any time.)

Preset Compatibility with Helix and HX Devices

As covered in the preceding sections, as of Helix Native v1.80 and HX Edit v2.80, the
preset translation functionality and Helix Native Hardware Compatibility modes make
it possible for any presets from Helix and HX devices to be exported from HX Edit and
utilized within Helix Native. Likewise, you can also utilize Helix Native to create presets
that will be fully compatible with whatever Helix or HX device you want to use them on.
This compatibility is the foundation of the Line 6 “Studio to Stage” concept!

TIP: If you own a Helix or HX device, be sure to check the “Helix compatible”
version number (found in the Helix Native Preferences' About box—see page
56) to determine the recommended Helix firmware version you should use for
preset compatibility. For optimal compatibility with Helix Native v1.92 and HX Edit
2.92, you'll also need to be running the v2.92 device firmware (or later)—the best
practice is really to just always use the latest versions of all Line 6 software, device
drivers, and firmware!

A\

Presets, setlists and bundles can simply be imported into the Helix Native or the HX
Edit app using their Import functions, as covered in the following sections. It is also
possible to drag and drop presets directly between the applications' Preset panels.
Once imported into the HX Edit application, presets are immediately loaded onto your
connected Helix device, replacing the presets within the device's internal memory.
When importing presets into the Helix Native Presets Library, they are then available for
any instance of the plug-in that is set to the same HC mode.

E NOTE: As with all plug-ins, the specific settings you last used within your existing
I plug-in instances are retained as part of your host DAW project and not affected
unless you manually load a different preset into the plug-in's Signal Flow. Instances
of the Helix Native plug-in that already exist in previous host DAW projects will
also reference the current plug-in Presets Library lists when you load the DAW

project again.

Since the different Helix device types include different physical inputs and outputs,
some variances exist among settings, as well as for their support of block types &
controllers, which may affect the sharing of presets between HX Edit and Helix Native
plug-in. These differences are detailed in the following sections.

HX Edit Application

Line 6 HX Edit is the editor/librarian software for use with Helix hardware devices that
are running firmware version 2.20 or later. For best performance, it is recommended to
use the latest version of both the HX Edit application and Helix firmware. If you own a
Helix that is still running a firmware earlier than v2.20, you'll need to update the Helix
device's firmware to the v2.20 firmware or later, or use the previous Helix application
with your Helix device.

For optimal preset compatibility between Helix Native plug-in and Helix/HX hardware,
you should always be sure to use matching versions of the Helix Native, device
firmware, and the HX Edit (or Helix) application. The easiest (and recommended) way
to be sure your presets are compatible is to update to all the latest versions available
for Helix Native, firmware and HX Edit. All Line 6 software is available for download from
line6.com/software.

Helix Native and Helix/HX devices each include some differences in preset capabilities,
due to different inputs, outputs, switch and controller support, etc. The following sections
cover the details of what you can expect when sharing presets between Helix Native and
Helix and/or HX devices.
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HX Edit Preset Translation

Just as described in the preceding sections for Preset Translation functionality in Helix
Native, HX Edit offers the same capabilities whenever importing or loading a preset.
Regardless of the specific Helix or HX device type currently in use with HX Edit, the
application will automatically identify the device or Helix Native HC mode type from with
which the preset was created, and attempt to translate the preset to match the current
device’s format.* Please also see the HX Edit Pilot’s Guide.

Z *TIP: Note that some preset functions may be disabled and/or removed accordingly

! to make the preset compatible with the destination device in HX Edit. Therefore, it
is a good idea to retain a backup of your original presets, and save new, individual
versions of “translated” presets after importing them into a different device format!

HX Edit Backup Files

The HX Edit application includes a feature that creates Helix Backup (.hxb) files that
can be utilized to restore a Helix or HX device's presets, IRs and global settings. Helix
Native does not currently include this feature and, therefore, does not support creating
or opening Helix Backup files.

Block Copy and Paste

Using the Copy and Paste Block commands, you can copy/paste any individual block
between presets within any instance of Helix Native, as well as between Helix Native
and HX Edit with any Helix or HX type device connected. It is also possible to drag and
drop any processing block to move it within the current preset, or to copy it into any
other Helix Native plug-in or HX Edit device window. Restrictions apply when copying
and pasting some block types, depending on the HC mode in use within Helix Native,
on the Helix hardware in use, and the paste destination—please see “Cutting, Copying
& Pasting Blocks” on page 35.

Marketplace Assets

All premium presets and IRs purchased from the online Line 6 Marketplace that are
offered for Helix and HX devices are compatible with Helix Native plug-in (license
authorization and version Helix Native 1.70 and later are required). Please see
“Marketplace & Account Options” on page 58.

Input & Output Block Settings

When Importing a Helix or HX Hardware-exported Preset into Helix Native - All
Input and Output blocks currently set to physical Inputs and Outputs (other than
“None”) will default to the “Host” setting within the plug-in.

When Importing a Helix Native-exported Preset into Helix or HX Hardware - All
Input and Output blocks currently set to “Host” will default to the “Multi” setting within
the Helix hardware. Any Input block set to “None” will remain as set to “None” within the
hardware.

Hardware Blocks (Send, Return, FX Loop &
Looper)

When Importing a Helix Hardware-exported Preset into Helix Native - These
hardware block types are only functional within Helix/HX devices and, therefore, their
parameters are not editable. These blocks have no routing functionality within Helix
Native.

3 NOTE: If an existing Send, Return or FX Loop block is toggled as “active” via its
I Bypass switch, it can reduce or fully mute the path's audio signal, depending on
the block's Mix or Dry Thru parameter settings. To ensure these block types are

not affecting the plug-in's signal path, simply toggle the block to bypassed.

If you load a preset that happens to include any of these types of hardware blocks,
you'll see them appear within the Signal Flow with an indicator to remind you they are
non-functional within the plug-in.*

An FX Loop, Send, Return, and Looper block within a Helix hardware-exported preset

3 *NOTE: Within the Preferences - Hardware Compatibility tab window, you can
I enable the option for Helix Native to automatically “Remove all non-functioning
hardware blocks” from presets whenever importing Helix presets, setlists or
bundles (see page 56). However, regardless of this Preference setting, it is still
possible to Paste one of these unsupported blocks into Helix Native from the HX
Edit app, if it remains as the most recently copied item in your clipboard.

When you select one of these hardware blocks within the Signal Flow, you'll see a
reminder within the Edit tab to alert you it is non-functional, and see that its parameters
are not editable (dimmed). However, these blocks and their original settings remain fully
functional if and when the preset is exported from Helix Native and imported back into
HX Edit.

An “unsupported” block's parameters within the Helix Native Edit tab

3 NOTE: Note that it is not possible to add non-functional hardware blocks to your
I tone from the Helix Native model menu—the Send/Return and Looper menu
categories of the Edit tab's Model Browser remain non-selectable.
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Impulse Responses

Impulse Response (IR) files are able to be utilized within IR blocks of Helix Native just as
they are within Helix and HX devices. You can simply import IRs using the Helix Native
Impulses panel to build your Library of IRs that are available to Helix Native. Helix
hardware retains its own separate IR Library (managed by using the HX Edit application).

If you are to be sharing presets between Helix Native and Helix or HX devices, it is a
good idea to build and maintain your IR Libraries similarly on each to allow the same IR
files to be utilized for your presets that include them. Please see “Impulses Panel” on
page 24 for details.

E NOTE: The Impulses Library within Helix Native is shared between all HC modes.
I Also see “Hardware Compatibility Modes” on page 13.

Hardware Controller Assignments

Helix and HX devices, as well as the HX Edit editor application, offer the ability to
create several types of “controller assignments” to provide remote control of preset
parameters via Helix/HX footswitches, expression pedals and external MIDI gear. These
controller assignments are saved and retained within Helix’HX hardware-exported
presets. By default, hardware assignments are not visible when a preset is loaded in
Helix Native, but they can optionally be set to be displayed in the Helix Native Edit tab
and Assignment List—see “Hardware Controller Assignments within Helix Native” on

page 43).

— Helix hardware
assignment indicators
In the Edit tab

Indicators on an Edit tab slider that a parameter includes a controller assignment

Helix hardware controller assignments offer no functionality within Helix Native plug-in,
and any parameter itself that includes an assignment remains adjustable and functional
within Helix Native. MIDI controller assignments created within HX Edit are supported
and functional within Helix Native. These controller assignments also continue to be
retained in the preset, even once exported from Helix Native, allowing them to still
function if imported back into a Helix or HX device again. Please see the Helix and HX
Owner's Manuals.

Z TIP: Note that, within Helix Native, you can utilize your host DAW application
4 parameter automation functionality to control the bypass of blocks and parameter
values in real-time! Please see page 43.

B NOTE: HX Stomp and HX Effects devices, and therefore, the HX type HC modes
I in Helix Native, support fewer hardware controller assignment types than Helix
devices and modes.. Also see “Hardware Compatibility Modes” on page 13.

Snapshots & Snapshot Assignments

Snapshots & snapshot assignments created and saved within a Helix or HX device's
preset are compatible when the preset is loaded in the Helix Native plug-in, and vice-
versa. However, there are a few specific functions that can exist within Helix hardware-
created presets that Helix Native does not support, as described below.

Helix hardware Command Center message data (see previous section).
Line 6 Variax instrument tunings and other Variax parameter settings.

These types of data within snapshots are essentially ignored by Helix Native, with all
other supported snapshot settings recalled just as on Helix hardware. Both supported
and non-supported snapshot data are retained within your Helix Native-exported presets
when loaded on Helix hardware again. Please also see “Working with Snapshots” on

page 31.

3 NOTE: The current snapshot, along with all its settings, can be copied and pasted
I using the Copy Snapshot and Paste Snapshot commands either within the
current Helix Native preset or within the current HX Edit preset, but not between
the Helix Native plug-in HX Edit app, and not between HC modes within Helix
Native. Also see “Copying, Pasting & Renaming Snapshots” on page 33..

Also keep in mind that, when loading a Helix or Helix Native-created preset while Helix
Native is currently in an HX device HC mode, HX modes support fewer snapshots (HX
Effects presets include up to 4 and HX Stomp up to 3 snapshots, where Helix/Helix
Native presets support up to 8 snapshots). Therefore, when a preset is translated to one
of the HX device HC modes, the extra, non-supported snapshots and their contents
are discarded.

Bypass Assignments

A common practice within Helix devices is to configure “bypass assignments” where
the bypass parameter of blocks are then toggled Off/On via the device's footswitches,
or optionally by expression pedals or external MIDI commands. Currently, MIDI bypass
assignments are supported in Helix Native (see next section), but not other types
of bypass assignments that can be created within Helix hardware. If you happen to
change the bypass state of block that includes a Helix hardware bypass assignment
and export the preset, you will overwrite the saved state of the assignment when the
preset is imported back into a Helix device.

Also note that when a preset is loaded while Helix Native is currently in a different
HC mode from which the preset was created, bypass assignments that exist for
footswitches and controllers that don’t exist within the device HC mode are discarded
when the preset is translated.
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Controller Assignments

Helix device users can create “controller assignments” to map the control of parameters
(such as a wah or volume, a delay's Mix parameter, etc.) to a Helix expression pedal,
footswitch, or external MIDI controller device. Currently, MIDI In controller assignments
are supported in Helix Native plug-in (see next section), but not other types of controller
assignments that can be created within Helix hardware.* If you edit a parameter that
includes a Helix hardware controller assignment, and then export the preset from Helix
Native, your last-used parameter value is the same value the parameter will default to
upon import within a Helix device.

3 *NOTE: When importing a preset into Helix Native which includes HX Edit-saved
I hardware controller assignments, you'll see the assigned parameter sliders within
Helix Native display their values in white brackets indicating the assignments.
Even though these hardware controller assignments are not supported within
Helix Native, they are preserved with the preset (as well as with the respective,
individual blocks for copy/paste). Therefore, these assignments will still be intact

if you import the preset back into HX Edit.

MIDI In Bypass & Controller Assignments

Helix device users can create MIDI In bypass assignments to remotely toggle the bypass
of most block types, and create MIDI In controller assignments to remotely control
most Helix parameters, via external MIDI controller devices or MIDI software. These
MIDI In assignments are also supported by Helix Native. Likewise, MIDI In bypass and
controller assignments created in Helix Native presets are also supported when the
preset is imported into Helix devices via the HX Edit application. See page 49.

Command Center Assignments

The Command Center in Helix devices provides the ability to assign the transmission
of MIDI/QWERTY Hotkey/CV/Amp switching and other commands to Helix hardware
switches and expression pedals. Helix Native does not support the transmission of
these types of commands and, therefore, essentially just ignores any Command Center
assignments that may exist within an imported Helix preset. Existing Command Center
data is retained when exporting a preset from Helix Native.

Automation Controller Assignments

Since parameter automation is a functionality specific to DAW hosts and software plug-
ins, all automation controller assignments saved within a Helix Native-exported preset
will be ignored when the preset is loaded on Helix hardware devices. However, these
assignments are retained if and when the preset is exported from a Helix device. See
“Controller Assignment for Automation” on page 44.

Customized Hardware Footswitch Labels and LED
Colors

Helix and HX Effects devices include the ability to customize the labels displayed
on their “scribble strips” (on Helix Floor, Helix Control, and HX Effects devices) and
on-screen footswitch labels (on Helix LT devices), as well as to customize the color
displayed for their footswitch LED rings. This data is stored within a hardware-exported
preset, but is not utilized by the plug-in, nor altered when importing or exporting the
preset with Helix Native.

Z TIP: Remember, you can create an unlimited collection of backups of your presets,

¥ setlists and bundles from both Helix Native plug-in and the HX Edit application
using their Export functions. It is good advice to follow the golden rule, “back up
early and often” so that you always have copies of your favorite Helix tones!

Computer Processing Management

As covered at the start of this chapter, in order to maintain preset compatibility with
Helix and HX devices, each HC mode within Helix Native (except for the “Off” mode
option) incorporates a similar processing management as the DSP management
system utilized on the hardware device type. That is, Path 1 (and Path 2, if in a Helix
or Helix Native HC mode) within an instance of the plug-in each have a maximum
computer processing limit. Once this limit is approached on either path, the Edit tab's
Model Browser options become dimmed if the specific models require an amount of
processing power that would surpass maximum limit for the target device type/HC
mode. (Please see “Availability of Models within the Model Browser” on page 40.)
This way, any preset created and exported from the Helix Native is ensured to be able
to be imported and utilized in HX Edit for the intended target device.

If you set the Helix Native HC mode to “Off,” the processing limits are completely
removed, allowing you to add up to the maximum number of any blocks (and block
types) that will fit on any path. Note that this makes it possible to create an extreme
CPU demand in just one instance of the Helix Native plug-in, so it is best to be careful
not to bog down your DAW system with unnecessarily power-hungry plug-in options!

TIP: Please also see “Tips to Optimize Processing Power Usage” on page 39.

A\
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Presets Panel

The Librarian's Presets Panel provides functionality for loading, importing &
exporting Helix presets & setlists to manage the plug-in's Presets Libraries. Helix Native
incorporates one Preset Library for each of its four selectable Hardware Compatibility
modes (or HC modes), each with its own set of Factory Presets (please see “Hardware
Compatibility Modes” on page 13). When you select a HC mode, the respective
library for the mode is automatically loaded, allowing you to build and manage your
presets separately for each.

3 NOTE: As covered in the preceding chapter, when you import a preset into the
I Helix Native Presets tab, if the preset was created using a different source device
or HC mode than the HC mode currently in use by the plug-in, Helix Native will
attempt to translate it. If translated, the preset is successfully imported and then

resides within the current mode’s library.

Presets Tab = PRESETS il IMPULSES
Setlist Commands
Setlist Menu
Preset Commands PRESETS  COPY IMPORT | EXPORT
Last Loaded Preset D1A US Double Nrm

01B Essex A30
Selected Preset D1C Brit Plexi Jump
01D Cali Rectifire
02A US Small Tweed
028 Essex AlS

The Presets panel

Presets Tab - Click on this tab to display and place focus on the Presets panel.

Preset Commands - Click on any command in this row to perform its action on
the currently selected Preset(s).

Last Loaded Preset - When you double-click on any preset in the panel, it loads
it into the Signal Flow as the current tone in use by the plug-in. The white vertical
line at the left of the preset slot indicates that this is the last preset from within your
presets library that was loaded.

E NOTE: It is important to note that, once a preset is loaded as the current

I tone, changes to the current tone does not affect the preset within the Presets

Library panel unless you specifically Save the tone to the Preset Library—see
“Using the Preset File Menu” on page 28.

Selected Preset - Click once on any preset in the panel to select it, and you'll see
it appear highlighted, as shown above. The selected preset is the one that is acted
upon when choosing any Preset Command. Note that when you load a preset, it
remains the selected preset until you click on any other preset within the panel. It is
also possible to select multiple presets to perform actions on them simultaneously,
as covered in the following sections.

Setlist Commands - Click on any command in this row to perform the selected
action on the current Setlist.

Setlist Menu (Helix and Off HC modes only) - Click here to display one of the 8
Setlists of the Presets Library. Right-click directly on the current Setlist's name
here to rename it.

B NOTE: When in the Helix or Off HC mode, it is also possible to import and export

I all setlists, including all your presets and their last-saved settings by using the
Bundle options found in the Preferences window. Please see “Preferences -
Presets/IRs Tab” on page 54.

Helix Native Factory Presets

The very first time you insert an instance of the Helix Native plug-in after installation,
as well as the first time you select one of the four Hardware Compatibility modes (see
page 13) you'll see a pop-up notice informing you that the mode’s unique Preset
Library and set of Factory Presets will be automatically imported. This automatically
builds and populates the Helix Native HC mode with numerous Factory Presets to
provide an easy start for your own sonic creations! The Helix and Off modes include
3 setlists of factory presets, and the HX Effects and HX Stomp modes include a large
number of factory presets within their single setlists.

All factory presets can be edited and overwritten as desired. Most factory presets are
intended for guitar, but, depending on the current HC mode, you’ll also see presets
titled starting with identifying codes, as follows.

“BAS” presets are intended for bass guitar

“FX” presets include FX blocks only (no amp or cab blocks)

“DIR” presets are intended for direct guitar recording and include amps and
effects blocks

+ “VOX” presets are intended for vocals
“KEY” presets are intended for keyboards

“AUX” presets are intended for use on your DAW project’s Auxiliary or Bus
tracks

>20<



+ You may also see some descriptively titled template presets, designed to
provide an easy start for specific configurations, such as for “Parallel” effects
processing, “Discrete Stereo” for 2 discrete channel processing, “Remote”
for those that include QWERTY key commands to remotely control popular
apps, etc. Also see “The Signal Flow Window” on page 34 for more on Helix
Native’s capabilities for mono, stereo, serial and parallel signal routing

=

Z TIP: If you want a clean start, we've also provided the options Clear Preset
v Library (to clear out all presets from all your plug-in's current Library) and
Restore Factory Setlists (to restore the original Helix Native factory presets).
These commands act only upon the current HC mode’s Preset Library. Please see
“Preferences - Presets/IRs Tab” on page 54.

Premium Marketplace Presets

If you've purchased and downloaded premium presets from the Marketplace online
shop, you must initially have Helix Native signed in, and your computer authorized,
to allow the import or export of these presets (as well as for import and export of any
setlists or bundles that include premium presets).*

| NOTE: The authorization required for your Helix Native license also covers the use
S of any Marketplace premium assets on this computer—both within Helix Native
(version 1.70, or later) and the Line 6 HX Edit (version 2.70, or later) application.

Please see “Authorizing your Computer” on page 5.

Premium Marketplace presets are otherwise able to be utilized just like any other
Helix Native, Helix or HX device presets. When imported, these premium Marketplace
presets are indicated by a golden guitar pick “badge” to their right within the Presets
panel. Please also see “Marketplace & Account Options” on page 58.

1l IMPULSES

1 USER1

PRESETS  COPY | PASTE | IMPORT | EXPORT

01A Endless Solo
Sniff the Glove
GD-DR.Z ROUTE 66 L
GD-ENGL FIRE 100  J
-

Premium Marketplace presets are indicated with a golden guitar pick badge

Loading Presets

Double-click on the desired preset from the Presets panel list to load it into the Signal
Flow window as the current tone, with all blocks' parameters accessible within the Edit
tab. You can also use the Next/Previous preset buttons at the top of the Signal Flow
window (see “Navigating with the Next/Previous Preset Buttons” on page 27).

E NOTE: |t is important to understand the differences and behaviors for Loading
I a preset into the Signal Flow and Importing a preset into the plug-in’s Preset
Library. Please see “Loading vs. Importing Presets into Helix Native” on page 13.

Alternatively, if you wish to load a preset that exists as a saved Helix preset (.hix) file on
your computer, you can do one of the following:

Use the preset Import command button and select the desired preset from
your computer to import it into the plug-in's current Preset Library, then double-
click the imported preset within the Presets list to load it as the current tone.

Use the Open from Disk option from the menu at the top of the Signal Flow
window. This loads the preset directly into the plug-in's Signal Flow as the
current tone (without importing it into the Preset Library).

E NOTE: Use the Save To Disk or Save To Library command within the file menu

I at the top of the Signal Flow if you wish to retain any changes you've made to

the current tone to create it as a preset that can be utilized by other Helix Native
instances, as well as with HX Edit.

The Default Preset

Whatever preset resides within location 01A of the first Setlist becomes the designated
Default Preset for the current HC mode’s Preset Library within Helix Native. You'll see
that this preset is the one automatically loaded into the Signal Flow every time you
create a new instance of the plug-in (using the same HC mode). This allows you to set
any preset you like as the Default Preset for Helix Native —by simply importing or saving
it to this Preset Library location!

All settings that you customize and save to this library Default Preset are recalled when
loaded, including automation assignments, routing configuration, block bypass states,
etc.

Importing and Exporting Helix Preset Files

Helix presets are able to be exported from the Presets Library to be copied and saved
to your computer as individual (.hlx) files, allowing you to create a limitless collection of
tones that can be imported back into your Presets Library at any time.

_ To Import a Helix Preset File - Helix Native can import a Helix (.hlx) preset
>< file that was created with Helix Native while in any Hardware
HEH Compatibility mode, or that was exported from any Helix or HX device

(via the HX Edit application). Helix Native. To import a preset, click once to select
the desired preset location within the Presets panel and click the Import preset
command.

If Helix Native is already using the HC mode that matches the mode or device from
which the preset was created, the preset is imported into the current Preset Library.
If Helix Native is currently using a different HC mode, then you will be prompted to
either change Helix Native to the matching HC mode, or have the plug-in attempt
to convert the preset to the current HC mode. (Please see “Hardware Compatibility
Modes” on page 13 for details.) The imported preset will then remain available
within the current HC mode’s Presets Library—and accessible for all instances of
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the plug-in that utilize this HC mode.

B NOTE: Importing a preset into the Preset Library does not also automatically

I load the preset into the Signal Flow of the plug-in. If you wish to load the
imported preset as the current tone, double-click on the preset within the
library location. Please also see ”Loading vs. Importing Presets into Helix
Native” on page 13.

To Export a Helix Preset - Click once to select the desired preset within the Presets
panel, then click the preset Export command. This creates a copy of the preset
from the Helix Native plug-in's Presets Library and saves it to your computer as a
Helix preset (.hlx) file. The familiar Mac or Windows computer's Save As window
is presented, in which you can edit the filename and choose a destination folder.

The exported preset file is saved in the device/mode format matching the current
Helix Native HC mode.

TIP: Using the Preset panel's Export command makes a copy of the selected library
preset in its last-saved state and saves it to your hard drive. If you wish to save the
tone currently in use within the plug-in's Signal Flow, with all edited settings intact,
use the File menu - Save options (see “Using the Preset File Menu” on page 28).

g\

Renaming, Reordering, Copying and Pasting
Presets

These functions allow you to customize your presets within the current Preset Library
panel. Choose Rename, Copy or Paste from the row of Preset command buttons
and it will act upon the selected (highlighted) preset location. Or, optionally right-click
on an individual preset location within the panel to open a context menu with these
same commands. For most commands, it is also possible to multi-select a number of
presets by using Shift+click to select a contiguous set of presets, or Cmd+click (Mac)
or Ctrl+click (Windows) to select a non-contiguous set.

B NOTE: Copy and Paste of presets and IRs between Helix Native and HX Edit is not
‘T‘ currently supported. However, you can use drag and drop for these actions! See
the next section.

Drag and Drop Presets

Drag and drop any preset (or multi-selected presets) directly to or from the plug-in's
Presets panel to perform the following actions.

+ Export - Drag any preset from the plug-in's Presets panel into any folder on
your computer to export a copy of the .hix Helix preset file and save it there.

Import - Drag any saved .hix Helix preset file from your computer's hard drive
and drop it directly into a slot within the plug-in's Presets panel to import it into
the Presets Library. (Note that this does not automatically load the preset as
the current tone in the plug-in. Double-click the preset slot you imported into
to load the preset.)

Load - Drag any saved .hix Helix preset file from your computer's hard drive

and drop it within the plug-in's Signal Flow window to load it.

E NOTE: This “Load” action loads the preset as the one used within this

" instance of the plug-in, but it does not import the preset into the plug-in's
Presets Library. Optionally, you can add this loaded preset by using the
File > Save to Library option within the Signal Flow window —see “Using
the Preset File Menu” on page 28.

Reorder - Drag any preset up or down and drop it into another location within
the Presets panel to reorder the presets within the current setlist. When the
preset is dropped in the new location, the surrounding presets are shifted
upward or downward accordingly.

Transfer to or from Helix/HX Hardware - With a Helix or HX device connected,
you can drag a preset directly from Helix Native plug-in's Presets panel and
drop directly into the Presets panel of the HX Edit application to import the
preset into your Helix device. Likewise, you can drag a preset from the HX Edit
app into Helix Native to import your device's library presets into the plug-in
(also see “Preset Compatibility with Helix and HX Devices” on page 13).

Importing and Exporting Setlists

The Presets panel allows you to Export to save a copy of the currently loaded setlist,
including all its presets, to a Helix setlist file (.hls). This is very handy for making a
backup of all presets within a setlist, so that a group of presets can easily be imported
back into the plug-in's Library in a single action. Setlists are exported in the format
matching the current HC mode in use within Helix Native.

_ To Import a Setlist - Click Import Setlist.* This will prompt you to ensure
== that you wish to replace the currently selected setlist and its presets
st within the plug-in's Presets Library. Continue through the “Open”

window to select the setlist you wish to import.

| *NOTE: If you import a setlist that was created with a different source HC
I mode (or from a different source device) than currently in use, Helix Native
will attempt to translate its presets for the current HC mode. (See “Preset

Translation” on page 15.)

To Export a Setlist - Click the Export Setlist command to save a copy the current
setlist as a Helix setlist file on your hard drive.
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Changing Setlists Importing and Exporting Helix Bundles

(A.va.ilable only when in thg Helix or Off HC modes) To change the active setlist shqwn (Available only when in the Helix or Off HC modes) A Helix bundle file (.hlb) includes
gg?é%ta?tﬁit:?ﬁf planell, Iclchlfbon th?rﬁet“St metr|1u anld cth%oset}‘.r%m ‘f:l”rnbong 'g!e 8,(35”'3.‘:? all 8 setlists that make up the plug-in's current Library, including all presets and saved
« N plug-in's Library. The currently-selected setiist will be indicated wi settings, all wrapped up in a single, tidy package. This makes it easy to store a backup
an “open folder” icon in the menu. of your complete Presets Library—and easily restore your Helix Native Library by
importing the bundle. Setlists are exported in the format matching the current (Helix
I PRESETS LRI or Off) HC mode in use within Helix Native. The options for importing and exporting a

SETLISTS Bundle are found within the Preferences > Presets/IRs tab (also see page 56).

Presets/IRs Hardware Compatibility

FACTORY 2
Preset Numbering Format: ~ 01A-32D

Stereo IR Import: Use Left Channel

Clear Preset Library Restore Factory Setlists

Clear IR Library

Choosing a new setlist from the setlist menu

Note that no new preset is loaded from within the new setlist until you specifically —— AR
double-click on a preset from within the new setlist.

Renaming Setlists Restore Factory Settings Check!rundates .
(Available only when in the Helix or Off HC modes) To rename the current setlist, right- Use the Import/Export Bundle buttons in the Preferences - Presets/IRs window
click on the current setlist's name within the Setlist menu and enter your new title. To Import a Bundle - Click the Import Bundle button found in the Preferences

> Presets/IRs tab.* This will prompt you to ensure that you wish to replace all
setlists and presets within your Presets Library with those from the selected
bundle file. Continue through the “Open” window to select the bundle you wish to
import.

R ing th t setlist . . .
enaming the current setiis 3 *NOTE: If you import a bundle that was created with a different source HC

I mode than currently in use, Helix Native will attempt to translate its presets for
the current HC mode. (See “Preset Translation” on page 15.)

To Export a Bundle - Click the Export Bundle button found in the Preferences >
General window to create a copy of the plug-in's complete Presets Library as a
Helix bundle (.hlb) file, stored on your computer.

B NOTE: Bundle files do not contain any of the Impulse Response (IR) files that
I you may have imported into the Impulses Library. You can separately export
IRs from within the Impulses Panel—see “Importing and Exporting Impulse
Responses” on page 24.
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Impulses Panel

The Librarian's Impulses Panel provides a list of up to 128 Impulse Response files
(along with their respective index numbers), which are available to all instances of
the Helix Native plug-in. Initially, this Impulses panel is empty, awaiting you to import
Impulse Response files. Once imported, Helix Native presets will access the IRs
displayed within the Impulses panel by their index number only. Impulse Response files
themselves are not directly associated with presets.*

Impulses Tab

:= PRESETS

il IMPULSES

IR Commands CORY IMPORT | EXPORT | CLEAR

001_Allure_V30
Allure_P10N
3_Allure_Greenbk
Allure_P12N

Selected IR
IR Index Numbers <

eambk12

The Impulses panel
Impulses Tab - Click on this tab to display the Impulses panel.

IR Commands - Click on any command in this row to perform its action on the
currently selected IR(s).

IR Index Number - Each IR slot includes an Index Number at its left. This index is
what is referenced by an IR block within a Helix preset, allowing the block to utilize
whatever actual IR file is imported into this IR Library slot.

Selected IR - Click once on any IR in the panel to select it, and you'll see it appear
highlighted, as shown above. The selected IR is the one that is acted upon when
choosing any available IR Command.

B *NOTE: Unlike the Helix Native Presets Library, where each Hardware Compatibility
S mode includes its own, individual Preset Library, the Impulses Library is a common
library, shared between all HC modes in the plug-in. Therefore, IR blocks within all your
presets, regardless of the current HC mode in Helix Native, will always reference the
index numbered slots within this same IR list.

What are Impulse Responses?

Impulse Responses (or “IRs”) that can be used in Helix Native are audio files that are
the result of capturing the sound of a test tone (frequency sweep) through a guitar or
bass amp speaker cabinet, which has been de-convolved with the original tone signal. This
represents the frequency response of the cabinet itself and can be used to simulate the way it
alters the sound. This is similar to a convolution reverb, but with a much shorter decay.

You can add an IR block to your preset as an alternative to using one of the Cab blocks
to provide speaker cabinet simulation along with an Amp block. Several companies
now offer large selections of professionally recorded IRs that can be used in Helix Native,
or you can even do some research on how to record and create your own.*

You can also find some IRs that were created using this convolution process to capture
the properties of acoustic guitar bodies, guitar pickups and other items. These IRs can
be used in the Helix Native or Helix & HX devices' IR blocks, to allow even deeper tone
sculpting!

*TIP: Helix IRs are now available for purchase from the online Marketplace, which
you can access directly right from inside Helix Native plug-in (version 1.70, and
later). Please see “Marketplace & Account Options” on page 58.

T A\

IR Formats and Restrictions

Once imported, files are automatically conformed to the Helix-compatible IR properties
(48kHz, 16-bit, Mono, 2048 or 1024 samples). For Helix Native plug-in, as well as for all
Helix and HX devices, the following IR file types are supported.

Helix Impulse Response (.hir) - This is the proprietary Line 6 IR file format.
All IRs purchased through the Marketplace are of this file type. Please also see
“Marketplace & Account Options” on page 58.

WAV (.wav) - Most IR producers and vendors typically offer IRs within the .wav
format. It is possible to import a mono or stereo .wav file IR, regardless of its
bit depth, length, or sample rate frequency. Once imported into Helix Native or
Helix hardware, files are automatically conformed to the Helix-compatible IR
properties (48kHz, 16-bit, Mono, 2048 or 1024 samples). Please be careful to
import only .wav files that were created specifically for use as IRs, not just any
audio .wav file, or you may experience unexpected sonic results.

\

Z Helix and HX Device Users: If you plan on utilizing your Helix Native presets in both
¥ Helix Native plug-in and your Helix or HX hardware, the best practice to import the

same exact IR files into both, and in the same IR list order. This allows all IR blocks
to reference and load the same indexed IR files for all presets that use them. Please

also see “Preset Compatibility with Helix and HX Devices” on page 13.

Importing and Exporting Impulse Responses

To Import an IR - Click once to select the desired index location within the Impulses
panel and then select the Import command button at the top of the Impulses list.
Continue through the File-Open window to select the desired IR file. If you select
multiple IR files, they will all be imported into contiguous index locations.

Premium Marketplace IRs

If you've purchased and downloaded premium IRs from the Line 6 Marketplace online
shop, you must initially have Helix Native signed in, and your computer authorized to
allow the Import or Export and license synchronization for these IRs.”
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B “NOTE: The authorization required for your Helix Native license also covers the use
S of any Marketplace premium assets on this computer—both within Helix Native and

the Line 6 HX Edit application. Please see “Authorizing your Computer” on page
5 and “Marketplace & Account Options” on page 58.

When premium Marketplace IRs (.hir files) are imported, they are indicated by a guitar
pick “badge” to their right within the Impulses panel.
= PRESETS i1l IMPULSES

IMPORT

001 _Allure_V30
002_Allure_P10N

003_Allure_Greenbk
004_Allure_P12N
005_Creambl12
006_HMP_2x12_GBack20/ @
007_HMP_2x12_GBack3( W@
00B_HMP_2x12_V30 L

009_HMP_2x12 D140 l

Premium Marketplace IRs are indicated with a guitar pick badge

To Export an IR - Select the desired IR(s) within the Impulses panel and click the
Export command to display the Save As dialog.” You may also drag & drop to and from
the Impulses panel to import and export IRs—see the following section.

*TIP: Exporting your complete list of IRs is a nice way to keep a backup of them
all in one place on your computer. It is helpful to rename your exported IR files to
include their stored index ID number at the start of the title (001 through 128, as
shown in the image at the start of this chapter) to easily identify what IR slots they
should be imported back into.

ag\

Renaming, Loading, Copying, and Clearing IRs

These functions can be performed by clicking the command buttons above the Impulses
index list and will act upon the selected (highlighted) IR. You can also right-click on any
IR slot to choose these options from the context menu.

TIP: We've also provided a handy Clear IR Library option, to clear out all IRs
from the plug-in's current IR Library in one click—see “Preferences - Presets/
IRs Tab” on page 54.

A\

Drag and Drop IRs

There are several drag and drop options that allow you to import and export single or
multiple IR files between your computer’s hard drive directories and Helix Native, as
listed below.

Import - Drag one or more IR (.hir or .wav) files from your computer's hard drive
folder directly into the Impulses panel. When multiple files are being dragged in,
they are imported in sequence, starting with the selected IR index slot.

Export -Select one or more IR index locations in the Impulses panel and drag
directly to your computer to export the IR files to the selected hard drive folder.

Load - Select any of the 128 index slots which contains an imported IR file
and drag and drop it directly onto a path within the current tone’s Signal Flow
to insert an IR block, and load the selected IR within the block. (Also see the
following “Loading an IR” section for more options.)

Copy - It is also possible to drag and drop IRs within the Impulses list view to
create a copy of the IR in a new index location.*

3 *NOTE: There are intentionally no options to move or reorder IRs in a single
I operation. Use the Copy and Clear functions to rearrange IR within the
Impulses list as needed.

Transfer To/From Helix Hardware (for Helix/HX device owners) With a Helix
or HX device connected, drop an IR from the Helix Native plug-in's Impulses
panel directly into the Impulses panel of the HX Edit application. It is also
possible to drag an IR from HX Edit into the Impulses panel of Helix Native to
import a copy of the same IR file.

Loading an IR in an IR Block

[ When you insert an IR block within your preset's Signal Flow, it initially defaults to
| referencing the #1 IR index location (if you have not yet imported any IR file into
the referenced index location, the “empty” IR block has no effect on the signal).

To follow are a few methods for loading an IR into an IR block, which determines the IR
file that is associated with the IR block (also see “IR File Reference” on page 26 for
additional behaviors).

Use the Edit tab’s IR Select slider - Select the IR block within the Signal Flow,
then, in the Edit tab, use the IR Select parameter slider (or its menu at the right)
to select IR index number (1-128) that includes the desired IR.

AUTOMATION/CONTROLLER ASSIGN

IR 1024

Choosing an IR by its Library index number within the Edit tab
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Double-click in Library - Select the IR block within the Signal Path and then
double-click on the preferred IR within the Impulses Library list to load into the
IR block—replacing any currently referenced IR. Note that no action is performed
if you do not have an IR block selected.

Drag and drop - As mentioned in the preceding section, you can also add an IR
block already loaded with an IR by dragging the desired IR from the Impulses
Library panel and dropping it directly into an empty location within your Signal
Path. (Drag and drop from the IR Library always adds a 1024 Sample type IR
block.)

You can use the other IR block parameter sliders in the Edit tab to further shape the IR's
tone and level—see “Editing Model Parameters” on page 41. Once done selecting
an IR and its parameter options, be sure to save the preset to retain your IR block
settings.

\

Z TIP: Optionally, you can create a snapshot assignment (see page 32) on the IR

! Select parameter, which then allows you to change the block’s associated IR as
desired, per snapshot!

Whenever you load a preset that includes one or more IR blocks that reference an
empty IR index location, a pop up is displayed to alert you. For example, the alert
shown below is telling you that the preset includes two IR blocks, on Paths 1A and
1B, which cannot locate their originally associated IR files. The “Position” denotes the
block position of each IR block from left to right on the path, starting with “0” for the left
position. Please see the next section for more related IR behaviors.

Helix Native

. The IR(s) associated with the following blocks in this
preset could not be found in the Impulse Library:
Path 1A, position 4
Path 1B, position 3

Missing associated IR(s) alert pop-up

IR File Reference

Once an IR block is configured to utilize an IR index slot that includes an imported IR
(-wav or .hir) file, and the preset then saved (using Helix Native version 1.90 or later), the
preset creates a “reference signature” to the imported IR from its file name. Therefore,
even if you re-order IRs within the IR library list, your preset will still intelligently reference
the originally associated IR file, even if it now resides in a different IR Library index
location. The following behaviors apply:

If you clear or replace the IR file within the IR index slot for which the preset’s

IR block is configured to use, upon the load of the preset, the IR block will first

attempt to locate another instance of the missing, associated IR file within the

Impulses Library and automatically utilize it and its residing index slot. You'll

be alerted if the original associated IR is not found within the IR library (see

previous section).

+ If the configured IR index slot is currently empty, you’ll be prompted with an
alert (see previous section) that the IR block’s associated IR file cannot be
found, and the IR block continues to utilize the same (now empty) IR index
slot. You’ll want to configure the IR block to utilize an occupied IR index slot
(or import an IR into the currently referenced slot) and save the preset.

- If the original IR file is cleared from Library, and the IR index slot includes a
different IR file, you’ll be prompted that the associated IR cannot be found,
and the IR block utilizes this new IR file within the configured index slot. You'll
need to save the preset with this reference to the new IR (or configure the IR
block to use a different, occupied IR slot) to avoid seeing the alert pop-up on
future loads of the preset.

+Once an IR block is configured with an occupied IR Library index selection, and
the preset then saved, the IR (.wav or .hir) file retains this reference signature
when exported from the library—thus, even if you import the exported IR file
again into any index slot within your Impulses Library, the saved preset’s IR
block will still be able to locate and utilize it.”

Yes, the above rules all sound a bit complicated, but in typical use, all this really just
means that if you happen to move your IRs around in the IR Library list, your saved
preset will now not lose their link to them!

B *NOTE: The IR file reference functionality is also incorporated in the HX Edit
‘r software. Therefore, Helix and HX hardware presets exported from HX Edit will
exhibit the same behaviors and attempt to locate their referenced IR .wav files from
within the Helix Native IR library upon loading within the plug-in. Likewise, presets
exported from Helix Native will attempt to locate their IR blocks’ referenced IR .wav
files when loaded within HX Edit. The moral of the story here is simply to import the
same IR .wav files into both HX Edit and Helix Native if you plan on sharing your
crafted presets between them, and the proper IRs will automatically be utilized from
your IR library, regardless the IR slots where they reside.
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Working in the Plug-in Editor

To the right of the Librarian panels is the Editor Ul of the plug-in, which consists of a top row of options, the Signal Flow and Inspector windows, offering a multitude of options for
adding & configuring processing blocks, signal routing & parameter automation configurations. See the following sections for details on using these user interface elements. Note that
the Signal Flow layout changes within the plug-in differ depending on the selected Hardware Compatibility mode that is in use. We’ve called out within the following sections where
options and behaviors differ between HC modes. Please also see “Hardware Compatibility Modes” on page 13.

Next/Previous Preset Preset Name Preset File Menu

Show/Hide
Librarian Button

US Double Nrm

Signal Flow Window —

EDIT
B Guitar il

Bl US Double Nrm

Inspector Window —

Navigating with the Next/Previous Preset Buttons

These buttons provide an easy way to increment forward and backward within the
current plug-in Library setlist, instantly selecting and loading the next/previous preset
into the Signal Flow window. If you wish to have these buttons navigate through a
different setlist, choose the desired setlist from the Setlist menu at the top of the
Presets panel.

1| SNAPSHOT 1

Snapshots Menu Undo / Redo Buttons A/ B Buttons

Tempo Controls

L

Edit & Automation/Controller

AUTOMATION/CONTROLLER ASSIGN Assign Tabs

Bl US Double Nrm

Naming the Preset

The Preset Name field displays the name of the most recently loaded Helix preset.
Double-click on the text here to optionally rename the preset.

3 NOTE: When you edit the preset title or make any other changes to the preset's
" settings after initially loading it, be sure to use the Save to Library or Save to Disk
options found within the Preset File menu (see next section) if you wish to retain
your changes within a preset that can be utilized by other Helix Native instances!
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Using the Preset File Menu

To the right of the Preset Name field is the File menu which includes options for the
current tone.

Preset File Menu Button

=> L US Double Nrm 1 | SNAPSH

Open From Disk...

= 5 ;
INPUT Save To Disk...

i |l|||

Save To Library... N

- Open From Disk - Allows you to load a saved preset from your collections
of Helix preset (.hix) files saved on your computer. This differs from using the
Import command found within the Presets panel in that it loads the preset
directly into the Signal Flow without also importing the preset into the plug-
in's Presets panel library. If you edit this loaded preset and wish to save your
changes, use the Save options, as described below. (Also see “Loading vs.
Importing Presets into Helix Native” on page 13.)

- Save To Disk - Exports the currently loaded tone to your computer, offering you
the option for your specific save location.

- Save To Library - Allows you to choose any preset location within your Presets
panel to save the preset into the plug-in's internal Presets Library.

Configuring and Loading Snapshots

The Snapshots Menu allows you to load and edit the snapshots available within each
preset, providing instant recall of assigned parameter value changes, block bypass
states and more, in one click.

B8 NOTE: To follow is a quick description to get you going, but the snapshots
" feature is a big enough topic that we've dedicated an entire chapter to it. Please
see “Working with Snapshots” on page 31.

Current Snapshot
Indicator (1 - 8)

SNAPSHOT 1 Snapshot Menu

SNAPSHOT 1

2 SNAPSHOT 2
SNAPSHOT 3

The Snapshots Menu

- To Configure and Edit a Snapshot - Click on the Snapshots Menu and select
the snapshot index number you wish to edit, then configure all desired options
for your current tone's block bypass states, tempo and snapshot controller-
assigned parameters' values. Your changes are stored automatically for the
current snapshot index number. Be sure to Save your tone to permanently
retain your snapshot settings with the preset.

To Load a Snapshot - Simply choose the desired snapshot index number from
the menu and all the settings configured for the snapshot are recalled instantly.

Z TIP: Snapshots can also be loaded in real-time via your DAW host's plug-in
W parameter automation functionality—see “Automating Snapshot Changes” on
page 48.

Undo and Redo

Helix Native supports Undo and Redo for most edit actions performed within the plug-
in window, accessible via the Undo and Redo buttons at the top of the main plug-in
window. The Undo / Redo history is tracked per instance of the plug-in.

-y ™ A

The Undo and Redo buttons

1/ SNAPSHOT 1

Undo / Redo is available for most actions performed in Helix Native, including:

Parameter changes
Snapshot changes
Changing block models

- Signal Flow view changes (adding/cutting/clearing blocks, changing path
structure, etc.)

Master Input and Output Level sliders
A/B Compare functions (see next section)
Preset changes”

3 *NOTE: Loading a preset from the Presets Library window (or using the Open
I From Disk command within the Preset File Menu at the top of the Signal Flow)
is undo-able, but most other actions performed within the Library window are
not. A few other limitations apply to Undo for preset changes—please also
see the following list of unavailable Undo actions for details.
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Actions not available for Undo / Redo include the following:

(=0

- Tempo changes

- Adding, editing, and removing automation, snapshot, bypass, and controller
assignments

3 NOTE: When Undo restores the removal of a block that includes
Y assignments, in most cases, these assignments are restored with the block,
but in some cases may not be able to be retained.

- Edit actions performed via automation controllers and MIDI CC messages

+ Setlist and preset loading done via MIDI Bank/Program Change, CC
messages, or via automation®

- Pasting a copied snapshot
+ Changes to any settings within the Helix Native Preferences window
+Changing the Hardware Compatibility mode, either via the Preferences

window HC mode selection, or via loading a preset from a different device/HC
mode source (also see “Hardware Compatibility Modes” on page 13)

+ Actions performed within the Presets and IR Library windows (e.g., importing,
reordering, or pasting presets or IRs, etc.) Note that loading a preset by
double-clicking on it directly within the Presets Library is supported within
Helix Native —see next point

+Undo for the action of loading a preset is supported, with a few limitations:

+ Loading a preset which also includes a HC mode change is not supported
by Undo, and will clear the current Undo history

+ Any preset change performed via MIDI PC/CC messages or automation will
also clear the current Undo / Redo history

NOTE: Host DAW applications also typically offer their own Undo / Redo
commands, and some also offer “A/B Compare” features as well. However, due to
the complex architecture of Helix Native, these types of host commands typically
cannot track most actions performed within the plug-in. Therefore, we suggest
you use only the built-in Undo / Redo within Helix Native for restoring its actions.

Using the A/B Compare

The set of A/B Compare controls allow you to temporarily store all your current Helix
Native parameter settings as a starting point for further fine-tuning, and then easily
compare new, edited settings with the original settings.

[]Er] =

The A/B Compare controls

-
¥

NOTE: DAW host applications often include their own A/B Compare feature for
effects plug-ins. However, since Helix Native is a complex effects plug-in with its
own Presets Library and numerous parameters, it is recommended you use this
A/B Compare within Helix Native for its settings.

Also note that these A/B Compare controls are also supported by Undo/Redo,
allowing you to reverse the actions performed by the A, B, and Copy To buttons.

To follow is an example for how to use this feature.

1.

Start with the A button selected. Once you have loaded a preset or created a
tone to your liking within the Helix Native Signal Flow, click the middle Copy To

B button.
| -

Copy AtoB

This copies all the plug-in’s current parameter settings to the B location,
providing you with a stored “starting point” for further adjustments.

Select the B button and proceed to edit your tone to fine-tune it as desired. Note
that you can make any type of edits you like within the plug-in—adjust sliders,
bypass/move/add/clear blocks, add/edit/remove automation & controller
assignments, or even load a different preset.

You can now switch between both settings by clicking the A/B buttons while
playing your track and audibly compare between them.

Optionally, while the B button is selected, you can make further adjustments and
continue comparing to your original A settings.

If you decide you still prefer your original settings, simply switch back to, and
remain on, setting A.

If you decide you prefer your edited settings, with the B button selected, copy
the B settings to the A location by pressing the Copy To A button.

CopyBto A

This allows you to have these settings now stored in both A and B as your new
“starting point,” from which you can repeat the steps 3-5 for further fine-tuning.

All your current settings for A and B remain stored within the plug-in instance for the
host DAW project.
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Editing the Tempo

There are a few options available for configuring the tempo that is utilized by the plug-
in, accessible from the controls at the top of the Signal Flow window. Any of the current
tone’s effects blocks that are set to note division values (a Note Sync option is available
for most delay and modulation effects within the Edit tab—see page 41) will follow
this tempo value.
Tempo Select Menu Numerical Tempo Field

& Tap Tempo Button
Per Snapshot

i= Per Preset N

< ) Host Sync

The Tempo controls

How the Tempo Value is Recalled

Use the Tempo Select Menu to select how the tempo value is utilized and recalled.

+  Per Snapshot - The tempo value will be stored and recalled individually with
each snapshot (see “Working with Snapshots” on page 31 for details).

«  Per Preset - The tempo value will be stored and recalled individually with this
preset.

+ Host Sync - The tempo value follows the timeline tempo of the host DAW
project for any preset loaded within the plug-in instance. Note that even if your
DAW project has timeline tempo changes automated, Helix Native will follow
when using this setting! This is the initial default setting for the plug-in.

Entering a Tempo Value

To the right of the Tempo Select Menu is a combined Numerical Tempo Field and
Tap Tempo Button. When you have selected the Per Snapshot or Per Preset tempo
modes in the menu (as noted above, when set to Host Sync, the plug-in tempo will
dynamically follow that of your host project), you can enter a tempo here in two ways:

- Right-click to type in your desired numerical tempo value.
+  Click rhythmically to “tap” in your preferred tempo.

Show or Hide the Librarian Panel

Click the button at the top left of the Signal Flow window to either display or collapse
the Presets & Impulses Librarian Panel. Also see “Customizing the Helix Native Plug-in
Window” on page 11.

1lilr IMPULSES

=> T US Double Nrm
The Librarian Panel's Show/Hide Button
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Working with Snapshots

Within Helix hardware devices and within the Helix Native plug-in, it is possible to create
& customize up to 8 “snapshots” within a preset.” Snapshots can store a set of options
(a block’s bypass state, snapshot-assigned parameter values, and tempo settings),
and then recall them without the brief lag time and audible signal drop-out typically
associated with changing presets.

3 *NOTE: The number of snapshots available within a preset differs depending
I upon the Helix Native Hardware Compatibility mode in use, or the source device

type, as follows (please also see “Hardw mpatibility M ” on 13):
+ Helix HC mode and Helix Floor, Rack, and LT devices include 8 snapshots
per preset.
- HX Effects HC mode and HX Effects devices include 4 snapshots per
preset.
+  HX Stomp HC mode and HX Stomp devices include 3 snapshots per
preset.

Also note that, if you load or import a preset into a Helix Native instance that
is configured to a HC mode that supports fewer snapshots, the unsupported
snapshot settings will be discarded for the preset.

Configure any snapshot(s) with your desired settings for the current tone within Helix
Native, and then recall any snapshot from the Snapshots menu, via your DAW host’s
parameter automation or via external MIDI control (MIDI CC 69—see page 52).
Snapshots created and exported from Helix/HX devices (via the HX Edit application)
are also supported within Helix Native, and vice-versa. This all presents some extremely
powerful mix capabilities in your DAW, with the ability to instantly recall and change
numerous Helix Native parameter settings in real-time!

=

Z TIP: Don't worry, you actually don't need to utilize or even understand anything
® about snapshots if you don't want to right now! You can completely ignore them
and edit your presets without accessing them at all. But if you want to explore the
possibilities, please keep reading this chapter.

Similar to the snapshots feature in some high-end digital mixers, each Helix Native
snapshot stores and recalls the state of certain elements within the current preset,
including:
+  Block Bypass - The bypass (on/off) state of all processing blocks, independent
of any footswitch assignments—see “Snapshots > Block Bypass”

- Parameter Control - The value of any parameter assigned to a snapshot
controller (up to 64 per preset)—see “Snapshots > Parameter Control”

+  Tempo - The current system tempo, if the Tempo Select is set to Per Snapshot.
(By default, it’s set to Per Preset.) See “Editing the Tempo” on page 30.

Depending on how you configure them, snapshots can act as multiple variations of the
same tone, multiple different tones, or any combination thereof—all within the same
preset.

The Snapshots Menu

Snapshots are accessed via the Snapshots menu at the top of the Helix Native plug-
in main window. The index number displayed within the little camera icon within the
Snapshots menu tells you which of the preset’s snapshots is currently loaded. Click the
menu to select and load a different snapshot. Ctrl+click / right-click directly within the
menu to rename the current snapshot as desired. Also see “Configuring and Loading
Snapshots” on page 28.

Current Snapshot
Indicator

Snapshots Menu

SNAPSHOT 1

SNAPSHOT 1

SNAPSHOT 2 N
'y

SNAPSHOT 3

L=

The Snapshots Menu

Snapshots > Block Bypass

Snapshots automatically store the current bypass (on/off) state for all processing
blocks. Therefore, all block bypass states are recalled when jumping from snapshot to
snapshot, and appear as you last left them. (It is also possible to exclude any block’s
bypass from being controlled via snapshots—see “Per-Block Snapshot Bypass
Option” on page 32.)

For example, with Helix Native in the Helix HC mode, here's a scenario where you might
configure and name snapshots to toggle the desired blocks on/off for each section of
your song.

Snapshot 1—INTRO could have Distortion 1, Amp 1, Cab, Mod 1, and Delay 1 on:

o v RN [ R ) O fOle

Snapshot 2—VERSE could have Dynamics, Distortion 2, Filter, Amp 2, Cab, IR, Delay
2, and Reverb on:

] R ] R O | O

Snapshot 3—BRIDGE could have Dynamics, Amp 2, IR, EQ, Mod 2, and Delay 2 on:

- QU JOY |-l 6 © |6

Snapshot 4—CHORUS could have everything on:

Jujugn=]=Jol -] Jujujojo] o]

And Snapshot 5—INTERLUDE could just be Amp 1 and the IR:

Aujuin] =]o] Jejujulojolo
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Note that all snapshots in a particular preset share the same models; you cannot, for
example, add a US Deluxe Amp block in Snapshot 1 and switch its model to Essex A30
in Snapshot 2. However, (if the current Helix Native instance has not reached its HC
mode’s maximum processing limit), you can load both amp blocks into the same preset
and snapshots can enable neither, one, or both of them.

Per-Block Snapshot Bypass Option

As covered above, the default behavior for all amp & effects blocks is that their bypass state
is automatically controlled by snapshots. But if you prefer to exclude a block from being
controlled by snapshots, select the block and set the Snapshot Bypass option from the
block’s right-click / Ctrl+click menu to “off” (so that no check mark appears at the left of the
menu option). Or, you can right-click on the block’s Bypass button within the top right
of the Edit tab and access the Snapshot Bypass command from its menu. Choosing the
command from the menu again (so that the check mark appears), returns the block to the
default snapshot behavior.

AUTOMATION/CONTROLLER ASSIGN

i I
88 Minotaur Automation Bypass » O

Gain MIDI Bypass 3
MIDI Learn...

Copy

Tone
Clear Block

Clear All Blocks

v Snapshot Bypass

Edit tab - Block Bypass button right-click menu

Automation Bypass »

MIDI Bypass »

+' Snapshot Bypass N

Block right-click menu
The Snapshot Bypass command within the block context menu

Snapshots > Parameter Control

In addition, parameters can be set to jump to specific values with each snapshot. Here’s
an example, again using the Helix HC mode in Helix Native, where seven parameters'
values (out of a possible 64) are updated instantly with each snapshot:

Snapshot é'a“iﬁ Dljl'iiy Split A/B  Pitch Se'gct VI‘_’L“'IZ‘I‘*
1 INTRO 4.5 35% Path A 100 0 #27 -7.2dB
2 VERSE 4.5 35% Path A 100 +5 #27 0.0dB
3 BRIDGE 5.2 43% Path B 100 +3 #103 +0.8dB
4 CHORUS 4.5 50% Path B 100 0 #103 +1.5dB
5 INTERLUDE 39 8%  EvenSpit 45  #27  00dB
6 SOLO 8.7 72% Path B 100 +12 #103 +2.6dB

Amp Delay . . IR Volume
Snapshot Gain Mix Slliedts e Select Level
7 BREAKDOWN 2.0 46% Path B 47 -12 #12 0.0dB
8 OUTRO 45 35% Path A 100 0 #41 -3.6dB

In the preceding table, we see that when changing from Snapshot 2—VERSE to
Snapshot 3—BRIDGE:
The Amp block’s Gain increases from 4.5 to 5.2
The Delay block’s Mix increases from 35% to 43%
- The Split block routes your guitar from Path A to Path B
« The Pitch block’s Interval lowers from +5 to +3 semitones
The IR changes from index #27 to #103
The Volume block’s Level increases from 0.0dB to +0.8dB

If you want a parameter to be automatically updated with each snapshot, the parameter
must first be assigned to a snapshots controller, as covered in the next section.

Assigning a Parameter to the Snapshots Controller

As covered in the preceding Snapshots > Block Bypass section, the bypass state of any
block is automatically stored and recalled per snapshot. However, for other parameter
types, it is necessary to first create a snapshots assignment to allow the parameter’s
value to be stored and edited per snapshot.

1.  Within the Signal Flow window, select the block which includes the parameter
you wish to control via snapshots. For this example, we’ll choose the Litigator
Amp+Cab block so we can control the amp’s Drive parameter.

2. In the Edit tab, right-click on the Amp’s Drive parameter and choose the
Snapshots option.

Line 6 Litigator

Controller Assign »* None

Automation Assign » MIDICC
Snapshots |

iy
MIDI Learn...

Assigning the Drive parameter to the Snapshots controller

3. You’ll see a little camera icon at the left, and the parameter’s value at the right

appear in white with brackets, to indicate the snapshots controller assignment.

Line 6 Litigator

Drive
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Now you can simply load any snapshot and set this Drive slider to the desired
value. The value is independently stored and recalled with each snapshot.

Each preset can have up to 64 controller assignments, including parameters
controlled by snapshots. Remember to save your tone if you want your
assignments to be permanently stored with the preset!

All existing snapshots assignments appear within the Automation/Controller
Assign tab’s Assignment List.

If desired, you can right-click on the assignment here and choose Clear Assignment
to remove it.

EDIT

Parameter Source

Clear Assignment .

T
Clear All Assignments

Once a snapshots assignment is created, any changes to the value of the
assigned parameter is instantly stored with the current snapshot. These stored
values are recalled when jumping from snapshot to snapshot, and appear as
you last left them per snapshot.

Copying, Pasting & Renaming Snapshots

You can copy & paste all snapshot settings from one snapshot to another within the
current tone as a time-saver for when you want to just change a few settings. You can
optionally rename your snapshots to help you remember the intended purpose of each.
These snapshot commands are available via right-click on the Snapshots menu.

-
T

To Copy & Paste a Snapshot - Select and load the snapshot you wish to copy
and select Copy from the Snapshots right-click menu. Then load the snapshot you
wish to overwrite and choose Paste to paste the clipboard contents, replacing the
currently loaded snapshot.

To Rename a Snapshot - Right-click on the currently loaded snapshot from the
Snapshots menu and select Rename. Type in your new name, then press Enter/
Return on your keyboard.

NOTE: The action of pasting a copied snapshot and/or its snapshot title is not
tracked by the Helix Native Undo / Redo.

Tlps for Creative Snapshot Use

-
¥
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As in the preceding examples, configure and name a dedicated snapshot for
each section of your song: Snapshot 1 for the Intro, Snapshot 2 for Verse 1,
Snapshot 3 for the Chorus, and so on. Then use your host DAW's parameter
automation to load the snapshots in real-time!

Worried that further tweaking might make your tone worse, not better?
Snapshots are a great way to compare minor changes between tones without
losing your settings.

Turn any Delay or Reverb block's Trails parameter to “On” for seamless spillover
between snapshots.

Set different keys in Harmony Delay blocks or intervals in Pitch blocks per
shapshot.

Having difficulty maintaining consistent volume levels throughout a song? Set
the Output block's Level parameter per snapshot.

Recall snapshots via an external MIDI controller device or software using the
dedicated MIDI CC 69 —see “Global Reserved MIDI CCs” on page 52.

Rename your snapshots uniquely within a preset to define their purpose—see
the previous section.

Don’t want a block’s bypass state to be recalled per snapshot? No problem—
you can exclude any block from snapshot bypass control within the block’s
right-click / Ctrl-click menu—see “Per-Block Snapshot Bypass Option” on
page 32.

NOTE: All snapshots assignments and settings are retained within the current
tone's preset until another preset is loaded within the plug-in. If you wish to
permanently retain all your snapshot assignments and settings with the preset,
be sure to use the File menu options to Save your tone to the Presets Library or
to Disk. The snapshot that is in use when you save your preset is the one that is
recalled when the preset is loaded again.



The Signal Flow Window

The Signal Flow Window displays the plug-in's input and output blocks, levels, and
all processing elements, laid out in the actual flow in which your DAW audio signal is
routed through it. When you click on any input, output or processing block and select it
here, you can then access the block's model & parameter options within the Edit tab,
or its automation options within the Automation/Controller Assign tab below.

Path 1A Selected Block  Split Block Path 1B

INPUT [
o (A

Merge Mixer Block

Master Input  Path 2A

Bypassed Block  Active Block
Level Level
The Signal Flow Window (Helix or Off HC mode)

As covered in “Hardware Compatibility Modes” on page 13, the Signal Flow display

Master Output

within Helix Native will appear differently depending on the Hardware Compatibility
mode you have selected, effectively matching the Signal Flow (path structure and
block capacity) of the respective device. When using the Helix or Off HC mode, the
Signal Flow appears as shown above, matching the Signal Flow of a Helix Floor/Rack/
LT device.

When the HX Stomp or HX Effects HC modes are selected, the Signal Flow matches the
respective hardware device’s Signal Flow, as shown below.

INPUT

INPUT

The Signal Flow Window (HX Effects HC mode)

E NOTE: Throughout this chapter, all features and instructions apply with any HC
I mode in use in Helix Native, unless specifically noted.

Show/Hide Block Labels Option

If you prefer a cleaner look within the plug-in's Signal Flow window, you can “hide” the
descriptive text labels that appear below each block using the Show/Hide option within
the Preferences > View screen (see page 54). When set to hide the labels, you'll only
see a block's label appear when hovering your mouse over the block.

Block label option set to Show

E NOTE: The Show/Hide Labels function affects all Helix Native plug-instances
I globally. (However, you may need to close any other currently open plug-
in instance's window and re-open it again before a change in this setting is
applied.)

Block Bypass Assignment Indicator

If you create a bypass assignment (either via an automation or MIDI type assignment)
for any amp or effects block within your tone, you’ll see the block name label displayed
in brackets, as shown below. Please see “The Automation/Controller Assign Tab” on
page 43 for the full info on creating bypass assignments. (Note that if you happen to
have the above-mentioned Show/Hide Block Label option set to “Hide” you won’t see
these labels or indicators.)

Bracketed block label indicate a block bypass assignment

Master Input & Output Level Controls

At the left and right of the Signal Flow are the Master Input & Output level sliders, along
with real-time level meters. These level sliders' values are not saved per preset and,
therefore, offer global control over levels entering and exiting the plug-in. To follow are
several tips for using these controls.

Adjusting Levels - Just as with all sliders in Helix Native, the Master Input & Output
Level sliders can be adjusted in several ways:
Click on any slider's “handle” and drag to the desired value.

Click on the desired range location within a slider's path and it will jump to the
clicked value.

While hovering your mouse cursor over the slider's path, use your mouse wheel
to adjust it.

Double-click anywhere on the slider area and enter a precise numerical value.
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Clipping, as indicated by the Clip Indicator at the top of the meter lighting up red,
should always be avoided for both the plug-in's input and output.”
Z *TIP: Configuring your input levels into Helix Native is important for achieving
® ihe optimal sound from most Amp & Effect blocks. Please see “Optimizing
the Input Level” on page 10 for details.

If the plug-in's Output meter is showing very low or high levels, it is best to adjust
the blocks that may be cutting or boosting the signal too heavily (Dynamics,
Distortions and Amp blocks, for example, all offer Gain or Volume parameters).
However, you can always use this Master Output Level slider to optimize the plug-
in's final output level.

Reset to Default Level - Cmd-+click (Mac) or Ctrl+click (PC) directly on the Input
or Output slider to reset to the default (unity gain) value.

Peak Level Display - The numerical, real-time peak level value is displayed at the
top of each slider whenever you are adjusting the slider, and whenever you hover
your mouse cursor over the slider path.

Adding, Clearing & Bypassing Blocks

To Add a Block to Your Tone - Hover your mouse cursor over the desired
location on any path and you'll see an empty block location appear to indicate
that a processing block can be added there. Once you click and select the empty
location, choose any type of block from the Edit tab's Model Browser. Please see
“Selecting Models” on page 40 for more info.

Selecting a location in the Signal Flow for a new block

To Clear any Existing Processing Block - Select the desired block and choose
Clear from the (right-click) context menu, or click the “X” button that appears when
hovering your mouse cursor over a block.

When hovering over a block, you'll see its Bypass and Clear buttons appear

Clear All Blocks - Select the desired block and select Clear All Blocks from
the context menu to remove all processing blocks from the Signal Flow. (Input &
Output block settings remain unchanged.)

To Bypass or Enable any Existing Processing Block - There are a several ways
to bypass or enable a block:

+ Whenever you hover your mouse cursor over a block type that offers bypass,
you'll see a click-able Bypass/Enable button appear (as shown above).

Select the desired block and select Bypass or Enable from the block's
(Ctrl+click or right-click) context menu.

Click the Bypass/Enable button offered in the Edit tab—see “Editing Model
Parameters” on page 41.

Cutting, Copying & Pasting Blocks

It is possible to Cut, Copy or Paste any individual processing (Amp, Cab, IR, or FX) block
within Helix Native. To access these commands, click on the desired block within the
Signal Flow to select it, then right-click or Ctrl-click to display the context menu.

" Enable

Dist
Cut

Copy
Paste

Paste Before

Paste After
Clear Block
Clear All Blocks

Block context menu - Copy and Paste commands

TIP: You can also use Copy/Paste, or drag and drop, to copy a block between
separate Helix Native plug-in instances, or HX Edit device windows, as covered
below.

ug\\

Use Cut or Copy for a block, and then use one of the Paste commands within any Helix
Native plug-in instance or within the HX Edit application, as follows:

Into any path within the same or a different instance of the Helix Native plug-in,
and within any preset.

+ Into any path within the HX Edit app, and within any preset.

Block Copy / Paste is allowed for all block types (Amp, Effects, Mix, Input and Output
blocks), with some restrictions.* This provides great flexibility in re-creating tones
between Helix Native, HX Edit, and even different Helix and HX devices.

¥ NOTE: Some restrictions apply for copy/paste of blocks, depending on the
“,’ maximum block and DSP capacity and features of the particular HC mode in use.

For example, just as a Helix Native or device preset will prevent adding some
block or model types as the DSP limit is reached, the same DSP limit rules apply for
copy/paste. Therefore, copy and paste observes these Block rules as well. Physical
inputs & outputs differ between Helix Native and the different Helix/HX devices,
therefore, the copying of Mix, Input and Output blocks and their settings may not be
allowed, as covered throughout this chapter.

Cut - Clears the block from the Signal Flow and copies the block and its current
parameter settings to the clipboard.

Copy - Copies the block and its current parameter settings to the clipboard.

>35¢<



¥ NOTE: When copying a block with existing HX Edit hardware-based
",‘ assignments, the assignments will not be retained if the destination device

does not include or support the specific controller type (e.g., if copying a
block with an EXP 3 controller assignment from a Helix Floor to an HX Stomp
device (or HX Stomp HC mode in Helix Native), the assignment is not shown or
supported, since HX Stomp includes no EXP 3).

Paste - Pastes the most recently cut/copied block into the currently selected block
location within the Signal Flow. If you select an existing processing block, this will
replace the existing block and its settings.

- Paste Block After / Paste Block Before - If you select an existing processing
block, you can alternatively choose either of these commands to paste the
block in your preferred location.

+ Mix type blocks - Copy & paste are also available for an Input, Output, Split
and Merge type block as well, where its parameter settings can be copied &
pasted into a location with the same block type.

- When copying a block within the same window, or between separate Helix
Native (and/or HX Edit) windows, existing snapshot assignments are copied
with the block, but automation and footswitch-based bypass assignments are
not.

- When copying a block from HX Edit to Helix Native, it may not appear that
its hardware-based controller assignments are retained, since the Helix Native
does not support them, and does not list them in its Assignments tab. But if you
copy the same block back into an HX Edit window again, you'll see its original
assignments are indeed still intact.

¥ NOTE: When using the Cut command for a block that includes automation
S (Knob or Switch) controller assignments, the assignments are included in
the settings data when copied to the clipboard and included the first time
the block is pasted into a new location within Helix Native. When using the Copy
command, no existing automation controller data is copied to the clipboard..

Drag and Drop Blocks

You can also use “drag and drop” to copy/paste or move a block, including all its
current settings, within the current preset, as well as between separate Helix Native
and/or HX Edit windows. Copy or move can be performed with any processing type
blocks - Amps, Cabs, IRs, FX (as long as the block type is supported by the target
destination’s Signal Flow). The following drag and drop actions are available for blocks.

- Drag and drop of a block anywhere within the current Helix Native Signal Flow
moves the block (including when dragging between Paths).

+ Holding the Alt (Mac) or Ctrl (PC) key and performing drag and drop of a block
anywhere within the current Helix Native Signal Flow copies the block.

- Drag and drop of a block into the Signal Flow of any other Helix Native or HX
Edit app window copies the block.

Holding the Alt (Mac) or Ctrl (PC) key and performing drag and drop of a block
into any other Helix Native or HX Edit window moves the block.

Since performing a drag and drop of a block is essentially the same as a Copy/
Paste Block or Move Block operation, the same rules and behaviors apply —
please see the preceding section.

see the existing block shift left or right to place your dragged block before or after
it. Unlike when using the Copy and Paste commands, it is not supported to replace
an existing block via drag and drop.

3 NOTE: When dragging a block, if you try to drop it on top of an existing block, you'll
!

Block Order and Stereo Imaging

Helix Native is a stereo plug-in, with each Signal Flow path carrying two channels of
audio. When Helix Native plug-in is inserted on a stereo DAW track and fed a stereo
input (or playback of a stereo clip), the left and right audio is processed discretely in
stereo within each of the paths, wherever stereo blocks are used within the path. When
the track is fed a mono source, the mono signal is split and fed equally to the left and
right channels within the path. Whenever a mono block is added within a path (such as
an Amp or mono Effects model), both channels of audio are combined and sent out of
the block as mono.

Most of the Helix effects models have both mono and stereo versions. A stereo block
displays @ after its model name in the inspector. The stereo imaging—or how wide
your tone appears with stereo monitor speakers or headphones—is highly dependent
on the type of blocks you add, and in what order.

Legacy effects models vary in behavior, just as on the classic Line 6 effects from where
these models originated.

+ Legacy Distortion, Dynamics & Pitch/Synth effects are mono.

Legacy Modulation & Delay effects vary in that some are mono, some stereo,
and some mono-in/stereo-out, where adjusting the effect's Mix parameter can
narrow the stereo image that is fed into them. It is best to experiment with
these effects and tweak the Mix parameter to achieve the desired stereo output
results.

Legacy Filter and Reverb effects are stereo.

Keep the following in mind when building tones:

All Amp+Cab, Amp, Preamp, single Cab and IR blocks are mono, so any stereo
signal sent into these will be collapsed to mono. As such, it’'s a good idea to
add only mono effects blocks before amps and preamps to conserve computer
processing resources.

Adding a mono effects block will collapse any preceding stereo blocks' signal
on the same path to mono.
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+ The Helix Native plug-in's Signal Flow always allows the use of mono or stereo
type processing blocks, regardless the type of track on which it is inserted.
This allows you to utilize any existing preset and create complex routings within
the plug-in Signal Flow (see the routing examples later in this chapter). When
inserted on a mono output track, the output at the end of the Helix Native signal
chain is summed to mono.

+ If you're using Helix Native on an audio track with mono input and output, there
is no need to use stereo models at all (except, of course, for models that are
only offered as stereo).

« Stereo models use twice as much processing resources as mono models,
therefore, it’s a good idea to only utilize stereo models when stereo processing
is desired.

Moving Blocks & Arranging the Signal Flow

To arrange blocks within a signal path, in addition to using Cut/Copy/Paste (see
previous section), you can also click and drag any block left or right within the same or
any other path, to move it to the desired location. While dragging you'll see an empty
block location appear to indicate where you can drop your block, and existing blocks
will move to accommodate it.

\

=

Dragging a Delay block—an available empty block location appears while dragging

TIP: Holding the Alt (Mac) or Ctrl (Windows) key during drag and drop will copy
the block - see “Drag and Drop Blocks” on page 36.

To follow are a number of pointers for arranging the Signal Flow in different ways (also
see the next section for routing examples, to put these tips to use).

Maximum Block Capacity - Just as on the device being emulated, each Helix
Native HC mode offers its own capacity for the max. number of blocks that can be
added to a path.

- Helix or Off HC mode - Up to 8 blocks can be added to any main path or
parallel path, for a total of up to 32 blocks. (However, when in Helix HC mode,
you are likely to hit the max. DSP limit before being able to add this many
blocks—the Off HC mode has no such max. DSP limit.)

- HX Stomp HC mode - Up to 6 blocks total can be added.

- HX Effects HC mode - Up to 9 blocks total can be added.

Split Paths - Drag a block down from the main signal path and you'll see a parallel,
split path (Path B) appear, with both a Split and Merge block created at each end.
To remove the split path, clear or move all blocks out of the parallel path.

Change Split Block to a Path Input Block - (Helix or Off HC mode only) Click and
drag a Split block from the main path to the lower, parallel path to convert the Split
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block to a separate Input block for the parallel path. Drag the parallel path’s Input
block back up to the main path to restore it as a Split block. (Or right-click on the
Split block or parallel path’s Input block and use the Create Input or Restore Split
commands instead of dragging.)

Change Merge Block to a Path Output Block - (All HC modes) Click and drag
a Merge block from the main Path to the lower, parallel path to convert the Merge
block to a separate Output block for the parallel path. Drag the parallel path’s
Output block back up to the main path to restore it as a Merge block. (Or right-click
on the Merge block or parallel path’s Output block and use the Create Output or
Restore Merge commands instead of dragging.)

Split Block Options - When a Spilit block is selected in the Signal Flow, you can
choose from among four types of Split blocks and adjust its balance options using
the parameter sliders that appear in the Edit tab below.

Input & Output Blocks - A path's Input and Output blocks cannot be moved, but
when you select one of these blocks, you'll see options within the Edit panel below.

Tl

-—

P: Please also see “Editing Input, Output, Split & Merge Blocks” on page

A\
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Signal Routing Examples

To follow are a few routing possibilities you can try within the Signal Flow. Also be sure
to try some of the “template” factory presets we've provided within the setlist for even
more configurations.

1 into 2

(Al HC modes) Drag a split path's Merge block down to Path B. The Merge block
shifts right and a duplicate Output block is created:

In this example, the input signal is split to stereo Paths A and B (using the default
Split Y type split block), each with its own Output block. You can now use Path A
and B's Output block options to independently pan each left/right as desired.

Parallel Paths

(Helix or Off HC modes) If you start with a split path, you can convert it into two
individual, stereo parallel paths, each with its own Input and Output block.

1. Drag the Split block down to Path B (or right-click on the Split block and
choose Create Input). The Split block shifts left and a duplicate Input block
is created.

2. Drag the Merge block down to Path B (or right-click on the Merge block and
choose Create Output). The Merge block shifts right and a duplicate Output
block is created.

Inactive Split block Inactive Merge block

Once converted to Input & Output blocks, the Split and Merge blocks become
inactive—you can drag the Split and Merge blocks up to the Path A above (or right-
click on the Split or block and choose Restore Split or Restore Merge) to revert
back to a Split Path configuration.
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Discrete Stereo Processing with Amps

(Helix or Off HC modes) As mentioned in “Block Order and Stereo Imaging” on
page 36, each path within the plug-in is capable of processing discrete left &
right audio input on a stereo Audio, Aux or Bus track, provided you're utilizing all
stereo blocks on the plug-in's signal paths. But if you're wanting to utilize any Amp
or Preamp blocks (which are all mono-output blocks), it is necessary to split the path
to allow the left & right audio channels to be processed discretely.

Start with the AUX: DiscreteDuo preset provided within the factory TEMPLATES
setlist. This preset already has all necessary routing configured for discrete stereo
using an amp on each path. To follow are the key settings for this Signal Flow.

1. A Split Y type block is used with its Balance A & B parameters panned hard
left and right.

2. The Merge block's Pan A & B parameters are set hard left and right,
respectively, to also keep the two channels' audio discretely separate.

3. The Path 1 Output block is fed to Path 2A, allowing additional stereo effects
blocks to be applied.

Split Y block Path 1A (with mono blocks) Path 1B (with mono blocks) Merge block

Path 2A (with stereo blocks)

In this configuration, Path 1A of the split path will process only the left signal,
and the Path 1B will process only the right signal, allowing you to add mono
blocks on each of these parallel paths accordingly.

By placing stereo blocks on Path 2, it will still retain the left/right channel
separation, allowing you to use common effects to save some resources.



Super Serial

(Helix or Off HC modes) A serial path has eight processing block locations. If that’s
not enough, you can use parallel Path B to create an extended “super serial” path
configuration.

1.
2.

Drag the Merge block down to Path 1B. A duplicate Output block is created.

Drag the Split block all the way to the right, past the last processing block
on path 1A.

Select the Output block on path 1A and turn Knob 2 (Level) all the way down.
That way, you’re only hearing Output 1B.

In the illustration above, our signal is processed by the eight blocks on Path 1A and
processed further by Delay block (or whatever blocks you wish to add) on Path 1B.

Of course, if this still isn’t enough, you could always duplicate the above Signal Flow
routing on Path 2 and then route Path 1B’s output block to Path 2A for one gigantic
serial tone with up to 32 block locations (plug-in processing limit permitting. See
“Computer Processing Management” on page 19):

Tips to Optimize Processing Power Usage

The Helix, HX Stomp and HX Effects Hardware Compatibility modes each include a
processing limit, matching the DSP limit of their respective hardware devices, in order to
maintain preset compatibility with them. The Off HC mode includes no such processing
limit, allowing you to effectively add as many blocks, of any type, as will fit on all paths.
(Also see “Computer Processing Management” on page 19.)

Of course, your DAW system itself has a finite amount of processing resources, so it is
always a good idea to use your plug-ins efficiently. To follow are tips to for keeping the
Helix Native processing usage under control.
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Some block types, such as Amps, Cabs, IRs, and Pitch Shifters, use much
more of your computer's processing power than others. Not surprisingly, the
Amp+Cab block uses the most. EQ, Dynamics and Volume/Pan blocks use
relatively little.

Some models may require more processing power than others of the same
category. This is especially true with Amp models.

Instead of a parallel path with two Amp+Cab blocks or two separate Amps and
Cabs, try adding a single Amp block followed by a single Cab > Dual block, or
two individual Cab or IR blocks, as in the preceding “1 into 2” example (mixing
two different Cabs can provide some substantial variations).

The stereo version of an effects block will use roughly twice as much processing
power as a mono version of the same block. Likewise, the dual version of a cab
block will use roughly twice as much processing power as the single version.
Therefore, you likely won't want to use stereo versions of blocks in routing
configurations where they don't actually provide a stereo output (see “Block
Order and Stereo Imaging” on page 36).

Some model categories have “Simple” blocks, which utilize less processing
power than others.

The “Legacy” type models often utilize less processing resources than other
models of the same effect type.

When in Helix HC mode, if you hit the processing limit on Path 1, route its
Output block to Path 2 for more horsepower. If creating tones with two or more
amps and more than a handful of effects, use both paths.



The Edit Tab

The Inspector window's Edit tab provides access to all models via its multi-level Model
Browser, where you can choose from numerous categories of models to make up your
tone. This panel also displays all available parameters for the block that is currently
selected within the Signal Flow window, providing easy access for editing. Be sure
to check out the “Model Lists” chapter for the full array of models and what they are
based on.

Selecting Models

As mentioned in the previous chapter (page 35), add models to your current preset
by selecting the desired empty location on any path within the Signal Flow window
and then choose your specific model from the Model Browser. You can also select any
existing block within the Signal Flow and change its model this way. (Also note that
if you select an Input, Output, Split & Merge block, the Model Browser can also offer
options for these block types.)

List/Grid View Toggle Sub-Category Menu

AUTOMATION/CONTROLLER ASSIGN
Distortion H] v B8 Minotaur

N < E Gain

7 7
Model List/Grid Parameter Sliders

The Edit tab's Model Browser

7
Category List

Choose the type of block first in the Category List at the left and you'll see all of its
available models appear in the Model List. Note that, once you've selected a Category,
you can toggle List/Grid View Toggle button to change between a list or grid display
of the category's models.

Distortion v iZ Mono

s
H S
[

Distortion

None

Kinky Boost Deranged Master Minotaur

- LR )

Teemah! Heir Apparent Tone Sovereign

Model List view Model Grid view

For block categories that offer it, you'll see a Sub-Category menu at the top of the
Model List, where you can choose to see Mono, Stereo or Legacy type models. Amp
categories offer Guitar & Bass sub-categories, and for Cabs you'll see Single & Dual
sub-category options.*

2 ‘NOTE: Amp+Cab, Amp, Preamp and Cab models are not supported when in the

S HX Effects Hardware Compatibility mode, therefore, you won't see these
Categories or Models in the menu when Helix Native is using this mode (see page

13).

Once you click on any model in the Model List it is instantly active and loaded into the
selected Signal Flow location. (You can click on models here to preview them in real-time
as your DAW track is playing.) When a model is selected, its editable parameters appear
at the right of the Edit panel. If you want to remove an existing block, select it within
the Signal Flow and choose the None category's Empty Block option. Or alternatively,
right-click on the block within the Signal Flow and choose the Clear command.

Availahility of Models within the Model Browser

There are cases where some model types are displayed as “dimmed” and not selectable
within the Model Browser. There are limits for how many of some types of models can
be inserted within a path and/or within a preset, depending upon the current HC mode
in use, as described below.

B Guitar

Dimmed
models

Unavailable models appear dimmed within the Model Browser

Block Type

Hardware Compatibility Mode

two)

Helix HX Stomp HX Effects Off
Amp+Cab, Amp, | Up to four, any Up to two, any Amp, Preamp, No restrictions
or Preamp | combination, within a | combination and Cab blocks
preset (up to two per not supported
path)
Cab (includes | Up to four (two per Up to two Amp, Preamp, No restrictions
Amp+Cab) | path; Cab > Dual and Cab blocks
blocks are considered not supported

Impulse
Response

Up to four 1024-point
IRs (two per path) or
two 2048-point IRs
(one per path)

Up to two 1024-
point IRs or one
2048-point IR

Up to two 1024-
point IRs or one
2048-point IR

No restrictions

Send/Return &
Looper

Non-functional*

Non-functional*

Non-functional*

Non-functional*

*Non-functional type blocks remain “disabled” since they are only functional in Helix hardware and,
therefore, cannot be added from within the Helix Native Model Browser (see page 17).
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Additionally, as per the computer processing management functionality of Helix Native
(when set to any HC mode other than Off, see page 19), when the current tone
approaches its allowable processor usage limit, some models may not be selectable
if adding them would result in the tone exceeding the limit. To free up more resources
for the current preset, try removing some models, or swapping out models with similar
mono or “simple” versions within the same category.

Editing Model Parameters

Once added to your tone, simply click on any block within the Signal Flow to select it
and you'll see the model category and type highlighted in the Model Browser, with its
parameter sliders available at the right of the Edit tab.

Model Browser EditTab Selected Model Stereo Indicator  Bypass/Enable

EDIT AUTOMATION/CONTROLLER ASSIGN

i Stereo v g § ElephantMan CGD

28 Elephant Man

Parameters
The Inspector Window - Edit Tab

Selected Model, Stereo Indicator- At the top of the parameter pane you'll see
the name of the selected model. If the selected model is stereo, the @ indicator
appears to the right of its name, as pictured above.

Bypass/Enable - For all block types that support it, the Bypass/Enable button at
the top right allows you to manually toggle the selected block's processing on or off.
Note that you'll see all the block's parameter sliders become “dimmed” to indicate
the bypassed state. Alternatively, hover over the block and use Bypass button that
appears above the block, or right-click or Ctrl+click to choose the bypass/enable
options from the context menu—see “Adding, Clearing & Bypassing Blocks” on

page 35.
Adjusting Parameter Sliders - There are several ways to adjust slider values:
+  Click on any slider's “handle” and drag to the desired value.

+ Click on the desired range location within a slider's path and it will jump to the
clicked value.

+ While hovering your mouse cursor over any slider's path, use your mouse wheel
to adjust it. (Note that hovering over the scroll bar at the right also allows you
to use the mouse wheel to scroll vertically when there are more parameters.)

+  Click the up/down arrow buttons at the right for incremental adjustments. If a
down arrow is displayed at the right, click on it to expand a menu of selectable
options.

Resetting Sliders - If you're not happy with your slider adjustment, use Cmd-+click
(Mac) or Ctrl+click (PC) on a slider to reset it to its initial default value.

Type in a Precise Value - Double-click anywhere on a slider's path, or on its value,
to manually type in a precise numerical value.

Configuring a Parameter for Host DAW Automation - Right-click on a slider to
display the menu of automation controllers, which allow the host DAW application
to access the parameter for its automation features—see “The Automation/
Controller Assign Tab” on page 43 for details.

Accessing All Parameters - Note that some model types, such as amps and
complex effects, may have more sliders and controls than you can see all at
once in the Edit tab. Click and drag the vertical scroll bar at the right to access
all parameters (or use your mouse wheel when hovering your mouse cursor over
the vertical scroll bar). You can also resize the entire plug-in window as desired by
dragging its bottom right corner.

Note Sync

Most modulation and delay effects models offer a Note Sync option, allowing the
modulation rate or delay repeat time to follow the plug-in's main tempo value. For
models that offer it, you can click the Note Sync button within the Edit tab to toggle the
feature on/off. When active (the Note Sync button is lit), the parameter will change to
offer note division values, as shown below.

Note value options Tempo Sync (active)

Stereo v [g { Blephant Man D

A Delay block's Delay Time parameter configured for Note Sync

Set the plug-in's main Tempo Controls at the top right of the plug-in window to Host
Sync mode for the individual, active Note Sync parameters to follow your host project's
timeline tempo (also see “Editing the Tempo” on page 30).

Per Snapshot

i= Per Preset N

< ) Host Sync

Setting the plug-in to Host Sync tempo mode

Otherwise, when the main Tempo Controls option is set to Per Preset or Per Snapshot,
the parameters' Note Sync follows the editable tempo value that is displayed in the
numerical tempo field at the top right of the plug-in.
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Editing Input, Output, Split & Merge Blocks

Just as with Amp & Effects blocks, you can click on these block types within any Signal
Flow path and access their options in the Edit tab.

Input Block Options:

- The Input block for any path (except Path 1A) is able to be set to receive input
from the Host or None. If you have configured the Output block of a preceding
path to feed into the current path, then you may wish to set the current path's
Input block to None so that it does not also receive input audio from your Host
DAW track.

« Al Host Input blocks include a built-in Noise Gate, and you'll find the Gate's
On/Off and parameter sliders here as well.

Output Block Options:
« Al Output blocks offer Pan and Level sliders within the Edit Tab.

+ (Helix or Off HC modes) Path 1's Output block offers options to feed the path's
output to Host, or into any existing Input block of Path 2. (If you've created
a separate Path 1B, its output block offers these options as well).” Path 2's
Output block is always routed to Host.
Z *TIP: See page 37 for info about creating different possible path routing
= configurations using these Output block options.

Split Block Options - If your preset includes a Split path, click directly on the point
of the main path where the signal divides to select the Split block and you'll see
options for choosing between four different Split block types, as described below.
Note that there is also a Bypass switch for the Split block which, when bypassed,
results in the block feeding equal left and right signals to each stereo parallel path.

- Split Y: By default, a Split > Y appears any time parallel Path B is created. Use
the Balance A and Balance B (pan) parameters to adjust the left/right stereo
balance that is routed to each stereo path, respectively

- Split A/B: Use the Route To parameter to determine the total amount of signal
fed to Path A versus Path B.

- Split Crossover: Splits the audio content so that treble frequencies are sent
to Path A and bass frequencies are sent to Path B (or the path routing is
reversed when Reverse is On). Use the Frequency parameter to set the center
frequency; Any signal above this frequency is sent to Path A, and any signal
below this frequency is sent to Path B.

- Split Dynamic: Similar to a crossover, except the audio content above the
audio Threshold is sent to Path A, and the content below the audio Threshold
is sent to Path B (or the path routing is reversed when Reverse is On). Attack
determines how fast the signal routes to Path B once reaching the Threshold,
and Release determines how fast the signal returns to Path A once falling
below the Threshold—typically, higher values result in a smoother transition.

Merge Block Options - If your preset includes a Split path, click directly on the
point of the main path where the signal returns to select the Merge block and you'll
see several mixer options for blending the two paths' signals.

Z TIP: Split and Merge blocks can optionally be dragged down from Path A to
® path B to create individual parallel paths and other routing configurations.

See page 37.

Editing Send, Return, FX Loop & Looper Blocks

These block types are supported only by Helix and HX hardware devices, therefore,
you'll only see them within Helix Native when importing a preset that was exported from
a Helix or HX device. When included within a Helix Native tone, they are displayed with
a slashed circle icon on the block to indicate it as a “non-functional” block, as shown
below. Please also see “Hardware Blocks (Send, Return, FX Loop & Looper)” on page
17.

“Non-functional” blocks within Helix Native’s Signal Flow

3 NOTE: If an existing Send, Return or FX Loop block is toggled as “active” via its

I Bypass switch, it can reduce or fully mute the path's audio signal, depending on

the block's Mix or Dry Thru parameter settings. To ensure these block types are
not affecting the plug-in's signal path, simply toggle the block as bypassed.

You can still move & clear these blocks within the Signal Flow, and edit the parameters
of these blocks within the Edit tab. Your edits are retained within your exported presets
for use on Helix/HX devices—see “Preset Compatibility with Helix and HX Devices”

on page 13.
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The Automation/Controller
Assign Tab

The Inspector window's Automation/Controller Assign tabbed panel is where you
can create, edit and reference all your automation controller assignments for the current
plug-in instance. This panel offers two sections: the Assignment List at the left where
all current assignments are shown, and the Inspector at the right where you can create
new automation assignments and access additional options for existing assignments.

E NOTE: Actions performed within the Automation/Controller tab are not tracked
I by Undo / Redo. Please also see “Undo and Redo” on page 28.

Assignment List  Column Headers Selected Block Target Parameter Menu

EDIT AUTOMATION/CONTROLLER ASSIGN

Parameter Source S8 Simple Delay

Auto Ctrl Knob 1

Selected Assignment Min/Max Range = Automation/Controller

Parameters Menu
The Automation/Controller Assign tab

The features within this tab are described below. Also see the following sections for
specific steps on creating different assignment types.

- Assignment List - The 3-column pane at the left displays all existing bypass,
automation, and controller assignments for the current preset, listing the parent
Block, Parameter of the assignment, and the controller Source (the type of
assignment it is—a Snapshot, Knob or Switch, or MIDI CC). When you select
the assignment in this list (which is then displayed as highlighted), its editable
settings appear in the Inspector pane to the right.

+ Target Parameter Menu - When a block is selected within the Signal Flow, or
when an assignment is selected within the Assignment List at the left, this menu
offers selection of any available parameter for that block. Here is where you can
select the specific parameter for which you want to create an assignment, or to
edit the settings of the parameter’s existing assignment.

- Automation/Controller Menu - This menu is where you choose the type of
controller source for the parameter currently selected in the Target Parameter
Menu. Use the button at the left of this menu to choose an automation
Knob or Switch type controller source, or use the button to choose a
snapshot or MIDI CC type controller source. Once a controller source is
selected, the assignment is created, and you’ll see additional sliders appear in
the space below this menu (such as the Min/Max Range sliders appear for the
Simple Delay - Mix - Knob 1 automation assignment in the screenshot above).

Hardware Controller Assignments within Helix Native

If you are importing a Helix or HX hardware preset that was exported from HX Edit, it is
possible the preset may include hardware-specific bypass and controller assignments
(such as EXP Pedal or Footswitch controller assignments). As covered in “Preset
Compatibility with Helix and HX Devices” on page 13, hardware bypass and
controller assignments are not functional within Helix Native, but you can configure
Helix Native to display them in its Automation/Controller - Assignment List for reference.
To do so, choose the Show assignments option Preferences window > Hardware
Compatibility tab > Show hardware bypass/controller assignments menu (by default, this
option is set to Hide assignments).

Show hardware bypass/controller
assignments:

Hide assignments

® Hide assignments
Show assignments L\_

The Preferences - Show hardware bypass/controller assignments menu

When shown, these assignments appear with a hardware icon at left and dimmed (see
below), since they are not editable in Helix Native, but you can Clear them via the Clear
Assignment commands within the assignment’s right-click/Ctrl+click menu.

Parameter

Hardware bypass/controller assignments appear within the Assignments List

About Plug-in Parameter Automation

Helix Native supports your host DAW application's features to read, write and edit
parameter automation, where the DAW can control the plug-in's parameter values
over time using editable track envelopes. Helix Native takes this concept even further
and not only allows for practically any block's parameters to be automated, but also
allows automating the loading of any of the current preset's snapshots, which effectively
provides simultaneous switching of numerous Helix Native parameters in one action!

Most DAWSs additionally allow you to record parameter automation in real-time, where
you enter an automation “write” mode and changes to the selected plug-in parameters
are recorded and displayed on the track as adjustable envelopes. This allows all these
parameter changes to be played back (using the host's track “read” mode option) and
incorporated into your project’s mix-down.

Host DAW applications typically allow you to access the list of automatable parameters
for a plug-in by way of an automation parameter menu, specific to the audio or aux
track where you have inserted the plug-in. Each host DAW software offers parameter
automation options slightly differently, so it is recommended that you consult your
host software’s documentation for its specific instructions and parameter automation
capabilities.
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Controller Assignment for Automation

Since Helix Native can potentially include numerous parameters (depending on how
many Amp & Effects blocks you add within your tone), it utilizes a set of assignable
controllers that allow you to map whichever sliders and switches you desire to automate.
To follow are what will appear as “automatable” Helix Native parameters within your
host DAW application's plug-in automation menus.

+  Knob 1-16 Controllers - Allow you to assign “variable” type controls—for
example, the Mix slider of a delay, or the Drive slider of an amp.

- Switch 1-16 Controllers - Allow you to assign “Off/On” switches, such as the
Bypass switch for any block.

+ Snapshot Index Controller - Allows you to automate the loading of any of the
current tone's snapshots.

+ Additional “Fixed” Controllers - These Helix Native global parameters are
already mapped and require no automation controller assignment: Master
Input Level, Master Output Level, and Master Bypass. (Note that some host
DAW applications also offer their own “fixed controllers” within their automation
menus that are also usable with Helix Native plug-in, such as a Wet/Dry Balance
or their own plug-in bypass.)

Creating an Automation Controller Assignment

Before you’ll be able to utilize your DAW host’s track automation for a Helix Native
parameter, it is necessary to first assign the desired parameter to an automation “Knob”
or “Switch” controller. This is performed as follows.

Automating a Variable (Slider) Parameter:

1. Click on the block within the Signal Flow which contains the model and parameter
that you wish to automate. For this example, we'll create a controller assignment
to automate the Mix slider of the Simple Delay model.

2. In the Automation/Controller Assign tab, you'll see that the Simple Delay block
name is displayed at the top, indicating that it is the selected block. Click on the
Target Parameter menu to see all of the Simple Delay's parameters—select the
Mix parameter.

AUTOMATION/CONTROLLER ASSIGN

&4 Simple Delay
® Bypass
Time
Note Sync
Feedback

Mix ti‘

Level
Scale

Trails

Selecting a Delay's Mix as the target parameter for automation assignment
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Once a target parameter is selected, click on the [ button at the left of the
Automation/Controller menu, then select the desired “Knob” controller from
the menu to which you want to assign your selected target parameter. We will
select Knob 1. (You can alternatively assign a slider to one of the Switch
automation controllers to allow the parameter to be automated strictly between
two defined values—see the Tip at the end of this example.)

Simple Delay

Auto  Ctrl None

Selecting a Knob automation controller for a target parameter

Once selected, you’ll also see your assigned block and parameter name
displayed to the right of the Knob controller within this menu for a handy
reference, as shown here:

Simple Delay

Auto Ctr Knob 1

® Knob 1 (Simple Delay:Mix) N

Knob 2
The existing automation controller assignment’s block and parameter name is displayed
Z TIP: As an alternative to steps 2 & 3, you can right-click directly on the
4 Simple Delay's Mix slider within the Edit tab, choose Automation Assign and
the desired Knob controller from the menu.

i Simple Delay (D O]

Automation ASsign  *+ knob 1 (Simple DelayMix)
Mix Controller Assign » X
]

Knob 274
Knob 3
Knob 4

Creating an automation assignment from a slider's context menu in the Edit tab

Once created, you’ll also see your assigned block and parameter name
displayed to the right of the Knob or Switch controller within this menu, as
shown above.

3 NOTE: Only one parameter can be assigned to any one Knob (or Switch)
I automation controller at a time—choosing a controller with an existing
assignment will replace the existing assignment. Or, you can choose None
to remove an existing assignment.



Once the assignment is created, you'll see it appear in the Assignments List
at the left. When selected in this list, you can edit its assignment settings at
the right of the tab—see “Editing Options for an Existing Automation Controller
Assignment” on page 46. You'll also see an automation assignment knob

indicator icon (or switch icon, depending on which type of assignment you
created) displayed for the parameter's slider within the Edit tab, which includes
the knob number to which it is now assigned:

An automation assignment indicator for “Knob 1” appears at the left of the assigned slider

=

Z TIP: Click on the little knob automation assignment indicator at the left of
¥ ihe slider to jump to the Automation/Controller tab, where the assignment is
selected and its editable options displayed.

Now access your host DAW app track's automation parameter menu and select
the Helix Native - Knob 1 to configure it for host automation.

You should be able to see an envelope line for the “Knob 1” parameter for the
track (your host app may require that you toggle an option to display it). Adding
edit points and adjusting this envelope will now directly adjust the assigned Mix
slider of the Simple Delay.

Cubase Pro with Helix Native “Knob 1” automated on an audio track

You can repeat these steps, choosing other “Knob” controllers, to create
additional automation assignments for the Simple Delay (or any other selected
block within the Signal Flow), if you wish to automate more parameters for this
Helix Native plug-in instance.

Z TIP: Alternatively, in step 3 you can choose one of the Switch 1-16

® Jutomation controllers, which configures the parameter to be automated
strictly between two specific values. You can define the two values within
the Automation/Controller Assign tab using the assignment's Min & Max
value options—see “Editing Options for an Existing Automation Controller
Assignment” on page 46.

EDIT AUTOMATION/CONTROLLER ASSIGN

— PlastiChorus

Parameter Source

Switch 1

As shown in the example above, a variable Mix parameter slider is assigned
to a Switch automation controller, with its Min and Max Mix values set for
20% and 50%. These are the two specific values to which the host track
automation will be toggled between.

Automating an 0ff/On Switch Parameter:

The Switch 1-16 automation controllers are useful for when you wish to automate
a parameter between two specific values. Most commonly this would be a block's
Bypass Off/On, but you can automate other parameters in the same way, such as the
Speed - Fast/Slow switch of a rotary speaker model. For the following example, we'll
configure the bypass of a Simple EQ block.

1.
2.
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Add a Simple EQ block to your Signal Flow and click on it to select the block.

In the Automation/Controller Assign tab, you'll see that the Simple EQ block
name is displayed at the top, indicating that it is the selected block. Click on the
Target Parameter menu to see all of the EQ's parameters—select the Bypass
parameter (if not already selected as the default).

_‘u Simple EQ Bypass

® Bypass .
Noi i Lf
Low Gain

Selecting Bypass as the target parameter for automation assignment

Once the Bypass target parameter is selected, click on the Automation
Controller menu that appears and select the Switch controller to which you
want to assign your selected target parameter. We will select Switch 1.

.m Simple EQ  Bypass

None

MNone

Switch 1 N
i

Switch 2

[
MIDI In
|

Selecting a Switch automation controller for a target parameter



Once selected, you’ll also see your assigned block and parameter name
displayed to the right of the Switch controller within this menu for a handy
reference, as shown here:

|| SimpleEQ Bypass
Switch 1

MIDI In

® Switch 1 (Simple EQ:Bypass) N
i3

b
The existing switch controller assignment’s block and parameter name is displayed

TIP: As an alternative to steps 2 & 3 for assigning block bypass, you can
right-click directly on the EQ block within the Signal Flow, or right-click on
the model’s Bypass button within the Inspector pane - Edit tab panel, and
choose the desired Switch controller from the Automation Bypass menu.

E‘ Bypass

EQ
Cut
Copy

A\

Clear Block
Clear All Blocks

Automation Bypass » MNone

MIDI Bypass » ® Switch 1 (Simple EQ:Bypass) .
MIDI Learn... Switch 2 X

Creating an automation bypass assignment from a block’s context menu

%] simple EQ D)
. * Switch 1 (Simple EQ:Bypass) Automnation Bypass »
Low Ga
M switch 2 MIDI Bypass 8

Mid Freq  Switch3 MIDI Learn...
]

Switch 4 + Snapshot Bypass

Switch 5 0.0dB -

Switch 6

Switch 7

Level Switch 8 0.0dB *
u

Mid Gain

High Gain 0.0dB

Switch 9

Creating an automation bypass assignment from the
Edit tab - Bypass button’s context menu

Once selected, you’ll also see your assigned block and parameter name
displayed to the right of the Switch controller within this menu, as shown
above (Simple EQ: Bypass) .

E NOTE: Only one parameter can be assigned to any one Switch (or Knob)
I automation controller at a time—choosing a controller with an existing
assignment will replace the existing assignment. Or, you can choose None
to remove an existing assignment.
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Once the assignment is created, you'll see it appear in the Assignments List
at the left. When you select an existing assignment in this list, you can edit
its settings at the right of the tab—also see “Editing Options for an Existing
Automation Controller Assignment” on page 46.

Now access your host DAW app track's automation parameter menu and select
the Helix Native - Switch 1 parameter to configure it for host automation.

You should be able to see a “Switch 1” parameter envelope line for the track
(your host app may require that you toggle an option to display it). Adding edit
points and adjusting this envelope will now directly toggle the bypass state of
the assigned Simple EQ block. Note that, since this is a “switch” type parameter,
its track envelope will only create edit points as “off” (the Minimum, 0% value) or
“on” (the Maximum, 100% value).

01-200107 1216 wav

Reaper 5 with Helix Native “Switch 1” automated on an audio track

You can repeat these steps, choosing other “Switch” controllers, to create
additional automation assignments for the Simple EQ (or any other selected
block within the Signal Flow), if you wish to automate more parameters for this
Helix Native plug-in instance.

TIP: You can also utilize a Switch automation controller for an automation
assignment to a “variable” Helix Native parameter, such as any model's slider
parameter, allowing you to define two specific parameter values to toggle
between when automating the Switch's “Off/On” states—see “Automating
a Variable (Slider) Parameter:” on page 44.

ag )\

Editing Options for an Existing Automation
Controller Assignhment

Once you've created one or more automation controller assignments, they are displayed
in the Assignment List at the left of the Automation/Controller Assign tab. This list makes
it easy to reference all your automated parameters and edit their available options. The
Assignment List includes 3 columns:

Block - Displays the name of the parent block which includes the assigned
parameter.

Parameter - Displays the name of the assigned parameter.



\
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+  Source - Displays the automation controller source (Knob 1-16 or Switch 1-16)
to which the parameter is assigned.

TIP: Note that you can click on these column titles at the top of the list to sort the
list by Block, Parameter or Source, ascending or descending.

When you click on any assignment within the list, you'll see the assignment's editable
options appear at the right of the Automation/Controller Assign tab. Most variable
type parameters offer Minimum Value / Maximum Value sliders which allow you to
customize the automated values.

If the Automation Assignment Source is a Knob Controller - The Min & Max
values define the range for which the parameter can be adjusted, allowing you
to limit the range, if desired. For example, if you want an amp's Drive parameter
to automate strictly between the value range of 3.0 to 7.5, set these sliders
accordingly, as shown below.

EDIT AUTOMATION/CONTROLLER ASSIGN

Parameter Source Brit 2204

>

Auto Crrl

An Amp - Drive “Knob” automation assignment with its Min & Max (range) values defined

-
T

NOTE: For automation assignments, (unlike with MIDI assignments) the Min and
Max values cannot be inverted.

If the Automation Assignment Source is a Switch Controller - The Min & Max
values define the “Off” and “On” values to which the parameter can set, allowing
you automate switching between these values. For example, if you want an
amp's Drive parameter to automate strictly to either 4.0 or 8.5, set these sliders
accordingly, as shown in the following image.

EDIT AUTOMATION/CONTROLLER ASSIGN

Parameter Source

Switch 1

An Amp - Drive “Switch” automation assignment with its Min & Max (Off/On) values defined
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TIP: Some DAW hosts also offer additional on-screen controls to provide easy
access to track and plug-in parameters, such as the “Smart Controls” in Logic
Pro or the “Quick Controls” in Cubase Pro. Typically these types of DAW controls
can be set to the Helix Native Knob 1-16 or Switch 1-16 Automation Controllers,
for which you'd want to follow the preceding steps to assign your preferred Helix
Native parameter to the respective automation controller.

Removing or Replacing an Existing Automation
Controller Assighment

To Remove an Existing Automation Controller Assignment - Select the
assignment within the Assignment List and choose the None option from the
Automation Assignment menu.

= Brit 2204

Aute  Curl Knob 2

None

N

® Knob 1 (Brit 2204:Drive)

Knob 2

Select None to remove an existing assignment

To Replace an Existing Automation Controller Assignment - Select the existing
assignment within the Assignments List and choose a different Knob or Switch
controller from the Automation Controller menu. This removes the existing
controller and applies the newly selected Knob or Switch automation controller to
the parameter.” You can then choose this newly assigned Knob or Switch controller
from your DAW track's parameter automation menu to automate it.

E *NOTE: In the case where you have written automation for an existing
I Helix Native assignment and performed the above replace action, the

automation envelope in your DAW track will be left “orphaned,” since the
Knob or Switch automation controller it was configured to automate no
longer references any actual Helix Native parameter. If you assign another
parameter to this automated Knob or Switch controller, the track automation
envelope will then control the newly assigned parameter—or, you may wish
to delete the unused automation envelope from your host project.

To Re-assign an Existing Automation Controller Assignment to a New
Parameter - If you choose a new, unassigned block parameter in the Automation
menu, and then select a Knob or Switch from the Controller menu that is currently
assigned to another parameter, this removes the controller assignment from the
existing parameter and assigns it to the newly selected parameter. (Any Knob or
Switch automation controller can only be assigned to one parameter at a time.)

Automation Assignment Preservation when Changing Models

You may wonder, once you've configured one or more parameters of a particular Amp
or FX block with automation assignments, what happens to these assignments if you
want to then change the model for this block in your current tone? For just this situation,
Helix Native incorporates an automatic “preservation” for automation assignments,
which can intelligently re-assign the automation assignments when the new model
offers similar parameters.

3 NOTE: MIDI CC assignments are similarly preserved when changing the block’s
I model.
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For assignments to be preserved, the assigned parameters of the newly selected model
need to be similar in type and in scale. For example, if you've configured the Drive
slider of the Amp+Cab model to be automated by the Knob 1 automation controller,
you can then select most any other Amp+Cab, Amp or Preamp model for the block and
the Knob 1 controller will automatically re-assign itself to the Drive slider of the new
model. Likewise, if you have a Delay's Mix parameter automated, the Mix parameter
assignment will typically be preserved for the Mix parameter of most any other type of
FX model that includes a Mix slider.

For the cases where automation assignments cannot be preserved automatically, (e.g.,
when a block's model is changed to one with a very different set of parameters) any
existing track envelope with written or edited automation will be left in an “orphaned”
state on your DAW track. But you can manually re-assign the automation controller, as
covered in the previous section.

Automating Snapshot Changes

As covered on page 31, the Snapshot feature allows you to store a number of settings,
such as block bypass, parameter values, tempo values and more, and then recall all
snapshot-assigned settings simply by loading the respective snapshot via the plug-in's
Snapshots menu. For even more flexibility, Helix Native also allows you to automate
the loading of snapshots in real-time using your host DAW application's automation
features! Use the following steps to configure a snapshot automation assignment.

1. Access your host DAW app track's automation parameter menu and select the
Helix Native - Snapshot Index option.

Edit ~ Functions v

+

GUITAR 1
M S| %

> Read ¢ 1 Helix Nativ: Snapsh. Snapshot Index I
Switch 1

Selecting the Snapshot Index automation option in a Logic Pro track's automation menu

2. You should be able to see a “Snapshot Index” automation envelope line added
for the track (your host app may require that you toggle an option to display
it). Adding edit points and adjusting this envelope allows you to choose the
Snapshot index number that you wish to be loaded over the specified time
duration.

GUITAR 1#02 O

5
—

The editable Snapshot Index envelope line displayed on the Logic track

Feel free to continue to add, edit or remove the specific items you have included
within each of your snapshots. This automation feature simply loads whichever
shapshot you set it to load, allowing you to continue to customize snapshots'
contents as desired.

Writing Parameter Automation

Most host DAW apps also provide several “Read/Write” modes for parameter
automation, which typically appear as a set of options on the track (Off, Read, Write,
Latch, Touch, etc.).

-~ L ¥ INSERTS A-E 1o
| Audio 1 [T veix Naive]
rs m ECTEENNE

| vetorm 7
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m ~ read

touch g 3
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write vol -16.3

trim

The track automation Read & Write mode options in Pro Tools

When set to Read (typically the default), the track will actively “play back” the automation
envelope settings on the track, and when set to Off it will ignore the automation envelope.

When one of the Write options is set as active on the track, you can then play the track and
manually adjust any Helix Native switch or slider within the plug-in's Edit tab that includes
anautomation controllerassignment,andyourmovesarerecordedtothetrackinreal-time.
Also, since the Helix Native Snapshots feature has a dedicated automation parameter
(Snapshot Index), the loading of snapshots via the Snapshots menu can also be
“written” using your host's Write features. Typically you'll see the parameter's envelope
in the track edited with the adjustments that you have written, and you can manually drag
individual edit points to edit the envelope further as desired once playback is stopped.

Note that once a parameter is assigned to a controller and automated by the above
methods, it is no longer then possible to manually make adjustments directly to the
parameter's slider or switch within the Helix Native plug-in window, since it then
responds only to the written automation envelope values. To edit the settings, either
edit the automation envelope, or utilize one of the host's automation Write modes to
make the desired parameter value changes.
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MIDI Bypass & Controller Assignment

Most parameters and functions within Helix Native can also be controlled remotely
via external MIDI control devices or MIDI software applications. For most Helix
Native parameters, this is accomplished by creating a MIDI CC bypass or controller
assignment, either by utilizing the MIDI Learn functionality or manually, as shown in the
following steps.

\

Z TIP: If you happen to own a Helix device, it makes an excellent MIDI controller
¥ device for your DAW! Check out the “Command Center” chapter within your
Helix Owner's Manual for details on how to configure the Helix to transmit a
variety of MIDI control messages.

Reserved MIDI CCs

As can be referenced in “Global Reserved MIDI CCs” on page 52, several MIDI CCs
are reserved or pre-assigned to Helix Native or Helix hardware global functions and,
therefore, cannot be used for creating MIDI assignments to other parameters.

If you are using Helix Native with the Hardware Compatibility mode “Off,” all MIDI CCs
can be utilized for MIDI assignments, except CC 0, CC 32, and CC 69 (since these are
pre-assigned for Helix Native preset and snapshot functions).

3 NOTE: You’ll need to configure your DAW host application to receive MIDI
I Control input from your external MIDI controller device or software. These

settings are typically found within the DAW application's Preferences.
Additionally, it is often necessary to configure your DAW host track routing to so
that the external MIDI Controller data is fed directly to your current Helix Native
plug-in instance. This often requires the use of a MIDI or Instrument track to
receive the MIDI input and then route it to the audio track on which the Helix
Native plug-in inserted. Please see your application's documentation for details.

EEEXN 7/P: On the plug-in’s Status Bar, at the lower right of the main window, you’ll
see a handy MIDI In indicator light. When Helix Native receives MIDI input, you’ll see
this light up green—which can be a big help to let you know you have correctly routed
your MIDI controller data into the plug-in!

Creating a MIDI Bypass Assignment

For any block type that includes a bypass parameter, a MIDI bypass assignment can
be created to allow the block's bypass to be toggled via MIDI CC. You can create a
MIDI bypass assignment in Helix Native either by way using the MIDI Learn feature, or
manually, as covered in the following steps.

Creating a MIDI Bypass Assignment Using MIDI Learn:

1. Configure your external MIDI controller device (or software) to send your
preferred MIDI CC# (other than a “reserved” CC - see page 52). For best
results, configure a CC Toggle type message with two alternating values, where
one value is 0-63, and the other 64-127, allowing the bypass to be toggled
between its On and Off states.
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Within the Signal Flow, select the Amp, Effects or Split block for which you
want to create the MIDI bypass assignment. We’ve chosen the Distortion -
Compulsive Drive block for this example.

Right-click either directly on the Compulsive Drive block, or on the block’s
Bypass button that appears within the Edit tab, and choose MIDI Learn.

AUTOMATION/CONTROLLER ASSIGN
Bypass

o Cut Automation Bypass {-l

Copy = MIDI Bypass 3
MIDI Learn... t"?r

Clear Block v Snapshot Bypass
Clear All Blocks - .
T s Edit tab - Block Bypass button right-click menu

MIDI Bypass b

MIDI Learn... [>

¥ Snapshot B',rpalﬁ:;

Block right-click menu
Alternatively, you can click on the MIDI Learn - Arm icon that appears to the right
of the MIDI In slider, when the block’s bypass parameter is selected within the
Automation/Controller tab.
AUTOMATION/CONTROLLER ASSIGN
E Compulsive Drive B

None

MIDI In

This arms the block’s bypass parameter, where it “listens” for an incoming MIDI
CC message. Within the Signal Flow (and within the Automation/Controller
tab), you’ll see a little blue icon appear while armed. While a block is armed for
MIDI Learn, it listens for a valid MIDI CC type message. All other incoming MIDI
message types are temporarily ignored by Helix Native while a block or any
parameter is in the MIDI Learn armed state.

The “brain” icon appears flashing/lit while MIDI Learn is armed

TIP: You can arm multiple blocks via their right-click menu’s MIDI Learn
command and, once you send the MID | CC from your controller, all will be
configured with the same MIDI CC controller assignment in one step!

ag)\\

If you want to disarm MIDI Learn for this block, you can choose Disable MIDI
Learn form the right-click menu (or by simply left-click on any blinking blue
“brain” icon).



5. Send the MIDI CC message from your MIDI controller device and you should see
the block bypass instantly respond (and the title beneath the block is displayed in
brackets, indicating its bypass assignment). You can now access and optionally
edit or clear the assignment within the Automation/Controller Assign tab.

Creating a MIDI Bypass Assignment Manually:

1. Click on the desired block within the plug-in's Signal Flow to select it. For this
example, we've selected a Compulsive Drive Distortion block.

2. Go to the plug-in's Automation/Controller Assign tab. If not already selected,
choose the Compulsive Drive's bypass from the parameter menu at the top right
of the tab.

3. Click on the menu beneath and choose MIDI In as your assignment type. (If the
Bypass parameter already includes an existing assignment, choose None from
the menu to remove it, then choose MIDI In.)

4. Use the MIDI In slider to configure the MIDI CC number to which the block's
Bypass parameter will respond—we've select CC 13. Be sure to also configure
your external MIDI device to transmit this same MIDI CC number.

EDIT AUTOMATION/CONTROLLER ASSIGN

Block ~ Parameter Source

E Compulsive Drive  Bypass

Compulsive Drive Bypass MIDIIn13 > paTE MIDI In
Bypass

MIDI In

3

Configuring the MIDI In CC number for a MIDI bypass assignment

Once configured as above, when a MIDI CC Toggle message (CC 13 with two
alternating values, where one is 0-63, and the other 64-127) is sent to the plug-
in, it will switch the block's Bypass parameter.

5. Alternatively, you can right-click directly on the desired block within the plug-in's
Signal Flow, or select the desired block and right-click on its Bypass button within
the top right of the Edit tab, then select MIDI Bypass > MIDI In, and the desired
MIDI CC number from the sub-menu to create the MIDI bypass assignment.

1| SNAPSHOT 1 * None
cc4
ccs
ccé
ccT C LLER ASSIGN

C ccs
Ry i

cco cc Automation Bypass »
Clear Block CcC10
Clear All Blocks ccn
Automation Bypass » CC12
MIDI Bypass P CC13 p
+ Snapshot Bypass cC14

MIDI Bypass »
MIDI Leamn...

Creating a MIDI bypass assignment from the block in the Signal Flow (left),
or from the block’s Edit tab-Bypass button (right)

To remove a MIDI bypass assignment, right-click on the assignment within the
Assignments List at the left and choose the Clear option. Feel free to continue to
add, edit or remove MIDI bypass assignments for additional blocks as desired.
Be sure to Save your tone to retain these assignments within the preset.

Creating a MIDI Controller Assignment

Practically any parameter within Helix Native can be controlled remotely via a MIDI
controller device or MIDI software. This can be configured by creating a MIDI controller
assignment, either via Helix Native’s MIDI Learn function or manually, to allow the
parameter to be controlled via MIDI CC. For this example, we'll select a Wah to be
controlled via a MIDI expression pedal.

To Create a MIDI Controller Assignment via MIDI Learn:

1. Configure your external MIDI controller device pedal/knob (or software) to send
whatever MIDI CC# you like (other than a “reserved” CC - see page 52).

2. Click on the Wah block within the plug-in’s Signal Flow window to select it.

Within the Edit tab, right-click directly on the Wah'’s Position slider and choose
Controller Assign > MIDI Learn from the menu.

Teardrop 310

Controller Assign »* None
Automation Assign » MIDICC
Snapshots

MIDI Learn... N

"

Choosing MIDI Learn from a slider’s right-click menu

Alternatively, you can choose the Wah block’s Position parameter from the
menu within the Automation/Controller Assign tab, and click the MIDI Learn -
Arm button there.

AUTOMATION/CONTROLLER ASSIGN

Teardrop 310

Auto  Ctrl None

4. This arms the parameter, where it “listens” for an incoming MIDI CC message
(all other MIDI message types are ignored). Within the Edit tab, and within the
Automation/Controller tab, you’ll see a little blue flashing/lit icon appear while

armed.
e Position
< 1

The “brain” icon flashes at the left of the Edit tab’s slider, and appears lit in the
Automation/Controller tab, while MIDI Learn is armed
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If you want to disarm the block and cancel the MIDI Learn, you can choose
Disable MIDI Learn from the right-click menu, or simply left-click on any flashing
“brain” icon.
Z TIP: You can arm multiple parameter sliders via their right-click menus’ MIDI
¥ | earn commands—once you send the MID | CC from your controller, all
parameters will be configured with the same MIDI CC controller assignment
in one step!

5. Send the MIDI CC message from your MIDI controller device (or software), and
you should see the slider instantly respond, as well as display the little MIDI
Assignment indicator icon to its left. You can now access and optionally edit or
clear the assignment within the Automation/Controller Assign tab.

To Create a MIDI Controller Assignment Manually:
1. Click on the Wah block within the plug-in's Signal Flow window to select it.

2. Within the plug-in's Edit tab, right-click or directly on the Wah's Position slider
and choose Controller Assign > MIDI CC , and then the desired MIDI CC from
the sub-menu—we’ll choose CC 10—to create a MIDI Controller assignment for
the parameter.

cC
AUTOMATION/C o

Teardrop 310

MNone
r* MIDICC
Automation Assign » Snapshots

Controller Assign

MIDI Learn..

Creating a MIDI Controller assignment for a parameter

3. Go to the plug-in's Automation/Controller Assign tab and you'll see your newly-
created Wah MIDI Controller assignment in the list at the left. Click on this
assignment to select it and access additional options.

EDIT AUTOMATION/CONTROLLER ASSIGN
Block ~ Parameter Source Teardrop 310

Aute Cil MIDICC

Max Position

Creating a MIDI Controller assignment for a Wah

4. If desired, you can adjust the Min & Max Position parameters to limit the range
of a MIDI CC-assigned parameter. Note that it is possible to make the Min value
larger than the Max value, if you want to invert the behavior of the parameter.

Once configured as above, when a MIDI CC 10 message (with values of 0-127) is
sent to the plug-in, it will control the Wah block's Position parameter.

5. To remove a MIDI Controller assignment, right-click or Ctrl-click on the

assignment within the Assignments List and choose the Clear option.

6. Alternatively, you can create a MIDI Controller assignment within the Automation/

Controller Assign tab by first selecting the Wah block within the Signal Flow,
then, in the Automation/Controller Assign View, choose the desired parameter
from the Parameter menu (Position in our example), and then set the MIDI CC
slider to the desired MIDI CC number (CC 10 for our example—as seen in the
preceding screenshot).

Feel free to continue to add, edit or remove MIDI Controller assignments for

additional parameters as desired. Be sure to Save your tone to retain these
assignments within the preset.

Setlist, Preset, and Snapshot Recall via MIDI

Helix Native also responds to traditional MIDI CC, Bank and Program Change (PC)
messages from an external MIDI controller device (or from MIDI software via USB) to allow
remote setlist, preset, and/or snapshot loading.

3 NOTE - AU and AAX Plug-in Formats Only: At this time, remote MIDI control
" of setlist and preset changes is supported only with the AU (Mac) and Pro Tools
AAX (Mac and Windows) Helix Native plug-in formats. It is not supported for the
VST2 or VST3 Helix Native plug-in formats on Mac or Windows.

Also note that Setlist and Preset changes performed via MIDI PC/CC messages
are not supported by Undo, and will clear the current Undo history - please see
“Undo and Redo” on page 28.

Loading a Preset Within the Current Setlist

From your MIDI controller device, send a Program Change message to load the desired
preset within the current setlist. The PC message value differs depending on the current
Hardware Compatibility mode in Helix Native:

When in Helix, HX Effects or Off HC mode: use value 0-127 for Preset 01A-32D
When in HX Stomp HC mode: use value 0-125 for Preset 01A-42C

Loading a Preset Within a Different Setlist

When Helix Native is in the Helix or Off Hardware Compatibility mode, from your MIDI
controller device, send a Bank Change CC 32 (LSB) message with a value of O (for
Setlist 1), 1 (for Setlist 2), etc., followed by a Program Change message (Value 0-127
for Preset 01A—32D) for the desired preset within the setlist. (A CC 32 message will
not change the setlist until followed by a PC message to load a preset within the new
setlist.)

3 NOTE: When Helix Native is in HX Effects or HX Stomp HC mode, a Bank
I Change CC 32 (LSB) message is ignored, since the Preset Library includes only
the one, static setlist in these HC modes.
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Loading a Snapshot

From your MIDI controller device, send MIDI CC 69 with values as listed below to load MIDI CC# Value Function
the desired snapshot.” (Note that the number of available snapshots per preset differ

among Hardware Compatibility modes.) 0
+ When in Helix or Off HC mode: use value 0-7 for Snapshot 1-8 1
« When in HX Effects HC mode: use value 0-3 for Snapshot 1-4 2
« When in HX Stomp HC mode: use value 0-2 for Snapshot 1-3 3
+  For any HC mode: use value 8 for the next snapshot, use value 9 for the 49
previous snapshot.
50
E *NOTE: When the Snapshot Index Automation parameter is in use by the host 51
I DAW, the Snapshot Index selection will not respond to incoming MIDI CC 69
messages. 52
Z TIP: If you happen to own a Helix or HX Effects device, it makes an excellent MIDI s
¥ Controller device to remotely control Helix Native and your DAW host functions! 54
Additionally, all Helix and HX devices are capable of sending Program Change
messages, allowing you to remotely change presets in Helix Native—and can %
even do so synchronously when changing presets on the device itself. 56
Note that Helix and HX devices are set to transmit PC messages on device 57 R Var UED Ui [ EIPEITel S EESEmeiS
preset changes automatically. If this behavior is not desired you’ll want to
disable this in the device’s Preferences - MIDI settings. 58
Check out your Helix or HX device’s Owner’s Manual for details on how to 59
configure it to transmit a variety of MIDI control messages. 60
61
Global Reserved MIDI CCs ”
Helix Native has “reserved” specific MIDI CC messages to maintain compatibility with
Helix and HX devices. When using Helix Native in the Helix, HX Stomp, or HX Effects 63
HC Modes (see page 13), these reserved CCs are not available within the Helix
Native MIDI In Assignment menus, and not permitted when using MIDI Learn, to create 65
MIDI assignments.” 66
s *NOTE If you are using Helix Native with the Hardware Compatibility mode “Off,” all 67
S MIDI CCs can be utilized for MIDI assignments, except CC 0, CC 32, and CC 69.
64
68
Setlist 1-8 select (Helix or Off HC modes).
32 0-7 Note that the setlist change will not occur in Helix Native until the
(LSB) CC32 message is followed by a Program Change

(0-127), which then loads the respective setlist and preset.
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GLOBAL RESERVED MIDI CCs (Helix, HX Stomp, and HX Effects HC Modes)

MIDI CC# Value Function

0-7 Snapshot 1-8 select (Helix or Off HC mode)
0-3 Snapshot 1-4 select (HX Effects HC mode)

69 0-2 Snapshot 1-3 select (HX Stomp HC mode)
8 Next snapshot select
9 Previous snapshot select

70

71

72

73 Reserved for future use

74

75

76

128 0-63: Oh; Helix Native achieves self-awareness and starts poking fun of that
64-127: Nooo face you make during the solo
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Preferences and About Box

E NOTE: Note that some options are available only when Helix Native is set to
I the Helix or Off Hardware Compatibility modes, as indicated in the following
descriptions (see “Hardware Compatibility Modes” on page 13).

The Preferences Window

Clicking the Preferences button (the little gear icon) at the bottom left of the Helix
Native plug-in window opens the Preferences window, where you can configure several
settings for Helix Native.

NBA MNew Preset

£

Click the Preferences button to open the Preferences window

The Preferences window consists of a Restore button and three tabbed panes of
options: View, Presets/IRs, and Hardware Compatibility.

Restore Factory Settings

Restore Factoryt_Settings

This button at the bottom left of the Preferences window resets all items in all three tabs
of the Preferences window back to the initial, factory default settings.

Check for Updates

Check for Updates N
s

Pressing this button at the bottom of the window will launch your computer’s default
Browser app and take you directly to the Line 6 Helix Native downloads web page,
allowing you to check for and optionally download the latest Helix Native installer
version. As noted in the following section, the “About Box” tells you the version of
Helix Native that you are currently using.

Preferences - View Tah

Presets/IRs Hardware Compatibility

Show/hide name labels for signal flow view items:  Show Names

Restore Factory Settings Check for Updates

The View tab

This tab includes one option, for configuring how you wish to view the block labels
within the Signal Flow.

Show/Hide Block Name Labels - The Show Names setting is the factory default.
If you prefer to have the Signal Flow window not show labels beneath each block,
you can choose Hide Names here (see page 34).

Preferences - Presets/IRs Tah

Presets/IRs Hardware Compatibility

Preset Numbering Format:  01A-32D

Stereo IR Import:  Use Left Channel

Clear Preset Library Restore Factory Setlists

Clear IR Library

Import Bundle Export Bundle

Restore Factory Settings Check for Updates

The Presets/IRs tab
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This tab includes the following options for the Presets and Impulses Librarian tabs of
the plug-in.

Preset Numbering Format - The presets within the Librarian’s Presets Panel can
be numbered as Bank numbers & letters (as 01A-32D, the factory default setting)
or sequentially (as 000-127) within each Setlist, depending on which is more
convenient for you.

Stereo IR Import - When a stereo .wav IR file is imported by Helix Native, it is
converted to mono. This preference lets you choose whether to take the left
channel (the factory default setting) or right channel of the source IR file, or to sum
both channels to mono.

Clear & Restore Library Options
This group of buttons within the window offer quick and easy ways to clear out or

Clear IR Library - Instantly removes all IRs from the Impulses Library list. Use
the Impulses panel’s Import feature to import IR files from your computer’s hard
drive in whatever order you like. Note that the Helix Native IR Library is one
common library shared between HC modes, therefore, clearing this library will
clear all IRs for all HC modes.

Import & Export Bundle - (Available only when the Helix or Off HC mode is
in use) A Bundle is a file containing the complete set of all setlists and presets.
These buttons allow you to Import a Helix Bundle file from your hard drive,
or create and save all the Helix Native Library’s setlists and presets in their
currently-saved state as a Bundle file to your hard drive. As noted above, this is
a great way to easily save a backup of all your Library presets and restore them
at any time. Please see “Importing and Exporting Helix Bundles” on page
23 for details.

restore the contents of the Librarian’s panels. Preferences - Hardware compatml“ty Tah

A IMPORTANT! Be sure to backup your presets and impulses using the Export
options within the Librarian panels or Preferences window before using these
Clear and Restore features - Librarian presets and impulses will be permanently
deleted or overwritten, as indicated below.

3 NOTE: Each of the Helix Native Hardware Compatibility modes includes its own
" individual Presets Library, containing its own set of factory and custom-created
preset files. The Clear and Restore Preset Library buttons act only upon the
Preset Library of the current HC mode in use (see “Hardware Compatibility

Modes” on page 13).

+ Clear Preset Library - Instantly removes all presets in all setlists within the
current HC mode’s Preset Library. This replaces all with empty, “new” presets,
providing a clean library to create and import presets as desired.

- Restore Factory Setlists - The behavior differs depending on the HC mode
in use:

+ When Helix or Off HC mode is in use - Clears only Setlists 1, 2 & 8 and

replaces them with the Factory Setlists 1, 2 & 8 included with the currently
installed version of Helix Native.* All of your presets within any other setlists

Presets/IRs Hardware Compatibility

Current Hardware Compatibility Mode: Helix Floor/LT/Rack [Default] v

A i .
When loading presets that don't match Prompt
current hardware mode:
Remove non-runcl:nmng hafd\rvate blocks Dinabled
(e.g. Looper) when loading presets:
S| i s/c >
Show hardware bypass;_{.onlrouer Hide assignments
assignments:
Auto assign hardware bypass/ controllers

Disabled
to pedal based models: ey

Restore Factory Settings Check for Updates

The Hardware Compatibility tab

remain unaffected. This tab includes the following options for selecting the current and default Hardware

+ When HX Effects or HX Stomp HC mode is in use - Clears all presets.

u@\

*TIP: Note that when a new version of Helix Native is released, it may include
new Factory Presets within some or all HC modes’ Preset Libraries. If you
already have a previous version of Helix Native installed and install the newer
version, you'll need to perform the Restore Factory Setlists function for
each HC mode to get the new Factory Presets within your plug-in's Preset
Libraries.
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Compatibility mode (HC mode) in Helix Native, and mode behaviors.

Current Hardware Compatibility Mode - This menu allows you to manually
choose the current HC mode for this instance of the Helix Native plug-in. The four
options are Off, Helix/LT/Rack (for compatibility with any Helix Floor, LT or Rack
device), HX Effects, and HX Stomp. The Helix HC mode is the factory default.
Please see “Hardware Compatibility Modes” on page 13 for more info.

Note that changing this mode affects only the current plug-in instance, leaving all
other existing Helix Native plug-in instances unaffected. The default HC mode for
all new Helix Native instances is indicated by the [Default] text displayed to the
respective mode option within the menu. You can choose which mode you prefer
to be the default HC mode for all future instances by selecting the desired HC
mode in the menu, and then clicking the Set As Default button.




When loading a preset that does not match current HC mode - As covered in
“Hardware Compatibility Modes” on page 13, when you load a preset within Helix
Native that was created with a device or HC mode that differs from the current HC
mode in use by your Helix Native plug-in instance, Helix Native has the ability to
either automatically change its HC mode to match that of the preset, or to attempt
to translate the preset to match the current HC mode. This menu allows you to
choose the desired behavior whenever you attempt to load a preset that does not
match the current HC mode. This setting is global and will affect the preset loading
behavior of all current and future Helix Native instances.

+ Prompt - A pop up window will prompt you with options to either change the
HC mode to match the preset file, or translate the preset to the current HC
mode. (This is the factory default setting.)

+ Change to match file - No prompt is displayed and Helix Native will always
switch its HC mode to match that of the preset file.

- Translate file to current mode - No prompt is displayed and Helix Native will
always attempt to translate the preset to match the current HC mode. (Note
that, depending on the content of the preset, it may not be able to be translated,
in which case pop up error will alert you and the preset will not be loaded.)

Remove non-functioning hardware blocks when loading presets - Presets
exported from Helix’HX hardware can potentially include Send, Return, FX Loop
and/or Looper type blocks, all of which are non-functional within Helix Native plug-
in (see page 17). Enabling this option automatically strips out these block types
whenever importing Helix hardware Presets, Setlists or Bundles into Helix Native.
(Disabled is the factory default setting.)

Show hardware bypass/controller assignments - Presets exported from Helix/
HX hardware can potentially include hardware-specific bypass and controller
assignments, for example, an EXP Pedal for a Wah, or a Footswitch for a block
bypass. Setting this option to Show assignments allows them to be displayed
within Helix Native’s Automation/Controller Assign tab for reference. When
displayed, these assignments remain non-editable within Helix Native, but can be
cleared. When set to Hide assignments, such assignments remain hidden (the
default setting). See “Hardware Controller Assignments within Helix Native” on

page 43.

Auto assign hardware bypass/controllers to pedal based models - When set to
Enabled, any time a “pedal based” model (Wah, Volume, or Pitch Wham) is added
to your Helix Native Signal Flow, a hardware, EXP pedal controller assignment (plus
a toe switch bypass assignment, for a Wah) is automatically created, following the
auto assignment behavior of Helix/HX devices. You can enable this to make your
Helix Native-created presets more device friendly if you plan on exporting your
presets for use on Helix hardware. If you prefer not to have these auto assignments
created, keep this as Disabled (the default setting).

The About Box and Help Options

At the bottom left of the Helix Native plug-in window, click the ? button to access a
menu for the following About Box and Help options.

About
Online Help

Pilot's Guide
N, ® Dleve

Click the Preferences (gear icon) button to open the Preferences window

About Box

Choose About from the menu to display the About Box window, which provides full
version and legal information for Helix Native plug-in.

><  Helix Native 1.92

(LErNE -.

><

HEL 1> NATIVE

Helix Native 1.92
H 2.92 Compatible

maha Guitar Group, Inc. All ri

The Helix Native About box screen - About tab selected

Note that the “Helix 2.xx Compatible” version number in the lower portion of the About
screen informs you which device firmware version is supported if you are to be sharing
presets between Helix Native plug-in and your Helix or HX device.

Note that we recommend using the latest available versions of HX Edit, Helix Native
(where supported by your computer system), and your device firmware for optimal
compatibility! Please also see “Preset Compatibility with Helix and HX Devices” on

page 13.
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Legal Information

Choose the Legal tab at the left of the window to display the Legal screen, which lists
all the necessary trademark, copyright, and other legally required statements for the
Helix Native software.

Online Help

Choose the Online Help option from the menu to go directly to the Line 6 Helix Native
Support website page within your browser app. Here you can find the Knowledge Base,
FAQs, User Forums, and more for Helix Native.

Pilot’s Guide

Choose the Pilot’s Guide option from the menu to open the PDF document you are
now reading.
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Marketplace & Account
Options

Marketplace

MARKETPLAGE

CUSTOM PRESETS & IMPULSE

Now open for business is the Line 6 Marketplace online store, where you'll find 3rd-party,
premium add-on assets that even further enhance the functionality of Helix Native, as well
as Helix and HX hardware devices! As of this writing, professionally crafted presets and IRs
are available. Check back often on Marketplace for product news and announcements.
As covered within this chapter, you're only a few clicks away from using new Marketplace
assets on your system, right from the My Account menu in Helix Native.

¥ NOTE: Helix Native version 1.70 (or later) is required for the full functionality of
‘,‘ Marketplace premium presets and IRs.

Get Your Marketplace Assets

Access the Line 6 Marketplace website by choosing the Get More Presets and Get
More IRs, commands within the My Account menu at the bottom left of the Helix
Native plug-in window (or go directly to https://line6.com/marketplace/) and sign in to
your Line 6 account.* When browsing the Marketplace site, simply choose the desired
packs of presets or IRs, add them to your cart, and check out.

B “NOTE: Be sure to sign in to the same Line 6 user account with which you purchased
S your Helix Native license so that your Marketplace licenses are deposited into the
same account!

Once your purchase is complete, your downloadable Marketplace assets are deposited
into your Line 6 account, which include your personal license that allows you to import
them on your authorized computer system.

To download your purchased assets, click on the Manage Account command
within the plug-in's My Account menu (or go directly to https://line6.com/
account/), sign in to your account, and select Helix Marketplace from the
Hardware & Software section at the left.

Hardware & Software
Registered Gear

Purchase History
Authorized Devices
Software Add-ons
Helix Ma'kc—tclao&

Each Marketplace purchase is downloadable as a “zip” file that you'll need to “unzip”
on your local hard drive once downloaded.

Licenses for your purchased assets are automatically added to your Line 6 account,
and “synced” the next time you use an instance of Helix Native, as long as you are
actively signed in to your Line 6 account from the My Account menu (see “Account
Sign In / Sign Out” on page 59).

Import and Utilize Your Marketplace Assets

Once you've signed in and authorized your computer for use with Helix Native, your
computer is also authorized for your premium Marketplace assets—your presets and
IRs can then be imported and used just like any other presets and IRs.

Once imported, premium Marketplace presets (individual .hix preset files, or setlist or
bundles files that include them) and/or premium Impulse Responses (.hir files), appear
with a golden guitar pick “badge” at their right in the plug-in's librarian lists. (Also see
page 21 and page 24 for more about importing presets and IRs.)

‘il IMPULSES

= PRESETS 1l IMPULSES

IMPORT

001_Allure_V30
002_Allure_P10N
003_Allure_Greenbk
004_Allure_P12N
005_Creambk12
006_HMP_2x12_GBack2

Y | PASTE | IMPORT | EXPORT

01C GD-DR.Z ROUTE 66 L
01D GD-ENGL FIRE 100
02A GD-FENDR BMANbrt

D R.BMANOm *

The golden guitar pick badges indicate premium Marketplace Presets and IRs

o NOTE: The same Helix Native - Hardware Compatibility mode behaviors apply for the

‘T’ import of any Marketplace purchased presets into the Helix Native Presets Library. If
the preset device format does not match the current HC mode, Helix Native will

attempt to convert the preset. Please see “Hardware Compatibility Modes” on page 13.
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The My Account Menu Options

At the bottom left of the Helix Native plug-in window, you'll see the My Account menu
and account status indicator. Initially, before you've signed in to your Line 6 online
account and/or authorized your computer for Marketplace premium assets, you'll see
this menu displayed with the My Account label.

Manage Account...
Get More Presets...

Get More IRs

Signn...

© My Account r

S

The My Account menu (not signed in or authorized)

Clicking on the My Account menu at the bottom left of the Helix Native plug-in window
displays options for accessing the Preferences window (see page 54), signing in &
managing your Line 6 account, as well as for accessing Marketplace.”

¥ “NOTE: Once you've completed the computer authorization, it is not required that your
S computer have an active Internet connection, nor do you need to be signed in or

authorized at all for the Helix Native plug-in itself to be functional. But signing in is
necessary to authorize (or deauthorize) your computer to allow the use of Helix Native,

including the import and export of premium assets purchased from the online Marketplace.

Account Sign In / Sign Out

Signing in to your Line 6 account from within the Helix Native My Account menu (see
above) is necessary to be able to perform the following online processes.

+ To Authorize or Deauthorize your Computer - Once you've purchased the
Helix Native license, it is necessary to Authorize your computer to run it (as
covered in the next section).

+  For Authorizing Marketplace Purchases to your Computer - Whenever you
make a new purchase of premium add-ons from Marketplace, you'll need to be
signed in to allow Helix Native to initially “sync” with your Line 6 account and
authorize the licenses for your newly purchased goodies.

Once your computer is Authorized, you don't otherwise need to be actively signed in, or
even have an active Internet connection, to utilize Helix Native plug-in or Marketplace
add-ons.” We recommend that you simply remain signed in, as this does not hinder the
performance of Helix Native and ensures your licenses are always synced.

3 *NOTE: You must be actively signed in at all times if using the Helix Native plug-
I inin the 15-day Trial Mode. You must also be signed in for the initial import of
any new Marketplace assets, to allow license synchronization—see “License

Synchronization” on page 60.

If you are not currently signed in, choose Sign In from the My Account menu and enter
your Line 6 account user name and password in the Sign In pop-up window. If you have
forgotten your sign in credentials or have not already created a Line 6 account, choose
the Forgot my password/username or Create a Line 6 account option within the
window. If you are already signed in and wish to sign out, choose the Sign Out option
from the My Account menu.

@ Helix Native

Sign In

Please sign in to your Line 6 account

Sign In

The Sign In pop-up window

Computer Authorization Status Indicator

Once you've signed in and authorized your computer, you'll see the My Account
menu label display a green dot and your first name (derived from your Line 6 account),
indicating the status of your account sign in and computer authorization (more details
about authorization in the following section). When signed out, the menu button displays
the “My Account” label, with no colored authorization indicator.

Manage Account...
Manage Account g s

Get More Presets.. Get More Presets...

Get More IRs Get More IRs..
Deauthorize Computer

Sign Out Sign In...

® Steve N c Myaacoum[

3

Signed in with computer authorized Signed out with computer authorized
Once you've authorized your computer, you can optionally sign out, and your computer
remains in the authorized state, allowing you to continue to perform import, export, copy and
back up actions with your Marketplace premium assets, even if your Internet connection is
not currently active.

Note that you will need an Internet connection to be able to sign in again to access the
Deauthorize and Authorize options from the menu, as well as to initially synchronize with
your online Line 6 account after making any new Marketplace purchase (see “License
Synchronization”).
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Authorize / Deauthorize your Computer

Authorizing your computer allows your purchased (or Trial version) Helix Native license
to be run on the computer. It also allows you to utilize premium add-on assets purchased
from the Marketplace within Helix Native plug-in.

B Helix Hardware Owners: This activation & deactivation within Helix Native
I globally activates/deactivates your computer for the import, export and use of
Marketplace premium assets with the HX Edit application as well—please see
the latest HX Edit Pilot's Guide for details.

It is permitted to authorize a maximum of 4 of your computers concurrently. If you've
already authorized 4 computers, you can deauthorize one computer to free up one of
these license authorizations—see “Authorizing your Computer” on page 5 for details.

To Deauthorize your computer, first make sure you are signed in to your Line 6 acct. (as
covered in the previous section) then complete the following.

If you have purchased & authorized Helix Native - Click on the Deauthorize
Computer option. The online deauthorization completes momentarily. Helix Native
remains installed and selectable within your host DAW app, but the plug-in windows
displays only its authorization screen, and will not process audio while deauthorized.

If you are using the 15-day Trial version of Helix Native plug-in - When signed
in, you'll see your time remaining for the trial at the bottom of the plug-in window.
At any time during your 15-day trial, or once the trial has expired, you can click
this time remaining indicator to purchase your software license. Click Yes when
prompted to do so and you'll be taken to the Line 6 Online Store to make your
purchase and be up and running Helix Native plug-in in minutes!

Deauthorizing the Trial License from your Computer - You would likely only
want to deauthorize in the event that you want to continue the Helix Native
plug-in 15-day trial on a different computer that you own (assuming you have
time remaining in your trial). To continue your trial on a different computer, install
Helix Native plug-in on the other computer and choose the Trial version.

License Synchronization

Whenever you make a purchase from Marketplace, a license for each product you
purchase is deposited into your online Line 6 account. For Helix Native to access your
new licenses and effectively “unlock” your purchased assets, it needs to perform a
“sync” process with your Line 6 account. You must have an active Internet connection
and be signed in within Helix Native on your next use of the plug-in after your
purchase for this license synchronization to occur.

When you're signed in, this brief sync takes place automatically in Helix Native the
next time you insert a plug-in instance, or if already inserted, when you next click on
the plug-in window. (Note that it may take up to 5 minutes before a sync occurs for
an existing instance of the plug-in.) Once the license sync has completed, an active
Internet connection is not required for the use of these Marketplace purchased assets.

Manage Account

Choose this menu option to be taken to the Line 6 My Account page (https://line6.
com/account/), where you can view and update your Line 6 user account—view
and manage add-ons and Marketplace purchases, register Line 6 gear, update your
personal information, and more.
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Model Lists

To follow are the lists of all Effect, Amp, Speaker Cabinet & Microphone models included
in Helix Native, as well as the original gear they are based on.* Models, in many cases,
include some unique parameters, typically based on the controls found on the original
gear we modeled. However, you will also find a set of options that are common to
model category types, as described in the sections that follow.

Z TIP: Most model parameters are able to be configured for automation control by your

! host DAW software —see “The Automation/Controller Assign Tab” on page 43.

Effects Models

Helix Native includes all the effects models found within the award-winning Line 6 Helix
guitar processors. In addition, selected effects from the classic Line 6 DL4™, DM4™,
MM4™ and FM4™ stompboxes as well as M13®, M9®, and M5® processors are also
included, which are referred to as “Legacy” models.

The following Effects models are found within each of the Helix Native plug-in's
respective block category menus (Distortion, Dynamics, EQ, etc.). Once you've selected
an effects category in the plug-in's Model Browser menu, you'll see up to three effects
sub-categories: Mono, Stereo and Legacy. Mono models process in mono, as you'd
expect, collapsing the stereo output of any block preceding it to mono. Stereo models
process the signal as discrete stereo-in, stereo-out. Legacy type models, just as on
earlier Line 6 devices, are a mixed bag and can be either mono, stereo or mono-in/
stereo-out. See “Block Order and Stereo Imaging” on page 36 for more info.

A2 NEE S Em

Distortion Models

Subcategories Based On*
Xotic® EP Booster

Model
Kinky Boost

Mono, Stereo

Deranged Master Mono, Stereo Dallas Rangemaster Treble Booster

Minotaur Mono, Stereo Klon® Centaur

Teemah! Mono, Stereo Paul Cochrane Timmy® Overdrive
Heir Apparent! Mono, Stereo Analogman Prince of Tone

Tone Sovereign Mono, Stereo Analogman King of Tone

Mono, Stereo Way Huge® Red Llama (modded)
Fulltone® OCD

Hermida Zendrive

Alpaca Rogue

Compulsive Drive Mono, Stereo

Dhyana Drive Mono, Stereo

Distortion Models

Model Subcategories Based On*

Valve Driver Mono, Stereo Chandler Tube Driver

Top Secret OD Mono, Stereo DOD® OD-250

Scream 808 Mono, Stereo Ibanez® TS808 Tube Screamer®
Hedgehog D9 Mono, Stereo MAXON® SD9 Sonic Distortion
Stupor OD Mono, Stereo BOSS® SD-1 Overdrive

Deez One Vintage

Mono, Stereo

BOSS® DS-1 Distortion (Made-in-Japan)

Deez One Mod

Mono, Stereo

BOSS® DS-1 Distortion (Keeley modded)

Vermin Dist

Mono, Stereo

Pro Co RAT

KwB

Mono, Stereo

Benadrian Kowloon Walled Bunny Distortion

Legendary Drive

Mono, Stereo

Carvin® VLD1 Legacy Drive (hi gain channel)

Arbitrator Fuzz

Mono, Stereo

Arbiter® FuzzFace®

Triangle Fuzz

Mono, Stereo

Electro-Harmonix® Big Muff Pi®

Industrial Fuzz

Mono, Stereo

Z.Vex Fuzz Factory

Tycoctavia Fuzz

Mono, Stereo

Tycobrahe® Octavia

Wringer Fuzz

Mono, Stereo

Garbage's modded BOSS® FZ-2

Thrifter Fuzz

Mono, Stereo

Line 6 Original

Xenomorph Fuzz

Mono, Stereo

Subdecay Harmonic Antagonizer

Megaphone

Mono, Stereo

Megaphone

Bitcrusher

Mono, Stereo

Line 6 Original

Ampeg Scrambler

Mono, Stereo

Ampeg® Scrambler Bass Overdrive

ZeroAmp Bass DI

Mono, Stereo

Tech 21 SansAmp Bass Driver DI V1

Obsidian 7000 Mono, Stereo Darkglass® Electronics Microtubes® B7K Ultra
Clawthorn Drive Mono, Stereo Wounded Paw Battering Ram

Tube Drive Legacy Chandler Tube Driver

Screamer Legacy Ibanez® Tube Screamer®

Overdrive Legacy DOD® Overdrive/Preamp 250

Classic Dist Legacy ProCo RAT

Heavy Dist Legacy BOSS® Metal Zone

Colordrive Legacy Colorsound® Overdriver

Buzz Saw Legacy Maestro® Fuzz Tone

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Distortion Models

EQ Models

Model Subcategories Based On* Model Subcategories Based On*

Facial Fuzz Legacy Arbiter® Fuzz Face® Simple EQ Mono, Stereo Line 6 Original

Jumbo Fuzz Legacy Vox® Tone Bender Low and High Cut Mono, Stereo Line 6 Original

Fuzz Pi Legacy Electro-Harmonix® Big Muff Pi® Low/High Shelf Mono, Stereo Line 6 Original

Jet Fuzz Legacy Roland® Jet Phaser Parametric Mono, Stereo Line 6 Original

L6 Drive Legacy Colorsound® Overdriver (modded) Tilt Mono, Stereo Line 6 Original

L6 Distortion Legacy Line 6 Original 10 Band Graphic Mono, Stereo MXR® 10-Band Graphic EQ

Sub Oct Fuzz Legacy PAIA Roctave Divider Cali Q Graphic Mono, Stereo MESA/Boogie® Mark IV Graphic EQ
Dynamics Models Model Subcategories Based On*

Model Subcategories Based On* Optical Trem Mono, Stereo Fender® optical tremolo circuit

Deluxe Comp

Mono, Stereo

Line 6 Original

60s Bias Trem

Mono, Stereo

Vox® AC-15 Tremolo

Red Squeeze Mono, Stereo MXR® Dyna Comp Tremolo/Autopan Mono, Stereo BOSS® PN-2
Kinky Comp Mono, Stereo Xotic® SP Compressor Harmonic Tremolo  Mono, Stereo Line 6 Original
Rochester Comp  Mono, Stereo Ashly® CLX-52 (in conjunction w/ B. Sheehan) Bleat Chop Trem Mono, Stereo Lightfoot Labs Goatkeeper

LA Studio Comp Mono, Stereo Teletronix® LA-2A® Script Mod Phase Mono, Stereo MXR® Phase 90
3-Band Comp Mono, Stereo Line 6 Original Pebble Phaser Mono, Stereo Electro-Harmonix® Small Stone
Noise Gate Mono, Stereo Line 6 Original Ubiquitous Vibe Mono, Stereo Shin-ei Uni-Vibe®
Hard Gate Mono, Stereo Line 6 Original Deluxe Phaser Mono, Stereo Line 6 Original
Autoswell Mono, Stereo Line 6 Original Gray Flanger Mono, Stereo MXR® 117 Flanger
Tube Comp Legacy Teletronix® LA-2A® Harmonic Flanger Mono, Stereo A/DA Flanger
Red Comp Legacy MXR® Dyna Comp Courtesan Flange Mono, Stereo Electro-Harmonix® Deluxe EM
Blue Comp Legacy BOSS® CS-1 Dynamix Flanger Mono, Stereo Line 6 Original
Blue Comp Treb Legacy BOSS® CS-1 (Treble switch on) Chorus Mono, Stereo Line 6 Original
Vetta Comp Legacy Line 6 Original 70s Chorus Mono, Stereo BOSS® CE-1
Vetta Juice Legacy Line 6 Original PlastiChorus Mono, Stereo Modded Arion SCH-Z chorus
Boost Comp Legacy MXR® Micro Amp Trinity Chorus Stereo Dytronics® Tri-Stereo Chorus
Bubble Vibrato Mono, Stereo BOSS® VB-2 Vibrato
Vibe Rotary Stereo Fender® Vibratone

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategories Based On*
122 Rotary Stereo Leslie® 122 Simple Delay Mono, Stereo Line 6 Original
145 Rotary Stereo Leslie® 145 Mod/Chorus Echo Mono, Stereo Line 6 Original
Double Take Mono, Stereo Line 6 Original Dual Delay Stereo Line 6 Original
AM Ring Mod Mono, Stereo Line 6 Original Multitap 4 Stereo Line 6 Original
Pitch Ring Mod Stereo Line 6 Original Multitap 6 Stereo Line 6 Original
Pattern Tremolo Legacy Line 6 Original Ping Pong Stereo Line 6 Original
Panner Legacy Line 6 Original Sweep Echo Mono, Stereo Line 6 Original
Bias Tremolo Legacy 1960 Vox® AC-15 Tremolo Ducked Delay Mono, Stereo TC Electronic® 2290
Opto Tremolo Legacy 1964 Fender® Deluxe Reverb® Reverse Delay Mono, Stereo Line 6 Original
Script Phase Legacy MXR® Phase 90 (script logo version) Vintage Digital Mono, Stereo Line 6 Original
Panned Phaser Legacy Ibanez® Flying Pan Vintage Swell Mono, Stereo Line 6 Original
Barberpole Legacy Line 6 Original Pitch Echo Mono, Stereo Line 6 Original
Dual Phaser Legacy Mu-Tron® Bi-Phase Transistor Tape Mono, Stereo Maestro® Echoplex EP-3
U-Vibe Legacy Shin-ei Uni-Vibe® Cosmos Echo Mono, Stereo Roland® RE-201 Space Echo
Phaser Legacy MXR® Phase 90 Harmony Delay Stereo Line 6 Original
Pitch Vibrato Legacy BOSS® VB-2 Bucket Brigade Mono, Stereo BOSS® DM-2
Dimension Legacy Roland® Dimension D Adriatic Delay Mono, Stereo BOSS® DM-2 w/ Adrian Mod
Analog Chorus Legacy BOSS® CE-1 Adriatic Swell Mono, Stereo Line 6 Original
Tri Chorus Legacy Dytronics® Tri-Stereo Chorus Elephant Man Mono, Stereo Electro-Harmonix® Deluxe Memory Man
Analog Flanger Legacy MXR® Flanger Multi Pass Mono, Stereo Line 6 Original
Jet Flanger Legacy A/DA Flanger Ping Pong Legacy Line 6 Original
AC Flanger Legacy MXR® Flanger Dynamic Legacy TC Electronic® 2290
80A Flanger Legacy A/DA Flanger Stereo Legacy Line 6 Original
Frequency Shift Legacy Line 6 Original Digital Legacy Line 6 Original
Ring Modulator Legacy Line 6 Original Dig w/Mod Legacy Line 6 Original
Rotary Drum Legacy Fender® Vibratone Reverse Legacy Line 6 Original
Rotary Drum/Horn Legacy Leslie® 145 Lo Res Legacy Line 6 Original
Tube Echo Legacy Maestro® Echoplex EP-1
Tape Echo Legacy Maestro® Echoplex EP-3
Sweep Echo Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategories Based On* Model Subcategories Based On*
Echo Platter Legacy Binson® EchoRec® Simple Pitch Mono, Stereo Line 6 Original
Analog Echo Legacy BOSS® DM-2 Dual Pitch Mono, Stereo Line 6 Original
Analog w/Mod Legacy Electro-Harmonix® Deluxe Memory Man 3 OSC Synth Stereo Line 6 Original
Auto-Volume Echo Legacy Line 6 Original 3 Note Generator Mono, Stereo Line 6 Original
Multi-Head Legacy Roland® RE-101 Space Echo 4 OSC Generator Mono, Stereo Line 6 Original
Bass Octaver Legacy EBS® OctaBass
Smart Harmony Legacy Eventide® H3000
Octi Synth Legacy Line 6 Original
Glitz Mono, Stereo Line 6 Original Synth O Matic Legacy Line 6 Original
LEIEEE ene, SiEEs Lo Clifg/le] Attack Synth Legacy Korg® X911 Guitar Synth
Searchlights Mono, Stereo Line € Original Synth String Legacy Roland® GR700 Guitar Synth
Plateaux Mono, Stereo Line 6 Original ) .
Growler Legacy Line 6 Original
Double Tank Mono, Stereo Line 6 Original
Room Legacy Line 6 Original Model Subcategories Based On*
Chamber Legacy Line 6 Original Mutant Filter Mono, Stereo Musitronics® Mu-Tron® Il
Hall Legacy Line 6 Original Mystery Filter Mono, Stereo Korg® A3
Echo Legacy Line 6 Original Autofilter Mono, Stereo Line 6 Original
Tile Legacy Line 6 Original Asheville Pattrn Mono, Stereo Moog® Moogerfooger® MF-105M MuRF Filter
Cave Legacy Line 6 Original Voice Box Legacy Line 6 Original
SRRy LB Hire & i V Tron Legacy Musitronics® Mu-Tron® Il
Oclo Legacy Line 6 Original Q Filter Legacy Line 6 Original
'63 Spring Legacy Line 6 Original Seeker ey 7 Vex Seek Wah
i L Li iginal
Spring R ine 6 Origina Obi Wah Legacy Oberheim® voltage-controlled S&H filter
Particle Verb Legacy Line 6 Original i : "
Tron Up Legacy Musitronics® Mu-Tron® Il (up position)
Model Subcategories Based On* Throbber Legacy Electrix® Filter Factory
Pitch Wham Mono, Stereo Digitech® Whammy® Slow Filter Legacy Line 6 Original
Twin Harmony Mono, Stereo Eventide® H3000 Spin Cycle Legacy Craig Anderton's Wah/Anti-Wah
Comet Trails Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Parameter

Description

Time

Adjusts the delay/repeat time, with higher settings providing longer delays.
Activate the model's Note Sync parameter to toggle between Hz and note
values. Choosing a ms value provides a specific time in milliseconds; choosing
a note division value provides a time based on the current tempo. With a note
division value, this parameter’s value is retained when changing models.

Depth

Adjusts the intensity of the modulation. Higher settings result in more extreme
pitch bending, wobble, or throb, depending on the effect.

Feedback

Adjusts the amount of delayed signal fed back into the effect. Higher settings can
provide more dramatic textures.

Decay

Sets the length of time the reverb effect sustains.

Predelay

Determines the time before the reverb effect is heard.

Scale

On stereo delays, the Scale offers control over the left & right channel repeats
proportionately. The left channel repeats following the Time value and the right
channel will repeat at a time that is the percentage of the left time. For example, if
adelay's Time is set for 1 second and the Scale set to 75%, the left channel will
repeat at 1 second and the right at 750 milliseconds (ms).

Spread

Spread differs slightly among stereo delay effects. For most delays, it adjusts how
widely the repeats bounce left and right. With the Ping Pong Delay, for example, 0
is in the middle (mono), and 10 is full left to right panning for the repeats.

For modulated stereo delays, Spread affects the LFOs’ (low frequency oscillators)
stereo modulation behavior. At 0 the LFOs are in sync. At 10, the two LFOs are
180 degrees out of sync, so that when one side is modulating up, the other side is
modulating down.

Model Subcategories Based On*

UK Wah 846 Mono, Stereo Vox® V846

Teardrop 310 Mono, Stereo Dunlop® Cry Baby® Fasel model 310

Fassel Mono, Stereo Dunlop® Cry Baby® Super

Weeper Mono, Stereo Arbiter® Cry Baby®

Chrome Mono, Stereo Vox® V847

Chrome Custom Mono, Stereo Modded Vox® V847

Throaty Mono, Stereo RMC® Real McCoy 1

Vetta Wah Mono, Stereo Line 6 Original

Colorful Mono, Stereo Colorsound® Wah-fuzz

Conductor Mono, Stereo Maestro® Boomerang
Volume/Pan Models

Model Subcategories Based On*

Volume Pedal Mono, Stereo Line 6 Original

Gain Mono, Stereo Line 6 Original

Pan Stereo Line 6 Original

Stereo Width Stereo Line 6 Original

Headroom

Some mod and delay pedals' internal signal paths exhibit a bit of grit, especially
when placed after a high-gain amp block. Negative values increase the perceived
amount of grit; positive values clean things up a bit. At 0dB, the model behaves
like the original pedal.

Common FX Settings

Low Cut

High Cut

Filters a portion of the block’s bass and/or treble frequencies, which can help
remove rumble and/or high-end harshness.

Mix

Blends the effected “wet” signal vs. the “dry” signal passed through the block.
When set to 0%, the path bypasses the effect completely. When set to 100%, the
entire path is fed through the effect, and no dry thru signal is heard.

Level

Adjusts the overall output level of the effects block. Be careful not to boost this
parameter too high on multiple blocks, as digital clipping could occur. You should
typically leave this at 0.0dB for most blocks. Where the original pedal's level or
volume knob behavior doesn't really apply to dB values, 0.0-10 may be used.

Trails

Trails Off: Any delay repeats or reverb decays are instantly muted when the block
is bypassed.

Trails On: Any delay repeats or reverb decays continue to decay naturally when the
block is bypassed or a different snapshot is selected.

Parameter Description

Drive Adjusts the amount of overdrive, distortion, or fuzz.

Bass Adjusts the bass level.

Mid Adjusts the midrange level.

Treble Adjusts the treble level.
Adjusts the speed of the effect, with higher settings providing faster rates.
Activate the model's Note Sync parameter to toggle between Hz and note

Speed values. Choosing a Hz value provides a specific modulation speed in cycles per

P second; choosing a note value provides a time based on the current tempo. Not all

Speed parameters can be synced to note values, as they may be non-linear and
highly interactive.
Adjusts the rate of the effect, with higher settings providing faster rates. Activate

Rate the model's Note Sync parameter to toggle between Hz and note values. Not

all Rate parameters can be synced to note values, as they may be non-linear and
highly interactive.

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.

These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Amp Models

The following guitar & bass amp models are found within the Helix Native Amp+Cab,
Amp and Preamp block category menus. Note that you'll also see Guitar and Bass

subcategories for the Amp+Cab & Amp categories, and Guitar, Bass and Mic US Deluxe Vib Guitar Fender® Deluxe Reverb® (vibrato channel)
subcategories for the Preamp category. US Double Nrm Guitar Fender® Twin Reverb® (normal channel)
3 NOTE: Amp, Preamp, Cab, and Mic models are not supported when Helix Native US Double Vib Guitar Fender® Twin Reverb® (vibrato channel)
I is in the HX Effects Hardware Compatibility mode, therefore, you will not see Mail Order Twin Guitar Silvertone® 1484
these categories or models within the Helix Native menus when the HX Effects
mode is in use—see page 13. Divided Duo Guitar +13 JRT 9/15
Amp+Cab blocks include an Amp plus a matched Cab model. You can change Interstate Zed Guitar Dr Z® Route 66
out the Cab for sonic variation (see the list of “Speaker Cabinet Models” on Derailed Ingrid Guitar Trainwreck® Circuits Express
page 68 ). . ] ®
Amp blocks are identical to Amp+Cab blocks, except they contain no matched S G iy Folenet JLA 20 Jern Clioiie
Cab model. Using an Amp block is the best choice if you want to use an IR Essex A15 Guitar Vox® AC-15
block. Or try using a few IR or Cab blocks in a parallel Split Path for even more . ® )
variation. Essex A30 Guitar Vox® AC-30 with top boost
Preamp versions of each amp model are also included, which provide the tone A30 Fawn Nrm Guitar Vox® AC-30 Fawn (normal channel)
of just the preamp stage of the amp. Preamp blocks require less computer . .
processing than a full Amp block. A30 Fawn Brt Guitar Vox® AC-30 Fawn (bright channel)
Matchstick Ch1 Guitar Matchless® DC30 (channel 1)
Matchstick Ch2 Guitar Matchless® DC30 (channel 2)
Matchstick Jump  Guitar Matchless® DC30 (jumped)
WhoWatt 100 Guitar Hiwatt® DR-103 Brill Mandarin 80 Guitar Orange® OR80
Soup Pro Guitar Supro® S6616 Brit J45 Nrm Guitar Marshall® JTM-45 (normal channel)
Stone Age 185 Guitar Gibson® EH-185 Brit J45 Brt Guitar Marshall® JTM-45 (bright channel)
Voltage Queen Guitar Victoria Vintage Queen Brit Trem Nrm Guitar Marshall® JTM-50 (normal channel)
Tweed Blues Nrm  Guitar Fender® Bassman® (normal channel) Brit Trem Brt Guitar Marshall® JTM-50 (bright channel)
Tweed Blues Brt ~ Guitar Fender® Bassman® (bright channel) Brit Trem Jump Guitar Marshall® JTM-50 (jumped)
Fullerton Nrm Guitar Fender® 5C3 Tweed Deluxe (normal channel) Brit Plexi Nrm Guitar Marshall® Super Lead 100 (normal channel)
Fullerton Brt Guitar Fender® 5C3 Tweed Deluxe (bright channel) Brit Plexi Brt Guitar Marshall® Super Lead 100 (bright channel)
Fullerton Jump Guitar Fender® 5C3 Tweed Deluxe (jumped channels) Brit Plexi Jump Guitar Marshall® Super Lead 100 (jumped)
Grammatico Nrm  Guitar Grammatico® LaGrange (normal channel) Brit P75 Nrm Guitar Park® 75 (normal channel)
Grammatico Brt Guitar Grammatico® LaGrange (bright channel) Brit P75 Brt Guitar Park® 75 (bright channel)
Grammatico Jump Guitar Grammatico® LaGrange (jumped channels) Brit 2204 Guitar Marshall® JCM-800
US Small Tweed Guitar Fender® Champ® Placater Clean Guitar Friedman BE-100 (clean channel)
US Deluxe Nrm Guitar Fender® Deluxe Reverb® (normal channel) Placater Dirty Guitar Friedman BE-100 (BE/HBE channel)

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Cartographer Guitar Ben Adrian Cartographer Woody Blue Bass Acoustic® 360
German Mahadeva Guitar Bogner® Shiva Agua 51 Bass Aguilar® DB51
German Ubersonic Guitar Bogner® Uberschall® Cali Bass Bass MESA/Boogie® M9 Carbine
Cali Texas Ch1 Guitar MESA/Boogie® Lone Star (clean channel) Cali 400 Ch1 Bass MESA/Boogie® Bass 400+ (channel 1)
Cali Texas Ch2 Guitar MESA/Boogie® Lone Star (drive channel) Cali 400 Ch2 Bass MESA/Boogie® Bass 400+ (channel 2)
Cali IV Rhythm 1 Guitar MESA/Boogie® Mark IV (channel I) G Cougar 800 Bass Gallien-Krueger® GK 800RB
Cali IV Rhythm 2 Guitar MESA/Boogie® Mark IV (channel I1) Del Sol 300 Bass Sunn® Coliseum 300
Cali IV Lead Guitar MESA/Boogie® Mark IV (lead channel) Busy One Ch1 Bass Pearce BC-1 preamp (channel 1)
Cali Rectifire Guitar MESA/Boogie® Dual Rectifier® Busy One Ch2 Bass Pearce BC-1 preamp (channel 2)
Archetype Clean Guitar Paul Reed Smith® Archon® (clean channel) Busy One Jump Bass Pearce BC-1 preamp (jumped)
Archetype Lead Guitar Paul Reed Smith® Archon® (lead channel) Studio Tube Pre Preamp > Mic  Requisite Y7 mic preamp
ANGL Meteor Guitar ENGL® Fireball 100 c mon A s ttn
Solo Lead Clean Guitar Soldano SLO-100 (clean channel) 0mmo mp et gs
Solo Lead Crunch  Guitar Soldano SLO-100 (crunch channel) CEIEINEIE? [PEEEHiR

. . Adjusts the amount of power amp distortion. This parameter is highly interactive
Solo Lead OD Guitar Soldano SLO-100 (overdrive channel) Master with all other power amp parameters—the lower the Master is set, the less effect
PV Panama Ry Peavey® 5150° the other controls will have.

. ® . Lower Sag values offer a “tighter” responsiveness for metal and djent playing;
Revv Gen Purple  Guitar Revv® Generator 120 (purple/gain ch. 3) Sag higher values provide more touch dynamics & sustain for blues and classic rock

iffs.
Revv Gen Red Guitar Revv® Generator 120 (red/high gain ch. 4) e
Line 6 Elektrik Guitar Line 6 Original Hum Controls how much heater hum and AC ripple interacts with your tone. At higher
Ripple settings, things get freaky.

Line 6 Doom Guitar Line 6 Original

; ) . Bi Changes the Bias of the power tubes. Lower values achieve a “colder” Class AB
Line 6 Epic Guitar Line 6 Original 1as biasing. At maximum, the amp is operating in Class A.
Line 6 2204 Mod Guitar Line 6 Original Determines how the power amp tubes' voicing reacts when pushed hard. Set low

Bias X for a tighter feel. Set high for more tube compression. This parameter is highly

Line 6 Fatality Guitar Line 6 Original reactive with the Drive and Master settings.
Line 6 Litigator Guitar Line 6 Original
Line 6 Badonk Guitar Line 6 Original
Ampeg B-15NF Bass Ampeg® B-15NF Portaflex®
Ampeg SVT Nrm Bass Ampeg® SVT® (normal channel)
Ampeg SVT Brt Bass Ampeg® SVT® (bright channel)
Ampeg SVT-4 PRO Bass Ampeg® SVT®-4 PRO

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.

These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Speaker Cabinet Models

The following Cab models are available within the Amp+Cab and Cab block category
menus. All Cab models also include your choice of Mic model type used on the Cab,
as well as several Mic settings (see the list of “Microphone Models” on page 69).

There are two subcategories of Cab blocks—Single and Dual. Not surprisingly, Dual
Cabs require twice as much processor usage as single Cabs. When you select a Dual
Cab within the Model menu, you'll see two model tabs, allowing you to select the
specific cab and settings for each. Dual Cab blocks are stereo, with each of the two
cabs panned hard left and right.

E NOTE: Amp, Preamp, Cab, and Mic models are not supported when Helix Native
" is in the HX Effects Hardware Compatibility mode, therefore, you will not see
these categories or models within the Helix Native menus when the HX Effects
mode is in use—see page 13.

Soup Pro Ellipse Single, Dual 1 x 6x9" Supro® S6616

1x8 Small Tweed Single, Dual 1x8" Fender® Champ

1x12 Field Coil Single, Dual 1x12" Gibson® EH185

1x12 Fullerton Single, Dual 1x12" Fender® 5C3 Tweed Deluxe
1x12 Grammatico Single, Dual 1x12" Grammatico® LaGrange
1x12 US Deluxe Single, Dual 1x12" Fender® Deluxe Oxford
1x12 Celest 12H Single, Dual 1x12" +13 JRT 9/15 G12 H30
1x12 Blue Bell Single, Dual 1x12" Vox® AC-15 Blue

1x12 Lead 80 Single, Dual 1x12" Bogner® Shiva CL80
1x12 Cali IV Single, Dual 1x12" MESA/Boogie® Mk IV
1x12 Cali Ext Single, Dual 1x12" MESA/Boogie® EVM12L

2x12 Double C12N Single, Dual 2x12" Fender® Twin C12N

2x12 Mail C12Q Single, Dual 2x12" Silvertone® 1484
2x12 Interstate Single, Dual 2x12" Dr Z® Z Best V30
2x12 Jazz Rivet Single, Dual 2x12" Roland® JC-120

2x12 Silver Bell Single, Dual 2x12" Vox® AC-30TB Silver

2x12 Blue Bell Single, Dual 2x12" Vox® AC-30 Fawn Blue

2x12 Match H30 Single, Dual 1x12" Matchless® DC-30 G12H30

2x12 Match G25 Single, Dual 1x12" Matchless® DC-30 Greenback 25
4x10 Tweed P10R  Single, Dual 4x10" Fender® Bassman® P10R

4x12 WhoWatt 100 Single, Dual 4x12" Hiwatt® AP Fane®

4x12 Mandarin EM Single, Dual 4x12" Orange® Eminence

4x12 Greenback25 Single, Dual 4x12" Marshall® Basketweave G12 M25
4x12 Greenback20 Single, Dual 4x12" Marshall® Basketweave G12 M20
4x12 Blackback30 Single, Dual 4x12" Park® 75 G12 H30

4x12 1960 T75 Single, Dual 4x12" Marshall® 1960 AT75

4x12 Uber V30 Single, Dual 4x12" Bogner® Uberkab V30

4x12 Uber T75 Single, Dual 4x12" Bogner® Uberkab T75

4x12 Cali V30 Single, Dual 4x12" MESA/Boogie® 4FB V30

4x12 XXL V30 Single, Dual 4x12" ENGL® XXL V30

4x12 SoloLead EM Single, Dual 4x12" Soldano

1x12 Del Sol Single, Dual 1x12" Sunn® Coliseum

1x15 Ampeg B-15  Single, Dual 1x15" Ampeg® B-15

1x18 Del Sol Single, Dual 1x18" Sunn® Coliseum

1x18 Woody Blue  Single, Dual 1x18" Acoustic® 360

2x15 Brute Single, Dual 2x15" MESA/Boogie® 2x15 EV

4x10 Ampeg HLF  Single, Dual 4x10" Ampeg® SVT® 410HLF

6x10 Cali Power Single, Dual 6x10" MESA/Boogie® Power House
8x10 Ampeg SVT E Single, Dual 8x10" Ampeg® SVT®

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Microphone Models

Cab & Mic Settings

Knob Parameter

Description

1 Mic Selects one of the 16 available mic models.
57 Dynamic S 2 Distance gsltlgthe distance (1 inch to 12 inches) between the mic and the speaker
409 Dynamic Sennheiser® MD 409 3 LowCut Filters a portion of the cab's bass and/or treble frequencies, which can
421 Dynamic Sennheiser® MD 421-U 4 High Cut help remove rumble and/or high-end harshness.
30 Dynamic Heil Sound® PR 30 5 EarlyReflc ﬁ)ec}rsn tgguanngc;gnjoﬂ‘r“gﬁ:g trg;lgf:tions.” Higher values add more reflective
20 Dynamic sloeliosiiolcealiERd 6 Level Adjusts the overall output level of the Cab.
121 Ribbon Royer® R-121
160 Ribbon Beyerdynamic® M 160
4038 Ribbon Coles 4038
414 Cond AKG® C414 TLII
84 Cond Neumann® KM84
67 Cond Neumann® U67
87 Cond Neumann® U87
47 Cond Neumann® U47
112 Dynamic AKG® D112
12 Dynamic AKG® D12
7 Dynamic Shure® SM7

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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U.S. Registered Trademarks

All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. These
trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.

5150 is a registered trademark of ELVH Inc. Klon is a registered trademark of Klon, LLC.

Acoustic is a registered trademark of GTRC Services, Inc. Korg is a registered trademark of Korg, Inc.

Aguilar is a registered trademark David Boonshoft. Leslie is a registered trademark of Suzuki Musical Instrument Manufacturing Co. Ltd.
AKG, DOD and Whammy are registered trademarks of Harman International Industries, Inc. Lone Star is a registered trademark of Randall C. Smith.

Arbiter is a registered trademark of Sound City Amplification LLC. Marshall is a registered trademark of Marshall Amplification Plc.

Ashly is a registered trademark of Ashly Sound, Inc. Matchless is a registered trademark of Matchless, LLC.

Binson, Dytronics, LA-2A and Teletronix are registered trademarks of Universal Audio, Inc. MAXON is a registered trademark of Nisshin Onpa Co., Ltd.

Beyerdynamic is a registered trademark of Beyer Dynamic GmbH & Co. KG. Mesa/Boogie and Rectifier are registered trademarks of Mesa/Boogie, Ltd.
Bogner and Uberschall are registered trademarks of Bogner Amplification. Moog and Moogerfooger are registered trademarks of Moog Music, Inc.
BOSS and Roland are registered trademarks of Roland Corporation U.S. Musitronics is a registered trademark of Mark S. Simonsen.

Carvin is a registered trademark of Kiesel Guitars. Mu-Tron is a registered trademark of Henry Zajac.

Colorsound is a registered trademark of Sola Sound Limited Corporation, UK. Neumann is a registered trademark of Georg Neumann GmbH.

Cry Baby, Dunlop, Fuzz Face, MXR, and Uni-Vibe, are registered trademarks of Dunlop Orange is a registered trademark of Orange Brand Services Limited.

Manufacturing, Inc. Park is a registered trademark of AMP RX LLC.
822;%?38 and Microtubes are registered trademarks of Darkglass Electronics, TMI Douglas Paul Reed Smith and Archon are registered trademarks of Paul Reed Smith Guitars, LP.

Digitech is a registered trademark of DOD Electronics Corporation. Peavey is a registered trademark of Peavey Electronics Corporation.
Revv is a registered trademark of Revv Amplification Inc.
RMC is a registered trademark of Richard McClish.

Royer is a registered trademark of Bulldog Audio, Inc. DBA Rover Labs.

Dr. Z is a registered trademark of Dr. Z Amps, Inc.
EBS is a registered trademark according of EBS Holding.

EchoRec is a registered trademark of Nicholas Harris.

Electro-Harmonix and Big Muff Pi are registered trademarks of New Sensor Corp. Sennheiser is a registered trademark of Sennheiser Electronic GmbH & Co. KG.

Electro-Voice is a registered trademark of Bosch Security Systems, Inc. Shure is a registered trademark of Shure Inc.

Engl is a registered trademark of Beate Ausflug and Edmund Engl. Silvertone is a registered trademark of Samick Music Corporation.
Supro is a registered trademark of Absara Audio LLC.
TC Electronic is a registered trademark of MUSIC Group IP Ltd.

Tech21 is a registered trademark of Tech21 Licensing Ltd.

Eventide is a registered trademark of Eventide Inc.
Fane is a trademark of Fane International Ltd.
Fender, Twin Reverb, Bassman, Champ, Deluxe Reverb and Sunn are registered trademarks

of Fender Musical Instruments Corp. Timmy is a registered trademark of Paul Cochrane AKA PAULCAUDIO.

Fulltone is a registered trademark of Fulltone Musical Products, Inc. Trainwreck is a registered trademark of of Scott Alan Fischer and Mona Fischer.
Gallien-Krueger is a registered trademark of Gallien Technology, Inc. Tube Screamer is a registered trademark of Hoshino Gakki Co. Ltd.

Gibson and Maestro are registered trademarks of Gibson Guitar Corp. Tycobrahe is a registered trademark of Kurt Stier.

Heil Sound is a registered trademark of Heil Sound Ltd. Vox is a registered trademark of Vox R&D Limited.

Hiwatt is a registered trademark of Simon Giles and Justin Harrison. Way Huge is a registered trademark of Saucy Inc.

Ibanez is a registered trademark of Hoshino, Inc. Xotic is a registered trademark of Prosound Communications, Inc.

*See “U.S. Registered Trademarks” on page 70. All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Additional Resources

Looking for more info? We’ve got plenty of online resources, just a click away.

Download additional Help documentation covering Helix family devices and
software from the Line 6 website at Line 6 Product Manuals

Check out the Line 6 Support page for access to helpful tips, videos, discussion
forums, or to contact Line 6 Technical Support

Stay up to date with the latest updated version of Helix Native and all your other
Line 6 applications, available from the Line 6 Software Downloads page

Looking for some professionally crafted presets and Impulse Responses for
your Helix device or Helix Native plug-in? Check out the new Marketplace, and
be sure to check back often for news and product announcements

Visit the Line 6 CustomTone site where you can share your Helix presets with
the world, and download free presets created by Line 6 and other users just
like you

Can’t get enough Line 6 Gear & accessories? Head on over to the Line 6 Store

>11<


https://line6.com/support/manuals/
https://line6.com/support
https://line6.com/software
https://line6.com/marketplace/
https://line6.com/customtone/
https://shop.line6.com/helix-native.html
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